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KXRISH

5500000 -  «Muhandislik, ishlov berish va qurilish sohalari» 
bilimlar sohasi bakalavriat yo‘nalishlarimng o*quv rejalarida 
«Loyihalash jarayonlarini avtomatlashtirish asoslari» o‘quv fani 
nazarda tutilgan. Bu fanni o ‘zlashtirishda talabalardan zamonaviy 
avtomatlashtirilgan loyihalash tizimlarini qo‘llab amaliy grafik 
ishlami bajarish talab qilinadi. Bunda avtomatlashtirilgan 
loyihalashning eng ommaviy grafik tizimlari -  AutoCADdan 
foydalaniladi.

AutoCAD grafik tizimi Auto-Desk (AQSh) firmasi tomonidan 
ishlab chiqilgan, muhandislik-grafik ishlarini avtomatlashtirish 
uchun mo'Ijailangan, shu sababli kompyuter bilan birga «elektron 
kulman»ni hosil qiladi.

AutoCADning birinchi versiyasi paydo bo‘lgandan beri u 
quwatli muhitga aylandi, usiz zamonaviy sanoat korxonasi yoki 
konstruktorlik byurosining ishini tasawur qilib bo'lmaydi. Ocquv 
qo‘lianmada bayon qilingan AutoCAD 2007 versiya -  uning 
evolyutsion rivojlanishining natijasidir. Ushbu versiyada ba’zi bir 
o‘zgarishIar uch oMchamli muhitga taalluqli boMdi -  foydalanuvchi 
interfeysi yaxshilandi.

AutoCAD 2007 grafik tizimi Windows XP operatsion tizimga 
o‘matiladi.

Ocquv qo'llanmada taqdim etiigan o‘quv-metodik material 
Toshkent davlat texnika universitetining «Energomashinasozlik va 
kasb ta’Iimi (YeUT)» kafedrasida 7 yil davomida aprobatsiyadan 
muvaffaqiyatli o'tdi. 0 ‘quv qo‘llanmadagi chizmalar AutoCAD 
2007 dasturining eng yangi versiyasidan foydalanilgan holda 
bajarildi.

Ushbu o‘quv qoMlanmada quyidagi masalalar ko‘rilgan:
• AutoCAD 2007 grafik tizimini muayyan foydalanuvchiga 

moslab sozlash;
• chizmalarni ESKD stcmdartlariga mos ravishda yaratish, 

tahrir qilish va shakl berish metodikasi; bunda ushbu tizimda 
chizmalarni «oddiydan murakkabga» bajarish texnologiyasi bayon 
qilingan;



• AutoCAD 2007 grafik muhitida individual topshiriqlarni 
bosqichma-bosqich bajarish metodikasi;

• AutoCAD 2007 grafik muhitida uch о 'Ichamli ishchi 
maydonining bayoni va uni sozlash;

9 AutoCAD 2007 grafik muhitida uch o'lchamli obyektlami 
karkasli, sirtli va qattiq jismli modellar ko‘rinishida qurish 
metodlarL

Shaxsiy individual grafik topshiriqlarni bajarish quyidagi 
bandlardan iborat:

• detaining ikki tasviri bo'yicha uning uchinchi tasvirini 
ratsional kesimlari bilan A3 form atda qurish;

• sirtlarning kesishish va о 'tish chiziqlarini qurish;
• korpus detalining qattiq jism li modelini qurish.
0 ‘quv qo‘IIanmada AutoCAD grafik tizimining uch o'lchamli 

modellash vositalari yordamida turli uch oMchamli obyektlami 
yaratish metodikasi bayon qilingan.



1. AutoCAD 2007 REDAKTORINI ISHGA TUSHIRISH VA 
UNING DARCHASI

Grafik tizim AutoCAD 2007 Windows XP operatsion tizimda 
ishga tushiriladi. Yuklangandan keyin ekranda l.l-rasmda 
tasvirlangan ishchi makonni tanlash dialog darchasi paydo bo‘Iadi.

Unda AutoCAD Classic (Классик стипъ/Klassik stil) yoki 3D 
Modeling (3D моделирование/ЗО modellash) interfeyslami 
tanlash mumkin. Dastlab AutoCAD Classic punktni tanlaymiz, 
chunki biz ikki o‘lchamli makonni o'zlashtirishdan boshlaymiz.

So'ngra darcha paydo bo‘ladi, uning yordamida dastuming 
yangi funksiyalari bilan tanishish mumkin. Unda Yes (Да/На), 
Maybe later (Позже/Keyin) yoki No, Don't me this again (Больше 
не показывать это окно/Bu darcha boshqa ко ‘rsatilmasin) ulab- 
uzgicblaridan birini tanlang va OK knopkasini shiqillating.

Keyin Startup (Начало работы/Ish boshlanishi) dialog 
darchasi paydo bo‘ladi. Bu dialog darchasining paydo boclishi yoki



bo'lmasligi Tools => Options (Сервис ~> Настройки/Servis => 
О rnatish) komandasi bilan boshqariladi, Startup ro‘yxatidagi 
General Options (Общие параметры/Umumiy parametrlar) 
bo‘Iimning System (Система/Tizirn) ilovasida Show startup dialog 
box (Показывать диалоговое окно начало работы/Ish 
boshlanishi dialog darchasini ko 'rsatish)m tanlaymiz.

Yana shuni qayd qilish kerakki, indamasiik (по умолчанию) 
bo‘yicha ishchi zona qora rangga ega boMadi. Qulay boMishligi 
uchun ishchi zonaning rangini qoradan oqqa (yoki sizga yoqqan 
boshqa rangga) almashtirish tavsiya etiladi.
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1.2-rasm. Ishchi zona rangini tanlash darchasi 

Display (Экран) ilovasidagi Tools => Options (Servis =>



O'rnatish) komandasini tanlang va Colors (Ceema/Ranglar) 
knopkasida shiqillating. ICeyin Drawing Window Color (Окно 
светов чертежо/Chizrna ranglari darchasi) ochiladi -  1.2-rasm. 
Ushbu dialog darchasida ekranning har bir elementi uchun rang 
o'rnatish mumkin.

Indamaslik bo‘yicha ikki oMchamli ishchi zonaning rangi 
ro‘yxatda birinchi boMib topiladi, shuning uchun Color (Rang) 
maydonida White (Белый/Oq) qatomi tanlang. Apply&Close 
(Применить и закрытъ/Qo ’Hang va berkiting) knopkasida 
shiqillatib dialog darchasini yoping.

Startup (Ish boshlanishi) dialog darchasi 1.3-rasmda 
ko‘rsatilgan.
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1.3-rasm. S ta rtu p  (Ish boshlanishi) dialog darchasi

Startup (Ish boshlanishi) dialog darchasi yordamida mavjud 
chizmani ochish yoki yangisini yaratish mumkin. Birinchi holda 
Open a Drawing (Открыть чертеж/Chizrnani ochish) 
knopkasida, ikkinchi holda esa -  Start from  Scratch (Начать с 
нуля/Noldan boshlansin), Use a Template (По uiabnony/Shablon 
bo 4yicha) Use a Wizard (Использовать Macmepa/Ustadan 
foydalanish) knopkasida shiqillatiladi. Bu dialog darchasi 
keyinchalik File => New (Файл => Новыи/Fayl => Yangi)



komandasi bajarilishida ham paydo boiadi.
Start from  Scratch (Начать с иуля/NoIdan boshlash) rejimi va 

metrlik tizimlar birligi tanlangandan so'ng AutoCAD qo‘shimcha 
ko‘rsatmaIarsiz yangi chizma uchun ishchi ekranni ochamiz. 
Chizishni boshlashdan oldin AutoCAD redaktorining ishchi 
darchasi (grafik interfeysi) bilan tanishamiz.

1.1. Foydalanuvchining ishchi stoli
1.4-rasmda AutoCAD 2007 ning ishga tushirilgan ishchi 

darchasi ko‘rsatilgan. Bunda sarlavha qatorida (ekranning chap 
yuqori burchagida) bo‘lajak chizmaga avtomatik tarzda berilgan 
fayl nomi -  Drawing I paydo bo'ladi.

Ekranda to‘rtta funksional zonani ajratish mumkin:
® Ishchi grafik zona -  bu ekranning o‘rtasida joylashgan 

asosiy jabha, u yerda chizma bajariladi. Zonaning chap pastdagi 
burchagida foydalanuvchi koordinatalar tizimining piktogrammasi 
joylashadi. Strelkalar yo‘naIishi o ‘qlaming musbat yo'nalishiga 
mos keladi.

® Tizimiy menyu va instrumentlar paneli. Eng yuqorida 
sarlavha qatori, uning ostida esa -  AutoCAD tizimiy menyusining 
qatori joylashadi. Pastroqda instrumentlar panellari egallagan ikkita 
qator joylashadi. Ishchi zonadan chap tarafda instrumentlaming 
«suzuvchi» panellari Draw (Рисование/Chizish), Modify 
(Редактирование/ТаЬпг qilish), ocngda esa -  Dimension 
(Размеры/ 0 ‘ichamlar) joylashadi. Ulami ekranning istalgan 
joyiga siljitish mumkin. AutoCADda yana boshqa ko‘p 
instrumentlar panellari bor, ular zarurat bo‘yicha chaqiriladi.

«• Komanda qatori. Ishchi grafik zona ostida komanda qatori 
joylashadi. AutoCADning istalgan komandasini, uning nomini 
komanda qatorida terib, ishga tushirish mumkin. Agar komanda 
instrumentlar paneli piktogrammasi yoki menyu punkti vositasida 
ishga tushirilgan bo‘lsa, komanda qatorida tizimning mos 
komandasiga reaksiyasi aks ettiriladi. Bundan tashqari 
klaviaturadan kiritiladigan hamma narsa o‘sha zahoti komanda 
qatorida aks ettiriladi. Agar bilmasdan boshqa komanda chaqirilgan 
va joriy komandani bekor qilish zarur bo‘Isa, klaviaturadagi Esc



klaviaturasini bosish mumkin.
® Holai qatori. Holat qatorida xoch(sichqon ko‘rsatkichi)ning 

joriy koordinatalari aks ettiriladi.
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1.4-rasm. AutoCAD 2007 ning ishchi darchasi

Bazaviy xarakteristikalami yaxshiroq tushunish uchun kesma 
ko'rinishidagi grafik primitivni keltirilgan instruksiya bo‘yicha 
chizishga harakat qilib ko‘ramiz.

1.1-mashq. To‘g‘ri chiziq kesimasini chizish
1. Instrumentlar paneli Draw (PHCOBamie/Chizish)da Line 

(Отрезок/Kesma) piktogrammasini (uni sichqon knopkasini 
shiqillatib) tanlang (1.5-rasm) yoki komanda qatoridan kiriting. 
Bunda komanda qatorida quyidagi komandani kiritishga taklif 
paydo bo'ladi:

C o m m a n d :  l i n e  S p e c i f y  f i r s t  p o in t :  ( К о м а н д а :  
О т р е з о к .  О п р е д е л и т ь  п е р в у ю  т о ч к у /K o m a n d a :  
K e s m a .  B i r i n c h i  n u q t a  a n i q l a n s i n ) .



1.5-rasm. To‘g‘ri chiziq kesraasini chizish

2. Kesma birinchi nuqtasining koordinatalari X va Y ni, so‘ngra 
ikkinchi nuqtasining koordinatalarini bo'sh joy qoldirmasdan 
vergul bilan kiritilsin:

C o m m a n d :  L ine  S p e c i f y  f i r s t  p o in t :  50,  50 
E n t e r  ( К о м а н д а :  О т р е з о к .  О п р е д е л и т ь  п е р в у ю  
т о ч к у :  50 ,  50 E n t e r / K o m a n d a :  K e s m a .  B i r i n c h i  
n u q t a  a n i q l a n s i n :  50 ,  50 E n t e r ) ;

S p e c i f y  n e x t  p o i n t  o r  [U n d o ] :  100,  150 E n te r  
( О п р е д е л и т ь  с л е д у ю щ у ю  т о ч к у  или  [ О т м е н и т ь ] :  
100,  150 E n t e r / K e y i n g i  n u q ta  a n i q l a n s i n  yok i
[ b e k o r  q i l i n s i n ] :  100,  150 E n t e r ) ;

S p e c i f y  n e x t  p o i n t  o r  [U n d o ] :  E n te r
( О п р е д е л и т ь  с л е д у ю щ у ю  т о ч к у  или  [ О т м е н и т ь ] :  
E n t e r / K e y i n g i  n u q t a  a n i q l a n s i n  y ok i  [ b e k o r  
q i l i n s i n ] :  E n t e r ) .



1.2-masItq. Kesmani o‘chirish
1. Qurilgan kesma ko4rsatilsin, ya’ni kesmada mo^ljal xochi 

(marker)ni o‘mating va sichqon chap knopkasini shiqillating. 
Bunda kesma punktir bilan ajratib ko‘rsatiladi va uning oxirlarida 
esa «ruchkalan> paydo bo'ladi.

2. IClaviaturadagi Delete klavishasi bosilsin yoki sichqon bilan 
Modify (Редактирование/Tahrirlash) instrumentlar panelida 
Erase (CTepeTb/0‘chirish) piktogrammasini ko‘rsating. Kesma 
yo‘qoladi.

AutoCAD istalgan bajarilgan komandani yoki komandalar 
guruhini bekor qilish imkoniyatini beradi. Yo‘qotilgan tasvimi 
tiklash uchun instrumentlar panelining yuqorigi qatorida chap 
strelka Undo (Отмена/Веког qilish) piktogrammasida sichqonni 
shiqillating( 1.5-rasm).

Kiritishning dinamik rejimi
AutoCAD 2007 da ma’lumotiami dinamik kiritish rejimi 

mavjud. Holatlar qatorida DYN (DIN) knopkasi bosilganda 
dinamik kiritish Dynamic Input (Динамический ввод/Dinamik 
kiritish) rejimi ulanadi(1.6-rasm).
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m a r a a s  _ 11п е  П е р в а я  т о ч к а :

 ̂ШАГГСЕТУАСРТО|ОТСАОДПР |пжвязхл lore объш  | дпск 1 дин~̂ сГ|модеяь~

1.6-rasm. Dinamik rejimda to‘g‘ri chiziq kesmasini chizish

Yuqorida bayon qilingan komanda dinamik rejimda



bajarilishida kursor yonida yo‘riqlar qatori paydo boMadi (1.6- 
rasin). Unga nuqta koordinatalarini kiritish uchun komanda so‘rovi 
aks ettiriladi. Dinamik kiritish rejimi paydo boMishi bilan 
(AutoCAD 2006 dan boshlab) redaktor ishchi darchasining 
pastdagi chap burchagidagi koordinatalar paneli (1.4-rasmga 
qarang) o‘z ahamiyatini yo'qotadi, chunki u yerda ham shu 
informatsiya takrorlanadi.

Dinamik kiritish rejimining ikki turi mavjud: Pointer Input 
(Задание точки ее координатами/Nuqtani uning koordinataiari 
orqali berish) va Dimension Input (Задание точки ее 
расстоянием и углом/Nuqtani masofa va burchak orqali berish). 
Bu rejimlar Tools ==> Drafting Settings (Instrumentlar => 
BogMash parametrlari) dialog darchasi yordamida o‘matiladi.

Hozircha biz kiritishning klassik rejimida ishlaymiz, shuning 
uchun holat qatoridagi DYN (DIN) knopkasini bosib, dinamik 
kiritish rejimini uzib qo‘yamiz.

1.3-mashq. Chizmani saqlash
1. Instrumentlar panelining yuqori qatorida File (Fayl) 

menyusini shiqillating, chiqayotgan ro'yxatdan Save Drawing As 
(Сохранить как/КаЫ saqlang)ni tanlang. Ekranda tanlangan 
diskdagi papkalar ro‘yxati!i Save Drawing As dialog darchasi 
paydo boMadi.

2. Papkani chiqaring yoki yangisini yarating. File Name (Имя 
файла/Fayl nomi) qatorida chizma nomi -  «Чертеж 1» ni kiriting 
va ushbu darchadagi Save (Сохранить/Saqlansin) knopkasini 
shiqillating. AutoCADda yaratilayotgan chizmalarning hamma 
fayllarga avtomatik tarzda kengayish .dwg beriladi.

Tizimdan chiqish
Tizimdan chiqish uchun quyidagi amallaming biridan 

foydalanish mumkin:
* Close (Закрыть/Berkitiism) knopkasida sichqonni 

shiqillatish -  xoch ekranning o‘ngdagi yuqori burchagida;
* komanda qatorida Quit so‘zi teriladi va Enter kiavishasi 

bosiladi;



♦ menyuda File => Exit (Файл => Выход/Fayl => Chiqish) 
tanlanadi.

Agar informatsiya chizmada saqlanmagan boMsa, AutoCAD 
uni saqlashni taklif qiladi. Yes (Да/На) javobini berish bu taklifhi 
qabul qilish, No (HeT/Yo‘q) javobini berish oxirgi oezgarishlami 
saqlamasdan tizimdan chiqish yoki chiqishdan voz kechib, Cancel 
(Отмена/Веког qilish) knopkasini bosib chizmaga qaytish 
mumkin.

1.2. Menyu va instrum entlar panellari
AutoCAD komandalarini chaqirish menyu yoki instrumentlar 

panellaridagi piktogrammalar yordamida amalga oshiriladi. 
AutoCAD 2007 versiyasida tizimiy menyu qatori quyidagi chiqib 
keluvchi menyulardan tarkib topadi:

• File (Файл/Fayl) -  menyu fayl (chizma)lami ochish, 
saqlash, chop qilish, boshqa formatlarga eksport qilish va tizimdan 
chiqish uchun moMjallangan;

• Edit (Правка/Tuzatish) -  ishchi zonada chizma kesilarini 
tahrir qilish (tuzatish) menyusi;

* View (Вид/Tur) -  ekranni boshqarish, varaq va model 
makonlari rejimlarini uzib-ulash, uch oMchamli modellar uchun 
ko'rish nuqtasini o‘matish, tonirovka qilish, displey parametrlarmi 
boshqarish menyusi;

• Insert (Вставить/Kiritib o'rnatish) -  boshqa ilovalardan 
bloklar va obyektlami kiritib o‘matish komandasi menyusi;

• Tools (Инструменты/Instrumentlar) -  tizimni boshqarish 
vositalari, chizma parametrlarini bogManishlar va foydalanuvchi 
koordinatalar tizimini o'rnatish menyusi;

* Draw (Черчение/Chizmachilik) -  grafik primitivlar va uch 
oMchamli modellami qurish menyusi;

* Dimension (Размер/ОMcham) -  oMchamlami berish 
komandasi menyusi;

* Modify (Редактирование/Tahrir qilish) -  grafik obyektlami 
tahrir qilish menyusi;
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1.7-rasm. D raw  (Черчение/ChizmachiHk) va kontekst menyusi



* Window (Окно/Darcha) -  ochilgan chizma(fayl)lami 
boshqarish va sortirovka qilish menyusi;

♦ Help (Справка/Ма* lumot) -  ma’Iumot menyusi.
1.7,a-rasmda misol tariqasida Draw (Черчение/Chizmachilik)

chiqib keluvchi menyusining bir qismi ko‘rsatilgan. Uni ekranda 
ko‘rish uchun, kursor bilan tizimiy menyudagi Draw so‘zini kursor 
bilan ko'rsatish va sichqonni shiqillatish lozim. Agar o‘ng tomonda 
qora uchburchak turgan bo‘lsa, ekranga nimmenyuni ham chiqarish 
mumkin.

Kontekstli menyu
Kontekstli menyu joriy komanda uchun opsiyalar ro'yxatiga tez 

kirishni ta’minlaydi. Kontekstli menyu sichqon o‘ng knopkasi 
bosilgandan keyin ochiladi. 1.7,b-rasmda indamaslik bo'yicha 
kontekstli menyu keltirilgan, u sichqon o ‘ng knopkasi chizma 
jabhasida bosilgandan keyin ochiladi.

Tahrir qilish rejimining kontekstli menyusi qandaydir obyekt 
(masalan, qurilgan kesma) tanlangandan keyin va sichqonning o‘ng 
knopkasi bosilgandan so‘ng ochiladi (1.7,v-rasm).

Instrum entlar panellari
Instrumentlar panellari tanlangan piktogrammada sichqonni 

oddiy shiqillatish bilan AutoCAD komandalarini bajarish imkonini 
beradi. Instrumentlar panellari suzib yuruvchi yoki muayyan bir 
joyga o'rnatiigan bo‘lishi mumkin. AutoCAD 2007 da 40 yaqin 
instrumentlar panellari mavjud.

1.4-mashq. Instrum entlar panelini cliaqirisli
1. Tizimiy menyudan View => Toolbars (Вид => Панели 

инструментов/Tur => Instrumentlar paneli)ni tanlang.
2. Paydo bo‘lgan Customize User Interface (Настройка 

интерфейса иользователя/Foydalanuvchi interfeysini o'matish) 
dialog darchasidagi Toolbars (Панели инструментов/ 
Instrumentlar paneli) qatorida istalgan instrumentlar panelini 
tanlash mumkin.

3. Ishchi stolida ekranni masshtablash piktogrammalari



bo'Igan chizg'ich paydo bo'Iishi uchun instrumentlar panelidagi 
istalgan piktogrammani o'ng knopka bilan shiqiliatish va kontekstli 
menyu ro'yxatining oxirida Zoom (Masshtab) qatorini tanlash 
mumkin (1.8-rasm).

1.8-rasm. Ekranni masshtab lash menyusining piktogrammalari

1.3. Individual foydalanuvchi uchun AutoCADni o'rnatish
Yangi chizma ustida ishlashdan oldin ishchi muhitni o'rnatish 

lozim, ya’ni chizma ishchi maydoni o'lchamlarini, o'lchov 
birliklarini berish va koordinatalar tizimini o'rnatish kerak va h.k. 
Buning uchun AutoCAD 2007 da ishchi muhitni o'rnatish ustasi 
(мастер) mavjud, u tizim yuklangan zahoti ochiladi 
(Startup/Начало работы/Ish boshlanishi -  darchasi). Startup 
dialog diagrammasining yuqori qismida (1.3-rasm) to'rfta qator 
joylashgan:

* Open a  Drawing (Открыть чертеж/Chizmani ochish) -  
chizmaning mavjud faylini ochish;

♦ Start from Scratch (Начать с нуля/Noldan boshlash) -  
parametrlari indamaslik bo'yicha AutoCAD tomonidan 
o'matiladigan yangi chizmani yaratish;

• Use a  Template (Использовать шаблон/Shablondan 
foydalanish) -  yangi chizmada ilgari yaratilgan shablonlar 
parametrlarini o'rnatish;

* Use a Wizard (Использовать мастер/Ustadan foydalanish) 
-  yangi chizma parametrlarini o'matishning qadam-ba qadam 
jarayonini ishga tushirish; bunda o'matishning ikkita variant!: 
detali -  Advanced Setup va tezkor -  Quick Setup boMishi 
mumkin.

1,5-mashq, Ishchi muhit param etrlarini o'rnatish
Ustaning dialog darchasi (1.9-rasm) ishchi muhit parametrlarini 

o‘rnatishnmg ikki rejimiga ega. Parametrlami tezkor. o'rnatish ikki



bosqichdan tarkib topgan. U faqat chizma chegaralarini va 
masofalami o‘ichash birliklarini berish imkonini beradi.

Biz ishchi muhit parametrlarini detalli o'matish Advanced 
Setup (Детальная настройка/Detalli o‘matish)dan boshlaymiz.

Detalli o‘matish besh bosqichdan iborat Ishchi muhitning 
quyidagi parametrlari o‘matilsin:

♦ chiziqli kattaliklar o'lchov birligining turi Units va ulaming 
aniqligi Precision -  Decimal (Десятичные/О'пН) tizimi va o'ndan 
birgacha aniqlikni tanlang, Next (Далее/Keyin) knopkasini bosing 
(har to‘xtagandan keyin);

♦ burchak kattaliklarini taqdim etuvchi formatlar Angle va 
ulaming aniqligi -  o'nlik tizimni tanlang;

♦ burchak kattaliklami hisoblash uchun baza -  East 
(BocTDK/Sharq)ni o‘mating;

♦ burchak kattaliklami hisoblash yo'nalishi -  soat strelkasiga 
teskari yo‘nalishni tanlang;

♦ chizma ishchi maydonining chegaralari -  A4 (210x297mm 
-  1.10-rasm) formati oMchashlarini tanlang, so‘ngra dialog 
darchasidan chiqish uchun Finish (Готово/Таууог) knopkasini 
bosing.

1.9-rasm. Ishchi muhit parametrlarini o ‘matuvchi ustaning dialog darchasi
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1.10-rasm. Chizma maydoni o ‘lchamlarini o'rnatish dialog darchasi

Shuni qayd etish lozimki, format o'lciiamlarini Format => 
Drawing Limits (Формат => Границы чертежа/Format => 
Chizma chegaralari) komandasi orqali ham o'rnatish mumkin.

1.4. Koordinatalar tizimi
AutoCAD tizimida istalgan grafik primitivni qurish nuqtalar 

ketma-ketligini berishga asoslangan. Nuqtalar koordinataiari 
absolyut yoki nisbiy koordinatalar ko‘rinishida kiritilishi mumkin.

Absolyut koordinatalami kiritish ikki formatda amalga 
oshiriladi:

• to ‘g 'r i burchakli (Dekart) koordinataiari (X, Y);
• qutb koordinataiari (r<A, bu yerda r -  radius, A -  soat 

strelkasiga teskari yo‘naIishda graduslarda berilgan burchak).
Nisbiy koordinatalar oxirgi kiritilgan nuqtadan X va Y o‘qIari 

bo‘ylab siljishni beradi. Nisbiy koordinatalaming kiritilishi 
absolyut koordinatalami kiritishga o'xshash bajariladi, lekin 
ulaming oldida @ belgisi qo‘yiladi (@dx,dy -  to‘g‘ri burchakli



tizim, @г<А -  esa qutb tizimi uchun). Sichqon kursorining joriy 
koordinatalari koordinataiar panelida holatlar qatorida (ekranning 
chapdagi pastki burchagi) aks ettiriladi.

Qutb rejimida chiziqlar turii burchaklar ostida o‘tkaziladi, 
ortogonal rejimda esa chiziqlar faqat koordinataiar o‘qiari bo‘ylab 
o‘tkazijadi. Bir rejimdan ikkinchisiga o'tish holatlar qatoridagi 
ORTHO (ORTO) va POLAR (Полярный/Qutbiy) komanda 
knopkalarini sichqonni shiqillatish bilan amalga oshiriladi.

1.6-ntashq. Rombni chizish
1. «Чертеж 1» fayli ochilsin (agar u yopilgan bo'lsa).

Instrumentlar paneli Draw (PHCOBaHHe/Chizish)dagi Line 
(Отрезок/Kesma) piktogrammasini tanlang (1.5-rasm) va 
unda sichqon knopkasini shiqillatib, uni oching. Bunda 
komanda qatorida quyidagi komandani kiritishga taklif 
paydo bo‘ladi: C o m m a n d :  l i n e  S p e c i f y  f i r s t
p o i n t :  ( К о м а н д а :  О т р е з о к .  О п р е д е л и т ь
п е р в у ю  T 0 4 K y : / K o m a n d a :  K e s m a .  B i r i n c h i  
n u q t a  a n i q l a n s i n : ) .

2. Keyin klaviaturadan, l.Il-rasm  komanda qatoridagi 
iistingga muvofiq, probel qoldirmasdan X va Y 
koordinatalari kiritilsin.

■7?8№?.2357)2,OOCOO” VtÎ taEI<A C7rD~0TCrofl̂
1.1 l-rasm . Rombni chizish



Koordiimtalarni bog‘)asb
Sichqon yordamida nuqtalar koordinatalarini aniq kiritish 

uchun AutoCADda inaxsus komandalar mavjud:
• qadamli bog'lash SNAP -  nuqtalar koordinatalarini 

tasavvurdagi setka uzellariga bogMash rejimi (komanda 
qatoridagi GRID (SETKA) knopkasi yordamida setkani 
ko'rinadigan qilish mumkin), bu rejimda sichqon kursori 
faqat setka uzellari bo‘ylab siljiydi;

• obyektli bogMash OSNAP -  koordinatalami yaratib 
boMingan obyektning har xil nuqtalariga bogMash.
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1.12-rasm. D rafting  Settings (Параметры привязки/Во§‘1азЬ parametrlari) 
dialog darchasi, Snap and  G rid  (Привязка н ceTKa/Bog‘lash va setka)

qistirmasi

Holat qatoridagi mos nuqtalar yordamida bu rejimlami ulash 
yoki uzish mumkin. BogMashlar xarakteristikalarini Tools => 
Drafting Settings (Сервис => Параметры привязки/Servis =>



Bog‘Iashlar parametrlari) dialog darchasida quyidagi qistirma 
(закладка)1а^ап birini o‘rnatib sozlash mumkin:

• Snap and Grid (Привязка и cerrKa/Bog‘lash va setka) -  
bog‘lash va setka parametrlarini o‘matish uchun (1.12- 
rasm);

* Object Snap (Объектная привязка/Obyektga bog‘lash) -  
obyektga bog‘lash parametrlarini o‘rnatish uchun (1.13- 
rasm).

Dialog darchasini chaqirish uchun menyudan Tools => 
Drafting Settings (Инструменты => Параметры привязки/ 
Instrumentlar => Bog‘Iash parametrlari)ni tanlash kerak.
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1.13-rasm. D rafting Settings (Параметры npi!BH3Kii/Bog‘Iash parametrlari) 
dialog darchasi, O bject Snap (Объектная привязка/Obyektga bog‘lash)

qistirmasi



1.5. Ekranni boshqarish
Chizma elementlari bilan ishlash qulay bo‘lishi uchun 

AutoCADda ekrandagi tasvimi boshqarishning turli komandalari 
mavjud. Ulaming barchasi View (Вид/Тиг) menyusida joylashgan. 
Zoom (Masshtab) komandasi ekrandagi tasvir masshtabini 
boshqaradi. Masshtab kattalashtirilganda ekrandagi hamma 
elementlar, go‘yo foydaianuvchiga yaqinlashgandek, kattalashadi. 
Masshtab kichiklashtirib berilgani sari tasvir maydoniga 
chizmaning tobora ko‘proq qismi tushadi. Zoom (Masshtab) 
komandasining opsiyalarini instrumentlaming standart panelidagi 
piktogrammalar yordamida chaqirish mumkin (1.8-rasmga qarang). 
Quyida bu komandaning asosiy opsiyalari keltirilgan:

-  Zoom Window (Увеличить до окна/Darchagacha
kattalashtirilsin). Opsiya ramka yordamida masshtablanayotgan 
tasvir chegaralarini berish imkonini beradi;

sichqon piktogrammada har shiqiiiatilganida tasvimi ikki marta 
kattalashtiradi;

-  Zoom Out (Уменшить/Kichiklashtirilsin). Opsiya 
sichqon piktogrammada har shiqiiiatilganida tasvimi ikki marta 
kichiklashtiradi;

-  Zoom All (Показать все/Hammasi ko‘rsatilsin). 
Opsiya tasvimi shunday masshtablaydiki, chi2ma chegaralari 
ekranning grafik zonasi bilan ustma-ust tushadi;

©
>  -  Zoom Extents (Показать все объекты/Hamma 

obyektlar ko'rsatilsin). Opsiya chizmada mavjud boMgan hamma 
grafik elementlami ko‘rsatish imkonini beradi;

-  Zoom Preview (Предыдущий масштаб/Oldingi 
masshtab). Opsiya masshtablashning oldingi parametrlarini 
tiklaydi;

-  Zoom In (Увеличить/Kattalashtirilsin). Opsiya



4 -  Zoom Realtime (Масштаб в реальном Времени/Real 
vaqt masshtabi). Opsiya ekrandagi tasvir masshtabini boshqaradi;

42 -  Pan Realtime (Перемещение в реальном
Времени/Real vaqtda siljish). Opsiya panoramalaslmi boshqaradi.

View => Redraw (Вид => Перерисовать Bce/Ko‘rinish => 
Hammasi qaytadan chizilsin) komandasi ekrandagi tasvirni 
qaytadan chizish imkonini beradi.



2. GRAFIK PRIMITIVLAR

AutoCAD tizimida istalgan tasvir ikki oMchamli 
primitivlaming bazaviy to'plami yordamida yaratiladi. Ulami 
chizish uchun komandalar asosiy menyuning Draw 
(Черчение/Chizish) nimmenyusida joylashadi. Lekin grafik 
primitivning komandasini Draw (Ченчение/Chizish) instrumentlar 
paneli piktogrammasi yordamida chaqirish eng oson boMadi. Agar 
bu panel mavjud boMmasa, sichqonning o‘ng knopkasini 
instrumentlar panelining istalgan piktogrammasida shiqillatib uni 
chaqirish mumkin. Bunda ekranda konteksti menyu paydo boMadi, 
undan Draw qatorini tanlab olish lozim.

2.1. Prim itivlar xossalari
Istalgan grafik primitiv chizmaning ma’lum qatlamida 

muayyan tur, qalinlik va rangdagi chiziqlar bilan chizilishi 
mumkin. Bu xossalami berish uchun instrumentlar Layers 
(Слои/Qatlamlar) va Properties (Свойства/Xossalar) panellarida 
joylashgan. Ekranda chiziq qalinligining aksini holatlar qatoridagi 
LW T (Толщ/Qalin) knopkasi bilan ulash yoki uzish mumkin.

Tizim yuklangandan keyin hamma primitivlar uchun avtomatik 
tarzda nolinchi qatlam o'matiladi, unda primitivlarning rangi -  
qora, chizigM -  asosiy turdagi chiziq Continuous (Сплошная/ 
Uzluksiz), qalinligi Default (По умолчанию/Indamaslik bo‘yicha) 
boMib o‘matiIadi. Instrumentlar paneli Properties (Свойства/ 
Xossalar)ning chiziqlar rangi, turi va qalinligi piktogrammalarida 
ByLayeg (По слою/Qatlam bo‘ylab) qatori o‘matiladi, bu uiarning 
joriy nolinchi qatlamdagi o'matishlarga mosligini bildiradi.

2.1-rasm. L ayers (Спои/Qatlamlar) va Properties (Свойства/Xossalar) 
instrumentlar paneli



Chiziq rangi, qalmligi va turini o‘rnatisli 
Primitiv chiziqlar rangi va qaiinligini bu instrumentlaming mos 

ro‘yxatlaridan foydalanib o'zgartirish mumkin. Lineweight 
Control (Выбор толщины линии/Chiziq qaiinligini tanlash) 
instrumenti piktogrammasining strelkasi sichqonning chap 
knopkasi shiqillatilganda ro‘yxatlar ochiladi. Ochilgan ro'yxatda 
(2.2-rasm) chiziqning mos rangini, turini va qaiinligini tanlash 
lozim.
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2.2-rasm. Chiziqlar rangi, qalinligi va turini tanlash

Chiziqlar turini o‘zgartirish uchun Linetype Control (Выбор 
типа линии/Chiziq qaiinligini tanlash) instrumenti strelkasida 
shiqillatish va ro‘yxatdan O ther... (Другое.../Boshqa...)ni tanlash 
kerak (2.2-rasm). Ochilgan Linetype M anager (Мастер типов 
линий/Chiziqlar turlari ustasi) dialog darchasida Load... 
(Загрузить..,/Yuklansin...) klavishasida shiqillating. Load or



Reload Linetypes (Загрузить или обновить типы 
линий/Chiziqlar turlari yuklansin yoki yangilansin) dialog 
darchasida chiziqning zarur turini tanlang va dialog darchasidagi 
OK knopkasida shiqillating. Natijada Linetype Control (Выбор 
типа линии/Chiziq turini tanlash) instrumenti ro‘yxatida 
chiziqlaming yangi turlari paydo bo‘Iadi (ushbu holda 
shtrixpunktirli o‘q chizig‘i).

2.2. Chizmachilik uchun geometrik elementlar
Istalgan chiziq to‘g6ri chiziq kesmalari va egri chiziq 

yoylaridan tuziladi. Chizma to‘g‘ri chiziqli uchastkalarini chizish 
uchun Line (Линия/Chiziq), Constraction Line 
(Конструкционная линия/Konstruksion chiziq), Polyline 
(Ломаная/Singan chiziq), Polygon (Многоугольник/ 
Ko'pburchak), Rectangle (Прямоугольник/То^'п burchakli 
to‘rtburchak), Point (Точкэ/Nuqta) instrumentlari xizmat qiladi. 
Egri chiziqli uchastkalar Arc (Дуга/Yoy), Circle (Окружность/ 
Aylana), Spline (Сплайн/Splayn), Ellipse (Эллипс/Ellips) 
instrumentlari yordamida quriladi.

Draw (Черчение/Chizish) instrumentlar panelidagi 
piktogrammalari bo'yicha primitivlar chizish komandalarini 
(chapdan o‘ngga) bayon qilamiz.

Line komandasi

Line (Линия/Chiziq) komandasi ikki opsiyaga ega, ulami 
chiziq segmentlarini qurish jarayonida komandaning kontekstli 
menyusidan yoki bosh harfni klaviaturadan kiritib tanlash mumkin:

• Undo (Вернуться/Orqaga qaytish) -  egri chiziqning 
komanda tugagunicha eng oxirida shakllantirilgan segmentini 
o‘chiradi;

♦ Close (Замкнуть/Tutashtirmoq) -  chiziqni tutashtirib, oxirgi 
segmentni avtomatik tarzda o‘tkazadi.

Constraction Line komandasi

Constraction Line (Конструкционная линия/



Konstruksion chiziq) komandasi yordamchi chiziqlami o‘tkazish 
uchun xizmat qiiadi, ular detal proyeksiyalari orasida bog'lovchi 
chiziqlar sifatida xizmat qilishi mumkin. Bu chiziqning oddiy 
chiziqdan farqi shundaki, u tasvir masshtabidan qat’iy nazar ikkala 
tarafga ekran chegaralarigacha avtomatik tarzda uzaytiriladi.

Constraction Line (Конструкционная линия/Konstruksion 
chiziq) besh opsiyga ega:

* H or, Ver -  gorizontal va vertikal chiziqlami qurish uchun;
* Ang -  muayyan burchakka oqqan chiziqlami chizish uchun;
a Bisect -  burchak cho'qqisi va burchakning taraflarida

joylashgan ikki nuqta bo‘yicha burchak bissektrisasini qurish 
uchun;

* Offset -  berilgan masofada yoki ko‘rsatiIgan nuqtadan 
istalgan ko‘rsatilgan kesmaga parallel to‘g‘ri chiziq qurish uchun.

Shuni qayd qilish lozimki, Constraction Line 
(Конструкционная линия/Konstruksion chiziq) AutoCAD 2000 
da o‘z ahamiyatini yo‘qotdi, chunki yangi versiyada объектыу 
bog‘!ashda kuzatib turish funksiyasi paydo bo‘ldi, ular real 
geometrik qurishlar o‘miga muvaqqat yordamchi chiziqlami 
generatsiya qilish imkonini berdi.

Polyline komandasi

PoSyline (Ломаная/Singan chiziq) komandasi to‘g‘ri 
chiziqii va egri chiziqli segmentlar ketma-ketligini qurish imkonini 
beradi. To‘g‘ri chiziqli uchastkalarda komanda ham bir 
segmentdan ikkinchisiga o‘tganda, ham bir segment chegarasida 
kenglikni o'zgartirish imkonini beradi:

° Halfwidth (Полуширина/Yarim kenglik) -  segment yarim 
kengligini berish imkonini beradi;

* W idth (Ширина/Kenglik) -  keyingi segment kengligini 
berish imkonini beradi;

* Undo (Отмена/Веког qilish) -  yaratilgan oxirgi segmentni 
bekor qilish;

* Arc (Дуга/Уоу) — komandani yoyni chizish rejimiga 
o‘tkazadi;

° Close (Замкнуть/Tutashtirmoq) -  chiziqni kesma bilan



tutashtiradi;
• Length (Длина/Uzunlik) -  keyingi to‘g‘ri chiziqli 

segmentni oldingi segment yo'nalishida belgilaydi.

Polygon komandasi

tomonlari 3 dan 1024 gacha bo‘lgan to‘g‘ri ko'pburchak quradi. 
Komanda chaqirig‘idan keyin tizim so'roviga javoban ko*pburchak 
tomonlari sonini kiritish Iozim. Keyin ko'pburchakni berishning 
uchta usulidan birini tanlash lozim, ularga quyidagi komanda 
opsiyalari mos keladi:

* Edge (Сторона/Tomon) — berilgan ikki nuqta bo6yicha 
ko‘pburchak istalgan qovurg‘asining holatini aniqlaydi;

e Inscribed in circle (Вписанный в окружность/Aylana 
ichiga joylashgan) -  berilgan markazi va radiusi bo‘yicha tasawur 
qilinayotgan aylanani shakllantiradi, uning ichiga ko‘pburchak 
joylashadi;

* Circumscribed (Описанный вокруг окружности/Ау1апа 
tashqarisiga joylashgan) -  berilgan markazi va radiusi bo‘yicha 
tasawur qilinayotgan aylanani shakllantiradi, uning tashqarisiga 
ko'pburchak joylashadi.

Oxirgi ikki opsiya aylana markazi ko‘rsatilgandan keyin paydo 
bo*Iadi.

Rectangle komandasi
jr—у

Rectangle (Прямоугольник/То^‘п to‘rtburchak) 
komandasi ikkita qarama-qarshi cho‘qqisi bo'yicha to‘g‘ri 
burchakli to‘rtburchakni qurish imkonini beradi. Cho‘qqilami 
berish uchun koordinatalami kiritishning istalgan usulidan 
foydalanish mumkin. Quyidagi opsiyalardan foydalanib to‘g‘ri 
to‘rtburchaklami faskali qilib yoki chetlari silliqlangan qilib berish 
mumkin:

* Chamfer (Фаскэ/Rax) -  cho‘qqidan ikkala tarafdagi 
og'ishlikkacha masofalar berilganda og'ishliklami burchaklar 
bo'ylab shakllantiradi;

Polygon (Многоугольник/Ко‘рЬигсЬак) komandasi



♦ Fillet (CicpyrvieHHe/SilHqlash) -  tutashma radiusining 
qiymati kiritilganda burchaklar silliqlanishini shakllantiradi.

A rc komandasi

Arc (Дуга/Уоу) komandasi aylana yoyini chizish
imkonini beradi. AutoCADda yoyni berishning har xil usullari 
mavjud. Masalan, yoyni:

• boshlang*ich nuqta, markaz va oxirgi nuqta bilan;
• boshlang‘ich nuqta, oxirgi nuqta va radius bilan;
• markaz, boshlang‘ich nuqta va xorda uzunligi bilan va h.k. 

berish mumkin.
Mos opsiya Draw (Черчение/Chizmachilik) nimmenyusidagi 

Arc (Дуга/Уоу) komandasidan tanlab olinadi. Shuni qayd etish 
lozimki, yoy boshlang‘ich nuqtadan soat strelkasiga qarshi 
yo‘naIishda chiziladi.

Circle komandasi

Circle (Окружность/Aylana) komandasi aylanani olti
usulning birida chizish imkonini beradi:

* aylana markazi va uning radiusi bo‘yicha -  Center, Radius 
(Центр, рэдиус/Markaz, radius) opsiyalari;

• aylana markazi va uning diametri bo‘yicha -  Center, 
Diameter (Центр, диаметр/Markaz, diametr) opsiyalari;

• aylana diametrining ikki nuqtasi bo‘yicha — 2 Points (2 
точки/2 nuqta) opsiyalari;

* aylananing uch nuqtasi bo‘yicha -  3 Points (3 точки/3 
nuqta) opsiyalari;

• ikki urinma (ikki kesmaga, kesma va aylanaga va sh.k.) va 
radius bo‘yicha -  Tan, Tan, Radius (Касательная, касательная, 
радиус/Urinma, urinma, radius) opsiyalari;

* uch urinma bo‘yicha -  Tan, Tan, Tan (Касательная, 
касательная, касательная/Шпта, urinma, urinma) opsiyalari.

Komanda opsiyalari Draw (Черчение/Chizmachilik) 
nimmenyusining Circle (Окружность/Ау1апа) komandasidan yoki 
dialog jarayonida komandaning kontekstli menyusidan tanlanadi.



Revision Cloud (Облако/Bulut) komandasi uchta usulda 
belgilashlar qo'yish uchun chizmada zarur bo‘lgan jabhalami 
ajratib ko‘rsatish imkonini beradi:

• Arc length (Длина дуги/Yoy uzunligi) -  bulutda yoy 
uzunligini beradi;

• Object (Obyekt) -  joriy obyektni bulutga aylantiradi;
• Style (Stil) -  bulutni chizish stili: normal yoki 

kalligrafikligini beradi.

Spline komandasi

Spline (Splayn) komandasi chizmada ixtiyoriy shakldagi 
to‘lqinsimon chiziqni Bezye egri chiziqlari ko‘rinishida chizishga 
imkon beradi. Splayn nuqtalar bo‘yicha quriladi, bu nuqtalar 
komanda chaqirilgandan keyin ketma-ket kiritiladi va urinmalar 
bilan boshqariladi.

Ellipse komandasi

Ellipse (Ellips) komandasi ham to‘Iiq ellipsni va uning 
bir qismini qurish imkonini beradi. Ellipsning asosiy parametrlari -  
markazi koordinatalari, katta va kichik o‘q!ar yo‘nalishi va 
o‘IchashIaridir. To‘liq ellipsni ikkita usulda chizish mumkin:

♦ ellips markazi, so‘ngra qolgan parametrlar aniqlansin -  
Center (Центр/Markaz) opsiyasi tanlanadi;

• ellips o ‘qlarining oxirgi nuqtalari aniqlansin -  Axis, End 
(Ось, KOHeu/0‘q, tamom) opsiyalari tanlanadi.

Ellipsning bir qismini qurish uchun Arc (Дуга/Уоу) opsiyasini 
tanlash kerak.

Ellipse Arc komandasi

^  Ellipse Arc (Эллиптическая дуга/Ellipssimon yoy) 
istalgan uzunlikdagi ellips yoyini chizish imkonini beradi. Bunda 
boshlang‘ich ellipsning asosiy parametrlari hamda boshlang'ich va 
oxirgi nuqtalar beriladi.



Insert Block (Вставка блока/Blokni kiritib 
o'matish) va Make Block (Создать блок/BIokni yaratish) 
komandalari bloklami kiritib o'matish va yaratish imkonlarini 
beradi. Blok -  bu bir obyektga birlashtirilgan obyektlar guruhidir. 
Geometrik primitivlar bloklarga kiritilishi mumkin. Blokdagi 
obyektiaming boshIang‘ich xossalari saqlangan holda, bloklami 
chizmaga ko‘p martalab kiritib o‘matish, burish yoki masshtablash 
mumkin.

Point komandasi

Point (Точка/Nuqta) komandasi har xil tordagi belgilar 
yaratish imkonini beradi. Nuqta obyekt hisoblanadi va bosmaga 
chiqariladi. Nuqtaning shakli va o‘lchami Form at => Point Style 
(Формат => Стиль точки/Format => Nuqta stili) komandasi bilan 
aniqlanadi.

Hatch va Gradient komandalari

-гЛ Hatch (Штриховка/Shtrixlash) va Gradient 
(Gradiyent) komandalari kesim shakllarini shtrixlash va berk 
konturlarga tanlangan gradiyentli quyma (rang)ni quyish imkonini 
beradi.

Table va M ultiline Text komandalari

^  Table (Таблицэ/Jadval) va Multiline Text 
(Многострочный текст/Ко‘р qatorli matn) komandasi
chizmalarda jadvallar va matn yozuvlarini yaratish imkonini 
beradi.

Har xil primitivlami chizish bo'yicha mashqlami boshlashdan 
oldin tasvimi yo‘qotadigan va qayta tiklaydigan komandalar bilan 
tanishamiz, chunki chizmani qurishning biror jarayoni bu 
komandalarsiz bajarilmaydi.



3. CffiZMANI TAHRIRLASH

3.1. Primitivlarni yo‘qotisli
A

Obyektni yo‘qotish (o‘chirish) uchun Modify 
(Редактирование/Tahrirlash) instrumentlar panelidagi Erase 
(Удалить/Уо^оЙБЬ) piktogrammasida shiqillatish va 
o‘chirilayotgan narsani ajratib ko‘rsatish yoki oddiygina qilib 
klaviaturada Delete klavishasini bosish kifoya qiladi. Bir qancha 
obyektlami tanlash uchun ulami sichqon bilan ketma-ket ko‘rsatib 
chiqish mumkin. Sichqonni ekran bo‘ylab yuritib ramka (to‘g‘ri 
to‘rtburchak) yordamida ham obyektlami ajratib ko‘rsatish 
mumkin.

Gldingi komandalarni bekor qilish
^  Eng oxirgi bitta komandani bekor qilish uchun 

instrumentlaming standart panelidagi Undo (Отмена/Веког qilish) 
piktogrammasida shiqillatish kerak. Piktogrammada har bir 
shiqillatilgandan keyin bajarilganlar ro‘yxatidagi oxirgi komanda 
bekor qilinadi.

Redo (Вернуть/Qaytarilsin) komandasi Undo komandasi 
bekor qilganlaming hammasini, agar ular klaviaturadan kiritilgan 
bo'lsa, qayta tiklaydi. Agar Undo komandasi instrumentlaming 
standart paneli strelkasi yordamida bir necha marta chaqirilgan 
bo‘lsa, bu holda Redo komandasi faqat eng oxirgi bekor qilingan 
komandani qayta tiklaydi xolos.

Ekranda tasvimi qayta tiklash uchun yana oops (oy) komandasi 
ham bor. U faqat grafik obyektni o‘chirishning eng oxirgi 
komandasiga nisbatan ta’sir qiladi.



3.1-mashq. A4 format ramkasini qurish
3.1-rasmga muvofiq qurishlami bajaring.

3.1-rasm. A4 format! ramkalarini va chizma elementlarini chizish

G:

Q

Какasaa:
Кснаяаа: _ l ln e  Вереая течка:
С геяу х са я  т е ч к а  ш а  [О та в я и т ь ]: 0 .0
В т о ч к е  [6 1 5 . 3 9 1 3 ,  7 6 1 . 6 4 1 3 ,  0 .0 0 0 0 1  с о з д а н а  в ч з х я  и у с е в о й  д ш е и н  
С а е в у х е а я  т е ч к а  и л и  ( О т а г ю т ъ ] : Э 

л е я у т и а а  т о ч к а  и л и  ( З Е е а ш у т ь / О т г в к т ь ) :  б  
С з е д у п т а я  т о ч к е  и д и  С З е к Е в у т ь / О т к е т г г ь )  :  7  
С л е д у в д з д  т о ч к а  ш зм  [ З а я к я у т ь / С г т а е н к т ъ ! :  О 
С л е п у т и о я  т о ч к а  и л и  ( З е я к я у т й / О т е в к т ь )  :  З в я к н у т ь  
iB T O t a r a t e c K c e  е о х р а я е в я е  в  C : \ 7 r a p \ l _ l _ l _ 0 2 9 3 . s v $  . . .
■енэдае:
К си аааа: _ с сс ео п д
Вервий у г о л  яля  Кзска/Уром нь/С опрвггапие/Еш готй/Ш ирииа]: 2D0 
в то ро й  у г о л  ила [Ш ю 1э д ь /р о гк гр к /п а8 о р о т): 250

!ои9л а о :

3.2-rasm. Line (Линия/chiziq) va R ectangle (Прямоугольник/Го^‘п  
to‘rtburchak) komandalari listingi

1. «Чертеж 1» (format A4) faylini oching, mavjud qurilma 
(chizma)lami Erase (Удалить/Уо^ойэЬ) instrumenti yoki Delete 
klavishasi yordamida yo‘qoting.

2. Line (Линия/Chiziq) komandasidan foydalanib, (210x297 
mm) formatli ramkani chizing, nuqtalar koordinatalarini 3.2- 
rasmdagi listingga muvofiq bering.



3. So‘ngra 0,3 mm chiziq qaiinligini o‘mating va Rectangle 
(Прямоугольник/То^'п to‘rtburchak) komandasidan foydalanib, 
chizma ramkasini chizing.

4. Nuqtalar koordinatalari: chapdagi nuqta -  X=20, Y=60; 
o‘ngdagi nuqta -  X=205, Y=60 bo‘lgan gorizontal to‘g‘ri chiziqni 
o‘tkazing.

5. Polygon (Многоугольник/Ко‘рЬигс11ак) komandasidan 
foydalanib, chizma maydonining yuqorigi o‘ng qismida radiusi 15 
mm bo‘lgan aylana tashqarisida (3.3-rasmdagi listingga mos 
ravishda) oltiburchak chizing.

Is

K s n a s a a :

Х о н а т а а :  _ p o l y s o n  Ч и с л о  с т о р о н  < 4> :  6 
S ^ n s o ir e  и е п т р  н п о г о у г о л ь к к к а  и л и  [ С т о р о н а ] :

З а д а е т е  o m r m  р а л к а о г н я л  [ Е п к с а д г с о !  в  о к р у а в з с г ь / С т а с а е т а о  ы к р у р  е г .р у д т а г т и ]  

< С > ! В

? о д к у с  о я р у в в е е т х :  в о  

К о н ы а а н

3.3-rasm. Polygon (Многоугольник/Ко‘рЬигсЬак) komandasi Jistingi

6. Line (Линия/Chiziq) va Arc (Дуга/Уоу) komandalaridan 
foydalanib, 3.l-rasmga muvofiq berk kontur chizing:

- setka qadami bo‘yicha mo‘ljallab, Line (Линия/Chiziq) 
komandasi va setka uzellari bog‘lanishIari (SNAP (PRTV) 
va GRID (SETKA) holat qatorlari knopkalari)dan 
foydalanib, to‘g*ri chiziq 1 ni chizing;

- Draw => Arc => Continue (Черчение => Дуга => 
Продолжить/ Chizmachilik => Yoy => Davom ettirilsin) 
tanlab olinsin va radiusi 30 mm bo‘lgan aylananing yoyi 2 
chizilsin;

- to‘g‘ri chiziq 1 ga simmetrik qilib to‘g‘ri chiziq 3 
o ‘tkazi!sin;

- Line (Линия/Chiziq) komandasidan foydalanib, kontur 
tosg‘ri chiziq bilan berkitilsin;

- chiziqnmg mos turini tanlab, o‘q chizig‘i chizilsin.
7. File => Save As (Файл => Сохранить icaic/Fayl => Kabi 

saqlansin) komandasidan foydalanib qurilgan chizmalar «Чертеж



1» nomi ostida saqlansin. Do you want to replase it? (Хотите ли 
Вы 3aMeHHTb?/Siz almashtirishni istaysizmi?) so‘roviga javoban 
Yes (Да/На) knopkasini bosing.

3.2. Obyektga bog‘lanishlardan foydalanib geometrik 
qurishlar

Geometrik primitivlar nuqtalarining koordinatalarini aniq 
kiritishni klaviatura orqali yoki nuqtalarni setka uzellariga bog‘lash 
yordamida amalga oshirish har doim ham qulay bo‘Iavermaydi. 
AutoCAD (boshlangMch, oxirgi, aylana markazi va h.k.) nuqtani 
so‘ragan istalgan holda obyektga bog'lanishdan foydalanish 
mumkin. Bu holda ekran xochiga maxsus simvol -  nishon 
qo‘shiladi.

' Obyektga bog‘lanishni OSNAP (OPRTV) holat qatorining 
knopkasi yordamida ulash va uzish mumkin, u yoki bu obyektga 
bogianishni esa Tools => Drafting Settings (Сервис => 
Параметры привязки/Servis => Bog‘lanish parametrlari) dialog 
darchasidagi Object Snap (Объектная привязка/Obyektga 
bogManish) qistirmasi yordamida o'matish mumkin (1.13-rasmga 
qarang). Instrumentlar panellaridagi istalgan piktogrammani o‘ng 
knopka bilan shiqillatib Object Snap (Объектная привязка/ 
Obyektga bog‘lanish) instrumentlar panelini chaqirish mumkin 
(3.4-rasm).

- Г 7 / х х ™ Г @ й  x # s h  • . !а ж - л ;

3.4-rasm. O bject S nap  (Объектная привязка/Obyektga bog‘lanish) 
instrumentlar paneli

Zarurat bo'lganda baravariga bir nechta eng ko‘p 
qo'IIaniladigan bog‘lanishlami ulash mumkin. AutoCAD 2007 da 
hammasi bo‘lib 13 ta obyektga bog‘lanishIar mavjud:

• Endpoint (Конец/Oxiri) -  chiziq yoki yoyning eng yaqinda 
joylashgan oxirgi nuqtasiga bog'lanish;

e Midpoint (Середина/0‘Па${) -  chiziq yoki yoyning o‘rta



nuqtasiga bog‘lanish;
* Center (Центр/Markaz) -  aylana, yoy yoki ellipsning 

markaziga bog'Ianish;
* Node (Uzel) -  nuqtaviy elementga bog'lanish;
* Q uadrant (Kvadrant) -  yoy, aylana yoki ellipsdagi 

kvadrantning eng yaqin nuqtasiga (0°, 90°, 180°, 270°) bog'Ianish;
* Intersection (IlepeceHeHHe/Kesishish) -  ikki obyekt 

kesishishiga bog'lanish;
* Extension (Продолжение/Davomi) -  chiziq yoki yoy 

davomiga bog‘lanish;
e Insertion (Вставка/Kiritib o'matish) -  matn, blok kiritib 

o'rnatilgan nuqtaga bog‘lash;
* Perpendicular (Perpendikulyar) -  chiziq yoki yoydagi 

nuqtaga bog‘lash; bu shunday nuqtaki, u oxirgi nuqta bilan 
birgalikda ushbu obyektga normal hosil qiladi;

e Tangent (Касательная/ипмпа) -  aylana yoki yoydagi 
nuqtaga bog'lash; bu shunday nuqtaki, u oxirgi nuqta bilan 
birlashtirilganda urinma hosil qiladi;

* Nearest (Ближайшее/Eng yaqin) -  aylana yoki yoydagi, 
xochga eng yaqin joylashgan, nuqtaga bog‘lash;

® Apparent insertion (Мнимое пересечение/Mavhum 
kesishish) -  faraz qilinayotgan kesishish nuqtasiga bog‘Iash (ikki 
obyektning «Kesishish» nuqtasini qidiradi, ular fazoda kesishish 
nuqtasiga ega emas -  ayqash to‘g‘ri chiziqlar -  ular faqat 
ekrandagina ko‘rinadigan kesishish nuqtasiga ega);

* Parallel (Parallel) -  oldin chizilgan chiziqqa parallel 
bo'Igan chiziq o‘tkazish imkonini beradi.

Bulardan tashqari kuzatish funksiyasi Auto Track 
(Автоматическое отслеживание/Avtomatik kuzatish) funksiyasi 
ham mavjud, u ikki opsiyani: qutbiy kuzatish va obyektga 
bog‘Ianishdagi kuzatishni qamrab olgan. Auto Track (holat 
qatoridagi OTRACK knopkasi) avtomatik kuzatish rejimi 
ulanganda, tizim vaqtinchalik yordamchi chiziqlami generatsiya 
qiladi, bu obyektlaming aniq holatlarda, aniq burchaklar ostida 
yaratilishini ta’minlaydi va chizmani yaratish vaqtini sezilarli 
darajada tejaydi.



3.2-masItq. Ikkinchi proyeksiyalarni qurish 
■ 3.5-rasmga muvofiq qurilishlar bajarilsin:
1. «Чертеж 1» faylini oching va o‘sha zahoti, hali hech 

qanday amallami bajarmasdan, uni «Чертеж 2» nomi ostida 
oonlano Runda birlamchi chizmalar «Чертеж 1» faylida saqlanadi 
va unga istalgan paytda qaytish mumkin.

3.5-rasm. Obyektga bog‘lanish!ardan foydalanib chizma elementlarini chizish

2. Sichqon o‘ng knopkasini OSNAP knopkasida shiqillatib 
bog‘Ianishiami o‘matish dialog darchasini chaqiring. Endpoint 
(Конец/Oxiri), Midpoint (CepeAHHa/0‘rtasi), Center 
(Центр/Markaz), Quadrant (Kvadrant), Intersection 
(nepeceHeHHe/Kesishish) bog‘lanishlarini o‘mating.

3. OTRACK knopkasini bosib, obyektga bog‘lanishda holat 
qatorida kuzatish rejimini ulang va SNAP knopkasini bosib setkaga 
bog'lanish rejimini o'chiring.

4. Markazi, yoy markazi bilan ustma-ust tushadigan aylanani 
chizing:

- Circle (Окружность/Aylana) komandasini chaqiring;
- kursomi taxminan katta yoy markaziga olib keling va 

Center (Центр/Markaz) yozuvi paydo bo‘iganda sichqonning chap 
knopkasini shiqillating, bunda aylana markazi aniq katta yoy



markazidajoylashadi;
- klaviaturadan aylana radiusi 15 mm ni kiriting.

3.6-rasm. Obyektga bog‘ianishdan foydalanib olti burchakni chizish

3.7-rasm. Obyektga bogManishlardan foydalanib olti yoqlik qovurg‘alarmi
chizish

5. Oltiburchak tasvirini bajaring:
- Rectangle (Прямоугольник/То^'п to‘rtburchak) 

komandasini chaqiring;
- to‘geri to‘rtburchakning birinchi nuqtasi haqidagi komanda 

so‘roviga kursorni oltiburchakning chapdagi eng chekka nuqtasiga 
keltiring (3.6,a-rasm) va Endpoint (Конечная точка/Chekkadagi 
nuqta) yozuvi paydo bo‘lganda sichqonning chap knopkasini 
bosing va sichqon kursorini diagonal bo'ylab pastga yurgizing 
(3.6,b-rasm). Keyin 3.6,b-rasmga muvofiq to‘g‘riburchakning 
ikkinchi nuqtasini belgilang. Line (Линия/Chiziq) komandasini 
chaqiring va to‘g‘riburchakda vertikal to‘g‘ri chiziqlami (old



yoqlik qovurg‘alarini) quring (3.7,a-rasm).
6. Oltiburchak ichiga aylana chizish:
- Circle (Окружность/Ау1апа) komandasini chaqiring;
- aylana markazi haqidagi so‘rovga (sichqon knopkasini 

bnsmasdan) chekka nuqta (burchak)dan va oltiburchak 
tomoni o‘rtasidan o‘tgan kuzatish chiziqlarinmg kesishish 
nuqtasi ko‘rsatiIsin (faqat mos yozuv paydo bo‘lgandagina 
nuqta kiritiladi, ya’ni sichqon shiqillatiladi);

- aylana radiusi haqidagi so‘rovga javoban kursor 
oltiburchakning istalgan tomoniga keltiriladi va Midpoint 
(Средняя точка/0‘г1а nuqta) yozuvi chiqqanda (3.7,b-rasm) 
sichqonning chap knopkasini shiqillating.

7. Aylananing o‘q chiziqlarini chizing (3.5-rasm):
- Linetype Control (Выбор типа линии/Chiziq turini 

tanlash) instrumentlar ro‘yxatida shtrix-punktirli chiziqni 
tanlang (agar ro'yxatda bo'Imasa, uni 2.2-rasmga muvofiq 
yuklash kerak (ISO dash dot));

- Lineweight Control (Выбор толщины линии/Chiziq 
qaiinligini tanlash) instrumentlar ro‘yxatida 0,2 mm 
qalinlikdagi chiziqni tanlang-2.2-rasm;

- Line (Линия/Chiziq) komandasini chaqiring va 3.5-rasmga 
muvofiq boshlangMch nuqtani aniqlang (kuzatish chizig’ini 
aylana markazidan boshlang). Oxirgi nuqtani aniqiash uchun 
kursomi pastga tushiring va aylana tasviri chegarasidan 
tashqarida sichqonni shiqillating;

- keyin olti yoqlik proyeksiyalari uchun o‘q chiziqlarini 
chizing.

8. 5-banddagiga o‘xshash ravishda detaining ikkinchi 
proyeksiyasi (oldindan ko‘rinish)ni quring, u 3.5-rasmda 
ko'rsatilgan to^g^ri to^rtburchak bo‘lib, uning vertikal chiziqlari 
aylananing hamda yoy va tocg‘ri chiziqning chekka nuqtalari bilan 
proyeksion bog'lanishda bo‘ladi. So'ngra o‘q chiziqlarini 
o‘tkazing.

9. 0 ‘tkir burchakli -  60° parallelogramm quring (3.8-rasm):
- bogMashlami sozlash dialog darchasini chaqiring va Parallel 

(Parallel) bog‘Ianishini o‘rnating, Midpoint



(CepeAHHa/0‘rtasi), Center (Центр/Markaz), Quadrant 
(Kvadrant), Intersection (Пересечение/Kesishish) 
bog‘lashlami o‘chirish mumkin;

- Line (Линия/Chiziq) komandasini chaqiring, birinchi 
nuqtani kiritish haqidagi so‘rovga 3.5-rasmdagiga muvofiq 
ekran o‘mida sichqonni shiqillating, ikkinchi nuqta haqidagi 
so‘rovga uning qutb koordinatalarini solishtirma format 
@40<120 da kiriting;

- ko‘rsatkichni o'ngga suring, bunda @40<60 uzunlikdagi 
kesma kiritiladi;

- birinchi kesmani ko‘rsatib (sichqon knopkasini bosmasdan) 
va Parallel (Parallel) yo‘rig‘i paydo bo‘lishini kutib, 
chiziqni birinchi kesmaga parallel qilib davom ettiring;

- birinchi kesma oxirgi nuqtasi (parallelogrammning ikkinchi 
qurilgan nuqta)ni ko‘rsating, u ikkita kuzatuvchi chiziq va 
ularning kesishish nuqtasida mos yozuv paydo bo'lgandan 
keyin (3.8,a-rasm) aniqlanadi, keyin sichqon chap 
knopkasini shiqillatib natijani belgilab qo‘ying; so‘ngra 
to‘rtinchi tarafni qurib, chizmani berkiting.

3.8-rasm. Parallelograramni va uning tarafiga perpendikulyami chizish

10. Parallelogramm tomoniga perpendikulyar chizing (3.8,b-

- bog‘lanishlami sozlash dialog darchasini chaqiring va 
Perpendicular (Perpendikulyar) bog‘lanishini o‘mating;

- Lineweight Control (Выбор толщины линии/Chiziq 
qalmligini tanlash) instrumentlar ro‘yxatida chiziq

rasm):



qalinligini 0,2 mm o'mating;
- Line (Линия/Chiziq) komandasini chaqiring;
- birinchi nuqtani ixtiyoriy tanlang, ikkinchisini esa 

parallelogramm og‘ma chizig‘ini ko‘rsatib, Perpendicular 
(Perpendikulyar) yo‘rig‘i yordamida tanlang (3.S, b-rasm); 
nuqtani sichqon yordamida qayd eting.

11. Chizmani saqlab qo‘ying.

3.3. Qatlamlar
Har bir primitivga chiziq turi, qalinligi va primitiv joylashgan 

qatlami kabi xossalar xosdir. Qurish davomida primitivlami 
yaratishdan oldin bu xossalami o'matish mumkin. Kontur, o‘q 
chiziqlari, o‘Ichamlari, shtrixovkalari va sh.k.lar ko‘p bo'lgan 
murakkab detal chizmasini chizishda chizmaning alohida 
elementlarini alohida qatlamlarda bajarish qulay.

Dastlab tizim yuklanganda bitta -  nolinchi (tizimiy) qatlam 
o‘matiIadi, unda chizish tavsiya etilmaydi. Chizma 
murakkabligidan qat’iy nazar, yaxshisi hech bo‘lmaganda o‘zining 
parametrlariga ega boMgan bitta yangi qatlam yaratish kerak va uni 
joriyga aylantirib, chizmani shu qatlamda chizish lozim. Yangi 
qatlamlami Layer Properties M anager (Настройка свойств 
слоя/QatlamIar xossalarini sozlash) dialog darchasida yarating -  
3.9-rasm, bu darcha Form at => Layer... (Формат => 
Слои.../Format => Qatlamlar...) menyusidan yoki Layers 
(Слои/Qatlamlar) instrumentlar panelida mos knopka shiqillatib 
chaqiriladi (2.1-rasmga qarang).

Yangi qatlamni yaratish uchun New Layer (Создать/Yaratish) 
knopkasida shiqillatish yoki Alt+N klavishalar majmuini bosish 
kerak. Bunda yangi darchada ajratilgan qator paydo bo‘ladi, unda 
indamasdan kelishganlik bo'yicha o‘matilgan yangi qatlamning 
parametrlari aks ettiriladi:

• Set (Status) -  ro‘yxat element! statusi aks ettiriladi. Zangori 
rangli qog‘oz varag'i ko‘rinishidagi belgi foydalanilayotgan 
qatlamlarga, kul ranglisi -  bo‘sh qatlamlarga mos keladi, joriy 
qatlam M  ko‘rinishida aks ettiriladi;

• Name (Имя/Nomi) -  qatlam nomi. Indamasdan kelishganlik



bo‘yicha «Layer 1» («Слой l»/«Qatlam 1») nomi beriladi;
* On (Вкл/Yoqmoq) -  qatlam ko‘rinuvchanligi. Faqat 

ko‘riladigan qatlamlarda joylashgan ( -  Iampochka 
«yonayotgan»dagi) primitivlargina chiziladi, qatlamni 
ko‘rinmaydigan qilish uchun Iampochka tasvirida sichqonni 
shiqillatish lozim (Iampochka yorug‘ligi kamayadi);

* Freeze (Заморозить для всех сечений/Hamma kesimlar 
uchun muzlatish) — qatlamni saqlash. Primitivlami generatsiya 
qilish (qayta chizish) imkoniyati to‘xtatiladi;

* Lock (Зафиксировать/Blokirovka qilish) -  blokirovka 
qilish. Qatlam blokirovka qilinishi (qulflangan qulf) mumkin, ya’ni 
undagi primitivlaming tasviri ko‘rinadi, lekin ulami tahrirlab 
(o'chirib, siljitib va h.k.) bo‘lmaydi; indamasdan kelishganlik 
bo‘yicha qatlam blokirovkadan yechilgan;

* Color (Свет/Rang) -  ushbu qatlamda primitivlaming 
rangini belgilaydi;

* Linetype (Тип линии/Chiziq turi) -  indamasdan 
kelishganlik bo‘yicha Continuous (Сплошная/Uzluksiz) 
o‘matiIadi, agar dialog darchasida zarur boMgan chiziq turi 
boMmasa, uni Load... (Zagruzka..JYuk!ash...) klavishasida 
shiqillatib yuklash mumkin;

* Lineweight (Толщина линии/Chiziq qalinligi) -  Default 
(По умолчанию/Indamasdan kelishganlik) o‘matiIadi, chiziqning 
zarur boMgan qalinligi ro‘yxatdan tanlanadi, ro‘yxat esa Default 
qatorida sichqon shiqillatilganida paydo boMadi;

* Plot Style (Стиль чертежа/Chizma stili) -  parametr 
primitiv rangiga qarab chizma stilini tanlashga bogMiq;

* Plot (Grafika) -  chizma chop etilayotganda ushbu 
qatlamdagi tasvir ulanadi (kiritiladi) yoki uziladi;

* Description (Пояснение/Tushuntirish) -  joriy qatlamga 
tushuntirishlami yaratadi.

Boshqa qatlamni joriy sifatida o‘matish uchun dastlab ushbu 
qatlam nomida sichqonni shiqillatish, so'ngra dialog darchasining 
Set C urrent (Текущий/Joriy) knopkasida sichqonni shiqillatish 
kerak. Qatlamni olib tashlash uchun uning nomini tanlash va 
Delete (УдалитьЛУсЬшзЬ) knopkasida shiqillatish kerak.



3.3-mashq. Qatlamlarni yaratish va obyektlarni ко ‘chirish
1. «Чертеж 2 (Chizma 2)» faylini oching.
2. Yangi qatlamlarni yarating va ulaming parametrlarini 3.9,a- 

rasmdagiga muvofiq o‘mating, so‘ngra OK knopkasini bosib, 
darchani berkiting.

i M f t f f l f e y  ... .    .. ....
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3.9-rasm. L ayer P roperties M anager (Настройка свойств слоя/Qatlam 
xossalarini sozlash) va P roperties (Свойства/Xossalar) dialog darchalari

3. Hamma o‘q chiziqlarini 0 ‘q qatlamiga ko‘chiring:
- sichqon yordamida hamma o‘q chiziqlarini ajrating (3.5- 

rasmga qarang);
- sichqonni strelkada shiqillatib Layers (Слои/Qatlamlar) 

instrumentlar panelidagi Layer Control (Управление 
слоем/Qatiamni boshqarish) ro‘yxatini oching;

- «Оси» ( 0 ‘qlar) yozuvida sichqonni shiqillating;
- 0*qlar chizig‘ini tanlagandan so‘ng ushbu operatsiyani 

Layers (Слои/Qatlamlar) panelidagi M ake O bjecfs Layer



C urrent (Сделать слой объшсга текущим/ОЬуек! qatlami joriy 
qilinsin) knopkasini bosib bajarish mumkin. Qayd etilgan amallar 
natijasida hamma o‘q chiziqlari 0 ‘q qatlamiga ko‘chadi va bu 
qatlam joriy bo'lib qoladi (qatlamiami boshqarish ro‘yxatida 
«Оси» (0 4qlar) yozuvi paydo faocladi).

4. 0 ‘xshash operatsiyalar yordamida chizmaning qolgan 
elementlarini o‘zlarinmg qatlamlariga: kontur chiziqlar -  Kontur 
qatlamiga, ramka chiziqlari -  Ramka qatlamiga ko‘chiring.

5. Chizmani saqlab qo‘ying.
AutoCAD 2007 da obyekt yoki obyektlar guruhi xossalarini 

Properties (Свойства/Xossalar) dialog darchasida o'zgartirish 
mumkin. Buning uchun sichqon o‘ng knopkasini ekranda 
shiqillatib obyektni ajratish va kontekstli menyudan Properties 
(Свойства/Xossalar) opsiyasini tanlash kerak, bunda ekranda 
dialog darchasi paydo bo'Iadi (3.9,b-rasm).



4. CHIZMA ELEMENTLARINI G ‘ZGARTIRISH

Chizmani bajarish jarayonida har bir konstruktorga uni 
korrektirovka qilishga to‘g‘ri keladi. AutoCAD tizimida chizmani 
tahrir qilishda ishlatiladigan komandalami ko‘rib chiqamiz.

4.1. Obyektlami tanlash
Obyektni tahrir qilish uchun dastlab uni tanlab olish zarur. 

Tahrirlovchi ba’zi komandalar (o‘chirish, nusxa olish, ko‘chirish, 
burash, aks ettirish. massivlami yaratish) uchun dastlab obyekt 
yoki bir nechta obyektlami tanlab olish, so‘ngra komandani 
chaqirish yoki buning aksini qilish mumkin. Lekin boshqa 
komandalar (uzaytirish, kesib fashlash, uzish, rax (фаска) va 
silliqlash) uchun Select objects: (Выберите объекты:/ОЬуек11агш 
tanlang:) taklifiga javoban komanda chaqirilgandan keyingina 
obyektlami tanlashga o‘tish mumkin.

Obyektlar guruhini baravariga tanlash uchun AutoCADda turli 
usullar nazarda tutilgan. Tahrir qilish komandalarining Select 
objects: (Выберите объекты:/Obyektlami tanlang:) so'roviga 16 
opsiya mavjud.

Obyektlar guruhlarini tanlashda eng ko‘p ishlatiladigan uch 
opsiyani ko‘rib chiqamiz:

• Window (Ramka) -  to‘g‘ri to‘rtburchak ramkasining 
diagonal bo‘yicha ikkita burchak ko'rsatilganda obyektlami 
tanlash jabhasini belgilaydi, bunda ramkaga to‘lig‘icha 
joylashadigan obyektlar tanlanadi;

e Crossing (Пересечение/Kesishish) -  diagonal bo‘yicha 
ikkita burchak ko‘rsatiiganda ramkani kesib o‘tuvchini 
aniqlaydi, bunda nafaqat ramkaga to‘liq sig‘gan obyektlar, 
balki ramkaga qisman joylashgan obyektlar ham tanlanadi;

* ALL (Bce/Hamma) -  chizmadagi hamma obyektlar 
tanlanadi.

Obyektlami tanlash opsiyasini berish uchun Select objects: 
(Выберите объекгы:/ОЬуек11апи tanlang:) komandasi taklifiga 
javoban uning nomini bosh harflar bilan kiritish lozim.

AutoCAD 2007 da Selection Preview (Предварительный



просмотр/Dastlabki ko‘rib chiqish) funksiyasi bor. Bu funksiya 
kursor ustida siljiyotgan obyektning ajratib ko‘rsatilishini 
ta’minlaydi. Indamaslik bo'yicha obyekt qalinlashtirilgan shtrix 
ehizig‘i bilan ajratiladi.

Tahrir qilishning deyarli hamma komandalari Modify 
(Редактирование/Tahrirlash) menyusida, ulaming
piktogrammalari esa -  ushbu nomdagi instrumentlar panelida 
joylashgan (4.1-rasm). Tahrir qilish komandasini chaqirish uchun 
Modify (Редактирование/Tahrirlash) instrumentlar panelidagi 
mos piktogrammada sichqonni shiqillatish lozim.

Ы  4  i n s  ф  o  a t + - /  □  u  г  г  ^  ]

4.1-rasm. M odify (Редактирование/ТаЬпг qilish) instrumentlar paneli

Tahrir qilish komandalarini ulaming piktogrammalarining 
instrumentlar panelida joylashganligi ketma-ketligida (4.1-rasm) 
ikkinchisidan boshlab bayon qilamiz, chunki Erase 
(Удалить/0‘сЬт5Ь) komandasi yuqorida ko'rib chiqilgan edi.

4.2. Obyektlar nusxasini olish va joylashishini o4zgartirish
Komandalaming bu guruhi obyektlami ko'chirish, ulami 

burash; ko‘chirib va teskari aks ettirib, ulardan nusxa olish; 
obyektlami ma’lum struktura (massiv)larga tartiblab solib, ulardan 
nusxa olish; o'ziga o‘xshashlarini, bunda obyektlar o'lchamlari va 
shaklini o‘zgartirmasdan, yaratish imkonini beradi.

Copy komandasi

Copy (Копировать/Nusxa olinsin) komandasi yaratilgan 
obyekt yoki obyektlar guruhining nusxasini olish imkonini beradi. 
Komanda chaqirilgandan so‘ng ekranda obyektlami tanlash uchun 
nishon kvadrati, komanda qatorida esa -  quyidagi ma’Iumot:

C o m m a n d :  copy  (К о м ан д а :  к о п и р о в а т ь /
K o m a n d a :  n u s x a  o l i n s i n ) ;



S e le c t  o b j e c t s :  (В ы б е р и т е  о б ъ е к т ы : /
O b y e k t l a m i  t a n l a n g : )  paydo bo'ladi.

Obyektlami tanlash tugagandan keyin Enter klavishasini 
bosish yoki sichqon o‘ng knopkasini ekranda shiqillatish kerak. 
Natijada ekranda komandaning quyidagi so'rovi paydo bo‘ladi:

S p e c i f y  b a s e  p o i n t  or  d i s p l a c e m e n t ,  o r  
[ M u l t i p l e ] :  ( О п р е д е л и т е  б а з о в у ю  т о ч к у  и л и  
п е р е м е щ е н и е  и л и  [ Н е с к о л ь к о ] : / B a z a v i y  n u q ta n i .  
a n i q l a n g  y o k i  s i l j i s h n i  yok i  [B i r  n e c h t a ] : ) .

Qaysi nuqtaga nisbatan obyektlami nusxalash mo‘ljallangan 
bo‘lsa, o‘sha nuqtani ko‘rsatish lozim. Bazaviy nuqta kiritilgandan 
so‘ng komanda qatorida ikkinchi so‘rov paydo bo‘ladi:

S p e c i f y  s e c o n d  p o i n t  or  d i s p l a c e m e n t ,  o r  < u s e  
f i r s t  p o i n t  as d i s p l a c e m e n t  ( О п р е д е л и т е  в т о р у ю  
т о ч к у  или  < и с п о л ь з у й т е  п е р в у ю  т о ч к у  д л я  
п е р е м е щ е н и я > / 1 к к т с 1 и  n u q t a n i  a n i q l a n g  y o k i  < 
s i l j i t i s h  u c h u n  b i r i n c h i  n u q t a d a n  f o y d a l a n i n g > ) .

Nuqta tanlanganidan keyin, Enter klavishasini bosish lozim.

M irror komandasi

^  M irror (Отражение/Aks) komandasi obyektning ko'zgu 
aksini shakllantiradi. Bu komanda mashinasozlik chizmalarida 
ko‘p qo'llanadi. Uning yordamida yarim yoki choragi qurilgan 
detal chizmasidan foydalanib, butun detal chizmasini olish 
mumkin. Komanda ishga tushirilgan va obyektlar tanlangandan 
so6ng tizim aks ettirish o‘qi -  simmetriya o‘qining birinchi va 
ikkinchi nuqtalarmi so‘raydi. Ocqqa tegishli istalgan ikki nuqtani 
kiritish mumkin. Nuqtalar kiritilgandan keyin komanda quyidagi 
so'rovni chiqaradi:

D e le te  sou rce  ob jec ts  [Y es /N o]< N >:  (У даление  
и с х о дн ы х  о б ъ е к т о в  [Д а/Н ет] < H > : /B e r i lg an
o b y e k t l a m i  o ‘c h i r i sh  [H a /Y o‘q]<Y >:) .

Indamaslik bo'yicha (Enter klavishasi bosilganda) 
boshlang‘ich obyektlar yo‘qolib ketmaydi (o‘chirilmaydi). 
Boshlang'ich obyektlami yo‘qotish uchun Y ni kiritish lozim.



O ffset komandasi
^  Offset (Отступ/Xat boshi (chekinish)) komandasidan 

to‘g‘ri chiziqli va egri chiziqli kesmalardan normal bo‘yicha 
muayyan masofaga siljigan o ‘xshash kesmalarni yaratishda 
foydalaniladi. Ishga tushirilgandan keyin komanda quyidagi 
so‘rovni chiqaradi:

S pec i fy  o f f se t  d i s t a n c e  or  [Through]  <Through>: 
( О п р е д е л и т е  вели чи ну  отступа или [Точка] 
<To4Ka>/Chek in ish  q iy m a t in i  an iq lang  yoki  [Nuqta]  
< N uq ta>) .

Agar so‘rovga javoban siljish qiymati kiritilsa, tizim quyidagi 
javobni beradi:

Se lec t  o b j e c t  to o f f s e t  or  < e x i t> :  (Выберите  
о б ъ е к т  для подобия  или < Bbixof l> /0 ‘x s h a s h l i k  
u c h u n  o b y e k t n i  t a n l a n g  y o k i  < c h iq i s h > ) .

Obyektlardan birini tanlash kerak, buning uchun unda 
sichqonni shiqillating. Obyektda birinchi marta shiqillatilganda 
quyidagi so‘rov paydo bo'ladi:

S pec i fy  po in t  on s ide  to offse t :  (О пределите  
т о ч к у  со стороны отступа: /Ха1  boshi  ( chek in i sh )  
t a ra f id an  nuq tan i  an iq lang : ) .

Bu so‘rovga javoban sichqon bilan obyektga nisbatan qaysi 
tarafda o‘xshash obyekt yaratilishini ko‘rsatish lozim. So‘ngra 
komandadan chiqish uchun Enter klavishasi bosiladi.

Komanda Array
o n
ОП A rray (Massiv) komandasi tanlangan obyektlardan nusxa 

olish va ulami to‘g‘ri to‘rtburchakli yoki doiraviy massiv shaklida 
joylashtirish imkonini beradi. Komanda ishga tushirilgandan va 
obyektlar tanlangandan so‘ng komanda qatorida quyidagi so‘rov 
paydo bo'ladi:

E n te r  the  type a r ray  [Rec tangu la r /Po la r ]  <R>: 
(В в е д и те  т и п  м асс и ва  [П рямоугольни к /К руговой ]  
< П > : /  M ass iv  tur in i  k i r i t in g  [T o ‘g ‘ri t o ‘r tbu rcha k l i /  
D o i rav iy ]  <T>:) .



Agar Rectangular (Прямоугольный/То^'п to'rtburchakli) 
kiritilsa, komanda quyidagi so‘rovni chiqaradi:

E n t e r  the n u m b e r  o f  row s  ( - )  < 1 > : ( В в е д и т е  
ч и с л о  ст р о к  ( - )  < l > : / Q a t o r l a r  s o n in i  k i r i t i n g  ( - )
< i > 0 ;

E n t e r  the n u m b e r  o f  c o lu m n s  ( I I I )  < 1 > : ( В в е д и т е  
ч и сл о  с т о л б ц о в  ( I I I )  < l > : / Q a t o r l a r  s o n in i  k i r i t i n g  
( I I I )  <  1 > 0 ;

E n t e r  the  d i s t a n c e  b e t w e e n  or  u n i t  c e l l  ( - ) :  
(В в е д и т е  р а с с т о я н и е  м еж ду  с т р о к а м и  или  р а зм е р  
я ч е й к и  ( - ) : /  Q a to r l a r  o r a s i d a g i  m a s o f a n i  k i r i t i n g  
yok i  y a c h e y k a  o ‘ l c h a m in i  ( - ) : ) .

Oxirgi so'rovga javoban yacheyka o‘Ichamini to‘g‘ri 
to‘rtburchakning qarama-qarshi cho‘qqilarining ikkita nuqtasi 
(ramka) bilan berish mumkin, bunda massivdagi qatorlar va 
ustunlar oraliqlari aniqlanadi.

Doiraviy massivni qurish uchun Polar (KpyroBoft/Doiraviy)ni 
kiritish lozim. Komandaning quyidagi so‘roviga javoban E n te r  
the  type  a r r a y  [ R e c t a n g u la r / P o la r ]  <P>: (В в е д и т е  
т и п  м ас с и в а  [ П р я м о у г о л ь н ы й / К р у г о в о й ]  < К > : /  
M a s s iv  tu r i n i  k i r i t i n g  [ T o ‘g ‘ri t o ‘r t b u r c h a k I i /  
D o i r a v iy ]  < D > : )  navbatdagi so‘rovlar chiqadi:

S p e c i fy  c e n t e r  p o in t  o f  a r r ay :  ( О п р е д е л и т е
ц е н т р а л ь н у ю  т о ч к у  M accH Ba: /M ass ivn ing  
m a rk a z iy  n u q ta s i n i  a n i q l a n g : ) ;

E n t e r  the n u m b e r  o f  i t e m s  in the  a r ray :  
(В в е д и т е  ч исло  э л е м е н т о в  в M a c c H B e : / M a s s i v d a g i  
e l e m e n t l a r  s o n in i  k i r i t i n g : ) ;

S p e c i fy  the ang le  to f i l l  (+  = c c w ,  -  =cw )  
< 3 6 0 > :  ( О п р е д е л и т е  угол  з а п о л н е н и я  (+ =c cw ,  -  
=cvv) < 3 6 0 > : /  T o ' l d i r i s h  b u r c h a g i n i  a n i q l a n g ( +  
= c c w ,  -  = c w )  < 3 6 0 > : ) .

Oxirgi so‘rovga javoban markaziy nuqtaga nisbatan massivning 
birinchi va oxirgi elementlari orasidagi burchak qiymatini kiritish 
lozim. To‘Idirish burchagining musbat qiymati soat strelkasinirig 
yo‘nalishiga teskari, manfiy qiymati esa — soat strelkasi



yo‘nalishiga mos bo'ladi.
Oxirgi so‘rov quyidagicha bo‘ladi:
R o t a t e  a r r a y e d  o b j e c t s ?  [Yes / No]< Y>:  

( П о в о р а ч и в а т ь  о б ъ е к т ы  ма с с ив а ?  [ Да / Нет]  <Д>: /  
M a s s i v  o b y e k t l a r i  b u r a l s i n m i ?  [ H a / Y o ‘q] <H>: ) .

Yes (Да/На) javobi berilganda obyektlar kopiyalashda opining 
bazaviy nuqtasiga nisbatan aylanadi. Kesma uchun oxirgi 
nuqtalardan biri, aylana uchun esa -  markaziy nuqta bazaviy nuqta 
vazifasini bajaradi.

M ove komandasi

Move (Перемещение/Siljitish) komandasi obyekt yoki 
оЬуенпаг guruhining siljitilishini ta’minlaydi. Obyektlami 
ko‘chirish jarayoni kopirovka qilish jarayoniga o‘xshaydi. 
Komanda chaqirilgandan va obyektlar tanlangandan so‘ng 
komanda quyidagi so‘rovni chiqaradi:

S p e c i f y  base  p o i n t  or  d i s p l a c e me n t :  
( О п р е д е л и т е  б а з о в у ю  т о ч к у  или п е р е м е щ е н и е : /  
B a z a v i y  n u q ta  y o k i  s i l j i s hn i  an i q l ang : ) .

Bazaviy nuqta berilgandan so‘ng navbatdagi so‘rov chiqadi:
S p e c i f y  s e c o n d  p o i n t  or  d i s p l a c e m e n t ,  or  <use 

f i r s t  p o i n t  as d i s p l a c e m e n t  ( О п р е д е л и т е  вторую 
т о ч к у  или п е р е м е щ е н и е  или и с по л ь зу й т е  первую 
т о ч к у  для  п е р е м е щ е н и я /  Ikk i n c h i  nuq t a  yoki  
s i l j i s h n i  a n i q l a n g  y o i n k i  b i r i nch i  n u q t a d a n  s i l j i t i sh  
u c h u n  f o y da l a n i n g ) .

So‘rovga javoban bazaviy nuqtaning yangi holatini yoki 
birinchi bazaviy nuqtaga nisbatan siljish vektorini berish lozim.

Rotate komandasi

Rotate (Поворот/Burash) komandasi obyekt yoki 
obyektlar guruhini komanda dialogi jarayonida aniqlanadigan 
bazaviy nuqta atrofida aylantirish imkonini beradi. Komanda 
so'rovidan va obyektlar tanlangandan so‘ng komanda quyidagi 
so‘rovIami chiqaradi:



S p e c i fy  bas e  po in t :  ( О п р е д е л и т е  б а з о в у ю
T04Ky: / Bazav i y  n u q t a n i  a n i q l a n g ) ;

S p e c i f y  r o t a t i on  ang l e  o r  [ R e f e r e n c e ] :  
( О п р е д е л и т е  у г о л  п о в о р о т а  или  [ С с ы л к а ] /  
B u r a l i s h  b u r c h a g i n i  a n i q l a n g  y ok i  [ Ha v o l a ] ) .

Oxirgi so'rovga javoban komanda qatoriga burish burchagini 
kiritish yoki Reference (Ссылка/Havola) opsiyasini tanlash 
mumkin. Reference opsiyasi mavjud burchakka nisbatan 
burchakni aniqlaydi. Bunda quyidagi so'rovlar ekranga chiqariladi:

S pe c i fy  t he  R e f e r e n c e  ang l e  <0>:  ( О п р е д е л и т е  
с с ы л а е м ы й  у г о л  < 0 > : / H a v o l a  q i l i n a y o t g a n  
b u r c h a k n i  a n i q l a n g  <0>: ) ;

S pe c i fy  t he  new ang l e :  ( О п р е д е л и т е  н о в ы й  
y г o л : / Y a n g i  b u r c h a k n i  a n i q l a n g ) .

Birinchi so‘rovga javoban obyektning joriy holatini belgilovchi 
burchakni, ikkinchi so‘rovga javoban esa — obyektning yangi 
holatini aniqlovchi burchakni kiritish lozim.

4.3. Obyekt o‘lchamlarini korrektirovlm qilish
Koinandalarning bu guruhi obyektlami butunicha masshtablab, 

ulaming o'lchamlarini o‘zgartirish, obyektlar gumhini siqib yoki 
cho‘zib, ulaming shaklini o'zgartirish, (kesmalar uchun) oxirgi 
nuqtani ko'chirish yo‘li bilan obyekt o‘lchamini o‘zgartish 
imkonini beradi.

Scale komandasi

: ! j J  Scale (Masshtab) komandasi mavjud obyektlar 
oMchamlari o‘zgartirilishini ta’minlaydi. Komanda chaqirilib, 
obyektlar tanlangandan va qaysi nuqtaga nisbatan masshtablanish 
sodir bo‘ladigan bo‘lsa, o‘sha bazaviy nuqta berilgandan keyin, 
komanda quyidagi so‘rovni chaqiradi:

S pe c i fy  s ca l e  f a c t o r  or  [ Re f e r e n c e ] :  
( О п р е д е л и т е  к о э ф ф и ц и е н т  м а с ш т а б и р о в а н и я  или 
[ C c b ^ K a ] : / M a s s h t a b l a s h  k o e f f i t s i y e n t i n i  a n i q l a n g  
y ok i  [ Ha v o l a ] : ) .



Bunga javoban tanlangan obyektlaming hamma o‘lchamlari 
qaysi songa ko*paytiriladigan bo‘lsa, o‘sha sonni kiritish yoki 
masshtablash koeffitsiyentini aniqlash uchun (Ссылка/Havola) 
opsiyasini tanlash lozim.

Stretch komandasi

tasviming bir qismini cho'zib uzaytirish yoki siqib qisqartirish 
imkonini beradi; bunda rasmning (o'zgarmasdan) qolgan qismi 
bilan bog‘lanish saqlanib qoladi.

Komanda chaqirilgandan keyin Se l ec t  ob j ec t s :  
( В ы б е р и т е  о б ъ е к т ы / O b y e k t l a r n i  t a n l ang )  so‘rovga 
javoban lotincha S harfini kiritish, so‘ngra kesuvchi ramka bilan 
obyektlami tanlash lozim. Komandaning keyingi so‘roviga javoban 
bazaviy nuqtani ko‘rsatish, so‘ngra tanlangan (kesilgan va ramka 
ichida joylashgan) obyektlaming yangi holatini sichqoncha bilan 
aniqlash zarur.

Trim komandasi

xrim (Обрезать/Kesib tashlamoq) komandasi obyektning 
bir qismini kesuvchi qirra bo‘ylab aniq o‘chirish imkonini beradi. 
Yuqorida ko‘rib chiqilgan hamma primitivlar hamda shtrixovkalar 
va matn kesuvchi qirra vazifasini o‘tashi mumkin. Komanda ishga 
tushgandan so'ng S e l e c t  o b j e c t s :  ( Выб е р и те  о б ъ е к т ы : /  
O b y e k t l a m i  t a n l a n g : )  so‘roviga javoban obyektlar -  
kesuvclii qirralami tanlash lozim.

Bundan keyin quyidagi so‘rov chiqadi:
Se l e c t  o b j e c t  to t r i m  or [ F e n ce / C r o s s i n g /  

P r o j e c t / E d g e / E r a s e / U n d o / ]  ( Выб е р и те  объект ,  
к о т о р ы й  ну жн о  о б р е з а т ь ,  или [ Л и н и я / С е к у щ а я /  
П р о е к ц и я / К р о м к а / У  дал  HTb/OTMeHa]: /Kesi l i shi  
l o z i m b o ‘ l gan  o b y e k t n i  t a n l ang ,  yok i  [ Ch i z i q /  
K e s u v c h i / P r o y e k s i y a / Q i r r a / Y o ‘qo t i l s i n / B e k o r  
q i l i n i s h ] :).

So4rovga javoban obyektning qaysi qismi yo‘qotilishi

Stretch (Растянуть/Ою^Ь uzaytirish) komandasi



(o‘chirilishi) kerak bo‘Isa, o‘sha qismini ko‘rsatish lozim.

Extend komandasi

Extend (Продолжить/Davom ettirilsin) komandasi 
obyektlami belgilangan chegaraviy qirragacha uzaytiradi. Kesma, 
yoy yoki polichiziq chegaraviy qirra boMishi mumkin.

Bu komandaning strukturasi Trim (Обрезать/Kesib tashlamoq) 
komandasi strukturasini tanlaydi. Dialog jarayonida dastlab 
chegaraviy qirra vazifasini o‘taydigan obyektlar, so‘ngra 
uzaytiriladigan obyektlar tanlanadi.

4.4. Obyektlami konstruksiyalash
Komandalaming bu guruhi obyektga quyidagi konstruktiv 

o‘zgartishlar: faska (rax)lar va birikmalami yaratish, obyektlami 
uzish (Kesish)lami amalga oshirish imkonini beradi.

Break at Point komandasi
Break a t Point (Разорвать в точке/Nuqtada uzish) 

komandasi obyektning nuqtada uzilishini ta’minlaydi. Komanda 
ishga tushgandan va obyekt tanlangandan so‘ng quyidagi so‘rov 
paydo bo‘ladi:

Spe c i fy  f i r s t  b r ea k  poin t :  ( О п р е д е л и т е  п е рв у ю 
T04Ky: / Bi r inch i  n u q t a n i  a n i q l a n g : ) .

Bu so‘rovga javoban sichqon yordamida obyektda uzilish 
nuqtasini ko‘rsatish kerak.

Break komandasi
J Break (Разрыв/Uzish) komandasi obyektni bo‘lak!arga 

o‘chirmasdan yoki obyektning bir qismi (chiziqlar, polichiziqlar, 
splaynlar, yoylar, aylanalar)ni o‘chirib uzishni amalga oshirish 
imkonini beradi. Komanda ishga tushgandan va obyekt 
tanlangandan so'ng quyidagi so*rov paydo boMadi:

Spe c i fy  s e c o nd  b r eak  p o i n t  o r  [ F i r s t  po i n t ] :  
( О п р е д е л и т е  в т о р у ю  т очку  или [ П е р в а я  т о ч к а ] : /  
I k k i n c h i  n uq t a n i  a n i q l a n g  y o k i  [ B i r i n c h i  nuq t a ] ) .



Bu so'rovga javoban sichqon yordamida obyektda ikkinchi 
nuqtani ko'rsatish lozim. Indamaslik bo‘yicha obyektni tanlashda 
(to‘geri chiziq tanlanishi lozim) sichqon ko‘rsatkichi qaysi nuqtada 
boMsa, o‘sha nuqta uzilishining birinchi nuqtasi boMadi. Agar 
birinchi nuqta vazifasini boshqa nuqta o‘tashi lozim boMsa, bu 
holda birinchi so‘rovga javoban First point (Первая 
точка/Birinchi nuqta) opsiyasini tanlashi kerak, bundan keyin 
ikkinchi nuqtani tanlash Iozimligi haqida so‘rov paydo boMadi:

S p e c i f y  s e c o n d  b r e a k  poin t :  ( О п р е д е л и т е
в т о р у ю  т о ч к у / I k k i n c h i  n uq t a n i  an i q l ang ) .

Natijada obyektning birinchi va ikkinchi nuqtalari orasidagi 
qismi o4chiriladi. Doirada esa birinchi nuqtadan ikkinchi 
nuqtagacha boMgan yoy soat strelkasiga teskari yo‘naIishda
o‘chiriIadi.

Join komandasi
Join (Соединить/Biriashtirish) komandasi o‘zining ta’siri 

bo‘yicha Break (Разрыв/Uzish) komandasining aksi boMib, u 
to‘g‘ri chiziq va yoydagi uzilishni bartaraf qilish hamda bir-biriga 
tutashgan splaynlarni biriktirish imkonini beradi. Komanda ishga 
tushirilgandan va obyekt tanlangandan so‘ng quyidagi so‘rov 
paydo boMadi:

S e l e c t  o b j e c t s  to j o i n  to source :  ( Выбери те
о б ъ е к т  дл я  с о е д и н е н и я  к и с х о д н о м у : /
B o s h I a n g ‘ i c h g a  b i r i k t i r i s h  uchun  obyek t n i
t a n l a n g : ) .

Bunga javoban biriktiriladigan obyektni ko‘rsating.

Explode komandasi

Explode (Расчленить/BoMaklarga boMish) komandasi 
obyektlami tarkibiy qismlarga ajratish imkonini beradi. Masalan, 
uchburchak boMaklarga boMingandan so‘ng uchta alohida 
kesmalardan tarkib topadi. Komanda ishga tushirilgandan so'ng 
boMaklarga boMish uchun obyektni tanlash haqida so‘rov paydo 
bo£ladi.



Cham fer (Фаска/Ках) komandasi ikki kesishuvchi to‘g‘ri 
chiziqlar hosil qilgan burchaklarda faskalami hosil qiladi. 
Indamaslik bo‘yicha komanda burchakni kesib tashlanadi va 
kesilish chizig‘i bo'ylab yangi kesma (faska)ni quradi. Bunda 
faskaning chetlari yoki faska katetlarining uzunligi yoki bir katet 
uzunligi va birinchi tanlangan to4g‘ri chiziqqa nisbatan faskaning 
og‘ish burchagi bilan aniqlanadi.

Komanda ishga tushgandan keyin faska katetlarining 
o‘lchamIari (ular oldindan o‘matilgan edi) haqida ma’lumotni 
chiqaradi va quyidagi so*rovni shakllantiradi:

S e l e c t  f i r s t  l i ne  o r  [ U n d o / P o l y l i n e / D i s t a n c e /  
A n g l e / T r i m /  M e t h o d / M u l t i p l e ]  ( В ы б е р и т е  п е р в у ю  
п р я му ю или  [ О т м е н а / П о л и л и н и я / К а т е т / У г о л /  
О б р е ж ь / М е т о д / М н о г о к р а т н о ] : / В т п с 1 п  t o ‘g ‘ri 
c h i z i q n i  y o k i  [Bekor  q i l i s h /
P o l i c h i z i q / K a t e t / B u r c h a k / K e s i b  t a s h l a / M e t o d / K o ‘p 
mar t a ]  t a n l a n g ) .

Agar faska katetlarining oldindan o'matilgan qiymatlari uni 
shakllantirishga to‘g‘ri kelsa, to‘g*ri chiziqlardan birinx tanlab olish 
kerak, socngra navbatdagi S e l e c t  s e c o n d  l ine:  ( В ы б е р и т е  
в т о р ую  л и н и ю / I k k i n c h i  ch i z i q n i  т а н л а н г )  so‘rovga 
javoban ikkinchi chiziqni ko'rsatish lozim boMadi.

Natijada faska shakllanadi, u tanlangan birinchi va ikkinchi 
to‘g‘ri chiziqlami kesiladi. Faskani yaratish, odatda, ikki bosqichda 
sodir bo‘Iadi. Komanda birinchi marta ishga tushirilganda 
faskaning talab etilgan parametrlari o‘matiladi. Birinchi so‘rovga 
javoban quyidagi ikki opsiyaning biri: Distance (Katet) opsiyasi -  
ikki katet bo‘yicha faskani shakllantirish uchun yoki Angle 
(Угол/Burchak) opsiyasi katet va burchak bo‘yicha faskani 
shakllantirish uchun tanlanadi.

Agar faskani shakllantirish uchun Angle (Угол/Burchak) 
opsiyasi tanlangan boMsa, komanda ketma-ket quyidagi so‘rovIami 
chiqaradi:

S p e c i f y  c h a m f e r  l e ng th  on the  f i r s t  l i ne  <_>:



( О п р е д е л и т е  д л и н у  к а т е т а  фа с к и для первой 
л и н и и  < _ > : / В I r inch i  ch i z i q  uchun  f aska  ka t e t i n i ng  
u z u n l i g i n i  a n i q l a n g  <_> : ) ;

S p e c i fy  c h a m f e r  an g l e  on the  f i r s t  l ine <_>:  
( О п р е д е л и т е  угол  ф а с к и  о т н о с и т е л ьн о  первой  
л и н и и  < _ > : / F a s k a  b u r c h a g i n i  b i r i nch i  ch i z i qqa  
n i s b a t a n  a n i q l a n g  <_>: ) .

Faskaning talab etiigan parametrlari o‘matilgandan keyin tizim 
komandani kiritishga taklifhi chiqaradi. Qaytadan ishga 
tushirilganda komanda o'matilgan parametrlar haqida ma’lumotni 
shakllantiradi. Faska yaratilgandan so‘ng boshlang‘ich kesmalami 
saqlash talab qilinsa, dastlab Trim (Обрезать/Kesib tashlamoq) 
opsiyasi tanlanadi, unda No Trim (He обрезать/Kesib 
tashlanmasin) qiymati o'matiladi va faqat shundan keyingina 
faskani qurishga o‘tiIadi.

Fillet komandasi
г1 Fillet (Скругление/Yumaloqlash) komandasi ikki kesma, 

yoy, aylana yoki poliliniya chiziqli segmentlarini bir-biriga 
tutashtiradi. Tutashtirish jarayoni faskani yaratish jarayoniga 
o‘xshaydi. Komanda ishga birinchi marta tushirilganda 
tutashmaning kerakli radiusi o‘matiladi, ikkinchi marta ishga 
tushirilganda esa tutashuvchi ikki obyekt tanlanadi.

Radiusni o‘matish uchun komandaning birinchi so‘rovi 
S e l e c t  f i r s t  o b j e c t  o r  [ U n d o / P o l y l i n e / R a d i u s /  
T r i m / M u l t i p l e ]  ( В ы б е р и т е  п е р в ы й  о б ъ е к т  или  
[ О т м е н  а / П о л и л и н и я / Р а д и у с / О б р е ж ь /  М н о г о -  
K p a T H o ] / B i r i n c h i  o b y e k t n i  t a n l a n g  y o k i  ( B e k o r  
q i l i s h / P o I i c h i z i q / R a d i u s / I C e s i b  t a s h l a / K o ‘p
m a r t a ] ) g a  javoban Radius (Radius) opsiyasi tanlanadi, so‘ngra 
talab qilingan son kiritiladi.

4.1-masltq. Chizmani tah rir qilish
1. 4.2-rasmga muvofiq «Чертеж 2» fragmentlari 

o‘zgartirilsin, bunda tahrirlash uchun moMjallangan



instrumentlardan foydaianilsin.
2. «Чертеж 2» fayli ochilsin va u «Чертеж 3» nomi ostida 

saqlansin.

4.2-rasm. Yangi konstruktiv elementlar bilan to 'ldirilgan chizma

3. 4.3-rasmga muvofiq M irror (Отражение/Aks) komandasi 
yordamida peфendikulyaming ko‘zgu aksi qurilsin. Buning uchun:

-  M irror (Отражение/Aks) komandasi chaqiriladi;
-  komandaning S e l e c t  o b j e c t s  ( В ы б е р и т е  

о б ъ е к т  ы / O b y e k t I a r n i  t a n l a n g )  so‘roviga 
javoban to‘g‘ri chiziq 1 ko'rsatiladi;

-  komandaning S p e c i f y  f i r s t  p o i n t  o f  m i r r o r  
l i n e  ( О п р е д е л и т е  п е р в у ю  т о ч к у  л и н и и  
о т р а ж е н и я / A k s  e t t i r i l i s h  c h i z i g ‘ i n i n g  
b i r i n c h i  n u q t a s i n i  a n i q l a n g )  so‘roviga javoban 
parallelogrammdagi 2-nuqta ko‘rsatiladi;



-  komandaning S p e c i f y  s e c o n d  p o i n t  o f  m i r r o r  
l i n e  ( О п р е д е л и т е  в т о р у ю  т о ч к у  л и н и и  
о т р а ж е н и я / A k s  e t t i r i l i s h  c h i z i g ' i n i n g  
i k k i n c h i  n u q t a s i n i  a n i q l a n g )  so‘roviga javoban 
parallelogrammdagi 3-nuqta ko‘rsatiIadi;

-  D e l e t e  s o u r c e  o b j e c t s  [ Y e s / N o ]  <N>
( У д а л е н и е  и с х о д н ы х  о б ъ е к т о в  [ Д а / Н е т ]  
< H > : / B e r i l g a n  o b y e k t l a m i  y o ‘ q o t i s h
[ H a / Y o ‘ q]  < Y > )  so*roviga javoban Enter klavishasi 
bosiladi.

4. Gaykaning tasvirlari chizmaning o‘ng chekkasiga yaqinroq 
siljitilsin:

-  Move (Перемещение/Siljitish) komandasi chaqiriladi;
-  Komandaning S p e c i f y  b a s e  p o i n t  or  

d i s p l a c e m e n t  ( О п р е д е л и т е  б а з о в у ю  т о ч к у  
и л и  п е р е м е щ е н и е : / В а г а у ! у  n u q t a n i  y o k i  
s i l j i t i l i s h n i  a n i q l a n g )  so‘roviga javoban 1-nuqta 
(aylana markazi) ko‘rsatiladi;

-  S p e c i f y  s e c o n d  p o i n t  o r  d i s p l a c e m e n t ,  or  <use  
f i r s t  p o i n t  as d i s p l a c e m e n t >  ( О п р е д ел ит е  
в т о р у ю т о ч к у  или  п е р е м ещ е н и е  или 
< и с п о л ь з у й т е  п е рв у ю т о ч к у  для 
п е р е м е щ е н и я > / 1 к к т с 1 п  n uq t a  yoki  
s i l j i t i l i s h n i  a n i q l a n g  yok i  < s i l j i t i s h  uchun  
b i r i n c h i  n u q t a d a n  f o y d a l a n i n g >)  so*roviga 
javoban ekranda 2-nuqta ko‘rsatiladi (4.4-rasm).



4.4-rasm Gayka tasvirini siljitish

5. Offset (Отступ/Chekinish) komandasidan foydalanib, 1- 
yoydan 5 mm masofada, shu yoyga o4xshash 2-yoy yaratilsin:

-  Offset (Отступ/Chekinish) komandasi chaqiriladi;
-  komandaning S p e c i fy  o f f s e t  d i s t a n c e  or  

[ T h r ou gh ]  < T h r o u g h >  ( О п р е д е л и т е  в е л и ч и н у  
о т с т у п а  или  [ Т о ч к а  п р о х о ж д е н и я ]  < Т о ч к а  
п р о х о ж д е н и я > /  C h ek i n i s h  q i y m a t i n i  a n i q l a n g  
[О* t i sh  n uq t a s i ]  < 0 ‘t i sh  n u q t a s i > )  so‘roviga 
javoban 5 ni kiritiladi va Enter klavishasi bosiladi; Se l e c t  
o b j e c t  to o f f s e t  or  <e x i t >  ( В ы б е р и т е  о б ъ е к т  
для  о т с т у п а  или < в ы х о д > /  C h e k i n i s h  
o b y e k t i n i  t a n l a n g  . yok i  < c h i q i s h > )  so‘roviga 
javoban yoy 1 ko£rsatiladi;

-  S p e c i f y  p o i n t  on  s ide to o f f s e t  ( О п р е д е л и т е  
т о ч к у  со  с т ороны о т с т у п а / C h e k i n i s h  
t a r a f i d a n  n uq t a n i  a n i q l a n g )  so'roviga javoban yoy 1 
ning o‘ng taraflda ekranda sichqon shiqillatiladi.

Shunga o'xshash 3- va 4-chiziqlami quring, bu tashqi konturga 
o‘xshash bo‘ladi (4.2-rasm).

6. Joriy o ‘q nomli qatlam o‘matilsin va imda nuqta 5 da 
bo'lgan radiusi 20 mm li aylana (teshiklar markazlarining o‘q 
chizig‘i) chizilsin (4.2-rasm).

7. Joriy kontur qatlami o‘matiIsin va unda markazi nuqta 6 da



boMgan radiusi 3 mm li aylana chizilsin.
8. A rray (Massiv) komandasidan foydalanib, radiusi 3 mm li 

yana uchta aylana chizilsin (bunda burchakning musbat yo‘nalishi 
hisobga olinishi zarur):

-  A rray (Massiv) komandasi chaqiriladi;
-  S e l e c t  ob j e c t :  ( В ы б е р и т е  о б ъ е к т / Obye k t n i

t a n l a n g )  so‘roviga javoban aylana ko'rsatiladi va Enter 
klavishasi bosiladi (yoki A rray (Massiv) komandasining 
dialog darchasi orqali);

-  E n t e r  the  t ype  a r r a y  [ Re c t a n gu l a r / P o l a r ]  <R> 
( В в е д и т е  т и п  м а с с и в а  [ П р ям оу го л ь н ы й /  
К р у г о в о й ]  < n > : / M a s s i v  tu r i n i  k i r i t i ng  
[ T o ‘g ‘ ri t o 6r t b u r c h a k ! i / D o i r a v i y ]  <T>: )  
komandasining so‘roviga javoban R (Iotincha) harf kiritiladi 
va E nter klavishasi bosiladi;

-  S p e c i f y  c e n t e r  p o i n t  o f  a r r a y  ( О п р е д е л и т е  
ц е н т р а л ь н у ю  т о ч к у  M a c c H B a : / M a s s i v n i n g  
m a r k a z i y  n u q t a s i n i  a n i q l a n g )  so'rovigajavoban 
nuqta 5 ko‘rsatiladi (4.2-rasm);

-  E n t e r  t he  n u m b e r  o f  i t ems  in the  a r ray  
( В в е д и т е  ч и с л о  э л е м е н т о в  в ма с с иве : /  
Ma s s i v  e l e m e n t l a r i  son i n i  k i r i t i ng )  so‘roviga 
javoban 4 raqami kiritiladi va Enter klavishasi bosiladi;

-  S p e c i f y  t h e  a n g l e  to  f i l l  ( + = c c w ,  -  = c w )  
< 3 6 0 >  ( О п р е д е л и т е  у г о л  з а п о л н е н и я  (+  = 
c c w ,  -  = c w )  < 3 6 0 > : / T o ‘ l d i r i s h  b u r c h a g i n i  
a n i q l a n g  (+  = c c w ,  -  = cw)  < 3 6 0 > : )  so‘roviga 
javoban E nter klavishasi bosiladi;

-  Ro t a t e  a r r a y e d  o b j e c t s ?  [Yes / No]  <Y> 
( П о в о р а ч и в а т ь  о б ъ е к т ы  мас с ив а ?  [Да/Нет]  
< f l > : / Ma s s i v  o b ye k t l a r i  bu r a l s i nmi ?
[ H a / Y o ‘q] < H > : )  so‘roviga javoban Enter klavishasi 
bosiladi.



4.5-rasm. T rim  (Обрезать/Kesib tashlamoq) komandasidan foydalanilganda
chiziqni yo‘qotish

9. Detaining yuqoridagi proyeksiyasi 7 va 8 to‘g‘ri chiziqlar 
bilan to'ldirilsin (4.2-rasm). To‘g‘ri chiziq 7 ni qurishda 9-nuqtada 
obyektga bog‘lanish va kuzatish rejimidan foydalanilsin.

10. 2 va 3 to‘g‘ri chiziqlar orasidagi chiziq 1 Trim 
(Обрезать/Kesib tashlamoq) komandasidan foydalanib yo‘qotiIsin:

-  Trim (Обрезать/Kesib tashlamoq) komandasi chaqiriladi;
-  Se l e c t  o b j e c t s  ( В ы б е р и т е  о б ъ е к т ы /  

O b y e k t l a m i  t a n l a n g )  so‘roviga javoban to‘g‘ri chiziq 
2 ko'rsatiladi, qayta S e l e c t  o b j e c t :  ( В ы б е р и т е  
о б ъ е к т / O b y e k t n i  t a n l a n g )  so‘roviga javoban esa 
to‘g‘ri chiziq 3 ko‘rsatiladi va E nter klavishasi bosiladi;

-  Se l e c t  o b j e c t  to  t r i m or  [ F e n c e / C r o s s i n g /  
P r o j e c t / E d g e / E r a s e / U n d o / ]  ( В ы б е р и т е  
об ъ е к т ,  к о т о р ы й  н у ж н о  о бр е з а т ь ,  или 
[ Л и н и я / С е к у  щ а я / П р о е к ц и я / К р о м к а / У д а л и т ь /  
OTMeHa] : /Kes i I i shi  loz im b o ' l g a n  o b y ek t n i  
t a n l a n g  yok i  [ C h i z i q / K e s u v c h i / P r o y e k s i y a /  
Q i r r a / Y o ‘q q i l i n s i n /  B e k o r  q i l i s h ] : )  so'roviga 
javoban to‘g‘ri chiziq 1 ko‘rsati!adi va Enter klavishasi 
bosiladi.

11. 4 va 5 to‘g‘ri chiziqlar Extend (Продолжить/Davom 
ettirmoq) komandasidan foydalanib to‘g‘ri chiziq 6 gacha davom 
ettirilsin:

-  Extend (Продолжить/Davom ettirmoq) komandasi 
chaqiriladi;

-  Se l ec t  ob j e c t s  ( В ы б е р и т е  о б ъе к т ы /



O b y e k t l a m i  t a n l a n g )  so'roviga javoban to‘g‘ri chiziq 
6 ko‘rsatiladi va E nter bosiladi;

-  S e l e c t  o b j e c t  to  E x t e n d  or  [ F e n c e / C r o s s i n g /  
P r o j e c t / E d g e / U n d o / ]  ( Вы б ер и те  объе кт ,  
к о т о р ы й  н у ж н о  п р о д о л ж и т ь ,  или 
[ Л и н и я / С е к у щ а я / П р о  е к ц и я / К р ом к а / О т м е н а ] :  
/ D a v o m  e t t i r i l i s h i  l oz i m b o ‘ lgan obyek t n i  
t a n l a n g  yok i  [ C h i z i q / K e s u v c h i /  P r o y e k s iy a /  
Q i r r a / B e k o r  q i l i s h ] : )  so‘roviga javoban to‘g‘ri chiziq 
4 ko‘rsatiladi va qayta chiqqan Se l e c t  ob j e c t  to 
E x t e n d  or  [ F e n c e / C r o s s i n g  / P r o j e c t / Ed g e /  
U n d o ] :  ( В ы б е р и т е  об ъ е к т ,  к о т о р ый  нужно  
п р о д о л ж и т ь ,  и л и  [ Л и н и я / С е к у ща я /
П р о е к ц и я / К р о м к а /  Отме на ]  : / Davom
e t t i r i l i s h i  l oz i m boMgan  obye k t n i  t a n l ang  
yok i
[ C h i z i q / K e s u v c h i / P r o y e k s i y a / Q i r r a / B e k o r  
q i l i s h ] : )  so‘rovigajavoban to‘g*ri chiziq 5 ko‘rsatiIadi va 
E nter klavishasi bosiladi.

12. Detaining chapdagi pastki qirrasi, Fillet 
(Округление/Dumaloqlash) komandasidan foydalanib, radiusi 5 
mm Ii aylana yoyi bilan dumaloqlansin (4.6,a-rasm), buning uchun:

-  Fillet (Округление/Dumaloqlash) komandasi chaqiriladi;
-  komandaning S e l e c t  f i r s t  o b j e c t  or  

[ U n d o / P o l y l i n e / R a d i u s / T r i m / M u l t i p l e j  
( В ы б е р и т е  п е р в ы й  о б ъ е к т  или  
[ О т м е н а / П о л  ил и н и я / Р а  д и у  с / О б р е ж ь / М  но-  
r o K p a T H o ] / B i r i n c h i  o b y e k t n i  t a n l a n g  y o k i  
[ B e k o r  q i l / P o l i c h i z i q / R a d i u s / K e s i b  
t a s h l a / K o ‘p m a r t a ] )  so‘roviga javoban R harfmi 
kiritish bilan Radius (Radius) opsiyasi tanlanadi;

-  komandaning S pe c i fy  f i l l e t  R a d i us  <0> 
( О п р е д е л и т е  • р а д иу с  с к р у г л е н ия  <0>/  
D u m a l o q l a s h  r ad i u s i n i  a n i q l a n g  <0>)  so‘roviga 
javoban 5 raqami kiritiladi;

-  komandaning Se l e c t  t i r s t  ob j e c t  or  [ Undo/



P o l y l i n e / R a d i u s / T r i m / M u l t i p l e ]  ( В ы б е р и т е
п е р в ы й  о б ъ е к т  или  [ О т м е н а /  П о л и л и н и я /  
Р а д и у с / О б р е ж ь / М н о г о к р а т н о ] /  B i r i n c h i
o b y ek t n i  t a n l a n g  yoki  [ B e k o r  q i l m o q /  
P o l i c h i z i q / R a d i u s / K e s i b  t a s h l a  / K o ‘p ma r t a ] )  
so'roviga javoban to‘g‘ri chiziq 1 ko‘rsatiladi;

-  S e l e c t  s e c o n d  o b j e c t  ( В ы б е р и т е  в т о р о й  
о б ъ е к т /  I k k i n c h i  o b y e k t n i  t a n l a n g )  so‘roviga 
javoban to‘g‘ri chiziq 2 ko'rsatiladi va Enter klavishasi 
bosiladi.
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4.6-rasm. Dumaloqlash va faskani qurish

13. Chamfer (Faska) komandasidan foydalanib to‘g‘ri chiziq 1 
bo‘ylab, unga 30° ostida kateti 2 bo‘lgan faska qurilsin (4.6,b- 
rasm):

-  Chamfer (Faska) komandasi chaqiriladi;
-  komandaning S e l e c t  f i r s t  l i n e  o r  [ U n d o /

P o l y l i n e / D i  s t a n  с е / A n g l e / T r i m /  M e t h o d /  
M u l t i p l e ]  ( В ы б е р и т е  п е р в у ю  п р я м у ю  и л и  
[ О т м е н а / П о л и л и н и я / К а т е т /  У г о л / О б р е ж ь /  
М е т о д / М н о г о к р а т н о ] : / B i r i n c h i  t o ‘g ‘ r i  
c h i z i q n i  t a n l a n g  y o k i  [ B e k o r  q i l i s h /
P o l i c h i z i q / K a t e t / B u r c h a k / K e s i b  t a s h l a  
/ M e t o d / K o ‘ p m a r t a ] : )  so‘roviga javoban A harfi 
bilan Angle (Угол/Burchak) opsiyasi tanlanadi;

-  komandaning S p e c i f y  c h a m f e r  l e n g t h  on  the  
f i r s t  l i n e  < 0 >  ( О п р е д е л и т е  д л и н у  п е р в о г о  
к а т е т а  ф а с к и  < 0 > : / F a s k a  b i r i n c h i



k a t e t i n i n g  u z u n l i g i n i  a n i q l a n g  < 0 > )  so*roviga 
javoban 2 raqami tanlanadi va Enter klavishasi bosiladi;

-  komandaning S p e c i f y  c h a m f e r  a n g l e  on the  
f i r s t  l i n e  < > ( О п р е д е л и т е  у г о л  ф а с к и  
о т н о с и т е л ь н о  п е р в о й  л и н и и  < > : /  
B i r i n c h i  c h i z i q q a  n i s b a t a n  f a s k a  
b u r c h a g i n i  a n i q l a n g  < > : )  so‘roviga javoban 30 
raqami kiritiladi va Enter klavishasi bosiladi;

-  komandaning S e l e c t  f i r s t  l i n e  o r  [ P o l y l i n e /  
D i s t a n c e / A n g l e / T r i m / M e t h o d ]  ( В ы б е р и т е  
п е р в у ю  п р я м у ю  и л и  [ П о л и л и н и я / К а т е т /  
У го л / О  б р е ж ь / М е т о д ] : /  B i r i n c h i  t o ‘ g ‘ ri  
c h i z i q n i  t a n l a n g  y o k i  [ P o l i c h i z i q / K a t e t /  
B u r c h a k / K e s i b  t a s h l a /  M e t o d ] : )  so‘roviga 
javoban to‘g‘ri chiziq 1 ko‘rsatiIadi;

-  komandaning S e l e c t  s e c o n d  l i n e  ( В ы б е р и т е  
в т о р у ю  п р я м у ю / l k k i n c h i  t o ‘g ‘ ri  c h i z i q n i  
t a n l a n g )  so‘rovigajavobanto‘g‘richiziq2 ko‘rsati!adiva 
Enter bosiladi;

-  shunga o‘xshash boshqa qovurg‘a va oltiburchakning yuqori 
sirti uchun faska quriladi.

14. Arc (Дуга/Уоу) komandasidan foydalanib gayka 
proyeksiyasini faska chiziqlari -  aylana yoylari bilan toMdirilsin 
(4.7,a-rasm):

-  Arc (Дуга/Уоу) komandasi chaqiriladi, ochilgan menyu 
Draw (4ep4eHHe/Chizmachilik)dan Arc => Start => End 
=> Direction (Дуга => Начало => Конец => 
Направление/Y oy => Boshlanish => Oxiri => Yo‘naIish);

-  komandaning S p e c i f y  s t a r t  p o i n t  o f  a r c  or  
[ C e n t e r ]  ( О п р е д е л и т е  н а ч а л ь н у ю  т о ч к у  
д у г и  и л и  [ L ( eH T p ] / Yo yn i n g  b o s h l a n g ' i c h  
n u q t a s i n i  a n i q l a n g  y o k i  [ M a r k a z ] )  so‘roviga 
javoban nuqta 1 ko‘rsatiladi;

-  komandaning S p e c i f y  e nd  p o i n t  o f  arc  
( О п р е д е л и т е  к о н е ч н у ю  т о ч к у  д у г и /  
Y o y n i n g  o x i r g i  n u q t a s i n i  a n i q l a n g )  so‘roviga



javoban nuqta 2 (1-nuqtaga bog'langan) ko‘rsatiladi;
-  komandaning oxirgi S p e c i f y  t a n g e n t  d i r e c t i o n  

f o r  t h e  s t a r t  p o i n t  o f  a r c  ( О п р е д е л и т е  
н а п р а в л е н и е  к а с а т е л ь н о й  д л я  н а ч а л ь н о й  
т о ч к и  д у г и / Y o y n i n g  b o s h l a n g 4i c h  n u q t a s i  
u c h u n  u r i n m a  y o ‘n a l i s h i n i  a n i q l a n g )  
so‘roviga javoban sichqon birinchi nuqtaga urinma 
yo‘na!ishda tortiladi va sichqon ekranda shiqillatiladi (4.7,a- 
rasm).

Oltiburchakning pastki va yuqori qismidagi qolgan yoylar 
shunga o‘xshash quriladi.

15. Break (Разрыв/Uzish) komandasidan foydalanib gayka 
qovurg'alarining pastki qismi yo‘qotiIsin:

-  Break (Разрыв/Uzish) komandasi chaqiriladi;
-  komandaning S e l e c t  o b j e c t  ( О п р е д е л и т е  

о б ъ е к т /  O b y e k t n i  t a n l a n g )  so'roviga javoban 
to‘g‘ri chiziq 3 ko‘rsati!adi (4.7,a-rasm);

-  komandaning S p c c i f y  s e c o n d  b r e a k  p o i n t  or  
[ F i r s t  p o i n t ]  ( О п р е д е л и т е  в т о р у ю  т о ч к у  
и л и  [ П е р в а я  T 0 4 i c a ] : / I k k i n c h i  n u q t a n i  
a n i q l a n g  y o k i  [ B i r i n c h i  n u q t a ] : )  so'roviga 
javoban F harfi bilan F i r s t  p o i n t  ( П е р в а я  
т о ч к а / B i r i n c h i  n u q t a )  tanlanadi;

4.7-rasm. Yoyni qurish va aylananing bir qismini yo'qotish

-  komandaning S p e c i f y  f i r s t  b r e a k  p o i n t  
( О п р е д е л и т е  п е р в у ю  т о ч к у  р а з р ы в а /  
U z i l i s h n i n g  b i r i n c h i  n u q t a s i n i  a n i q l a n g )

3



so‘roviga javoban nuqta 2 ko‘rsatiladi;
-  S p e c i f y  s e c o n d  b r e a k  p o i n t  ( О п р е д е л и т е  

в т о р у ю  т о ч к у  р а з р ы в а / U z i l i s h n i n g  
i k k i n c h i  n u q t a s i n i  a n i q l a n g )  so‘roviga javoban 
ekranda to‘g‘ri chiziq 3 dan tashqaridagi nuqta, masalan 
nuqta 4 ko‘rsatiladi.

16. Markazi 1 nuqtada bo'lgan radiusi 7 mm li aylana va 
markazi o4sha nuqtada bo‘lgan radiusi 9 mm И aylana qurilsin. 
Aylana 2 chizig‘ming qalinligi 0,15 mm ga o'zgartirilsin (4.7,b- 
rasm).

17. Break (Разрыв/Uzish) komandasidan foydalanib aylana 2 
ning bir qismi yo'qotilsin:

-  Break (Разрыв/Uzish) komandasi chaqiriladi;
-  holat qatorida OSNAJP (OPRTV) obyektga bog‘ianish rejimi 

o ‘chiriIadi (uziladi);
-  komandaning S e l e c t  o b j e c t  ( О п р е д е л и т е  

о б ъ е к т /  O b y e k t n i  a n i q l a n g )  so‘roviga nuqta 3 
ko‘rsatiladi (4.7,b-rasm);

-  komandaning S p e c i f y  s e c o n d  b r e a k  p o i n t  or  
[ F i r s t  p o i n t ]  ( О п р е д е л и т е  в т о р у ю  т о ч к у  
р а з р ы в а  и л и  [ П е р в а я  T 0 4 K a ] : / U z i I i s h n i n g  
i k k i n c h i  n u q t a s i n i  a n i q l a n g  y o k i  [ B i r i n c h i  
n u q t a ] : )  so‘roviga nuqta 4 ko‘rsatiladi.

18. Chizma saqlansin.

4.5. T ahrir qilish ruchkasidan foydalanish
Obyektlami faqat tahrir qilish komandalari yordamidagina 

tahrir qilish mumkin. AutoCAD tizimida primitivlami ruchkalar 
yordamida tahrir qilish usuli mavjud. Ruchkalar -  kichik 
kvadratchalar bo‘Iib, ular obyektlaming muayyan aniqlovchi 
nuqtalarida paydo bo‘ladi.

Masalan, kesma tanlanganda uning chetki va o‘rta nuqtalari, 
aylana tanlanganda esa -  aylana markazi va aylana choraklarining 
nuqtalari paydo bo‘ladi. Agar ruchkaning o‘zida shiqillatilsa, u 
faollashadi (toMdirish rangi o'zgaradi) va undan obyektni 
o‘zgartirish uchun foydalanish mumkin. Faol ruclika qizil rang



bilan ajratib ko‘rsatiladi. Ajratishni bekor qilish uchun faol 
ruchkada у an a bir marta shiqillatish lozim.

4.2-masItq. T ahrir qilish ruchkalaridan foydalanish
1. «Чертеж 3» fayli ochilsin va u «Чертеж 4» nomi ostida 

saqlansin. Agar u oldin ochilgan bo'lsa, Siz esa hozir boshqa 
chizma bilan ishlayotgan boMsangiz, uni Window (Окно/Darcha) 
tizimiy menyu darchasining ro'yxatida topish mumkin. Aks holda 
Siz File => Open (Файл => Открыть/Fayl => Ochish) menyu 
orqali Read only (Только для чтения — то есть нельзя сохранить 
его под этим же именем/Faqat o'qish uchun ya’ni uni ushbu nom 
ostida saqlab boMmaydi) versiyasini ochasiz.

2. Aylana radiusi kichiklashtirilsin (4.8,a-rasm):
-  1-aylanada shiqillatiladi;
-  o‘ng ruchkada shiqillatiladi va u sichqon yordamida 

tortiladi -  aylana 2-holatga siljitiladi.

4.8-rasm. Ruchkalar yordamida aylana radiusini kichiklashtirish va chizmani 
yangi elementlar bilan to‘ldirish

3. To‘g‘ri chiziq 1 va 2 lar aylana o‘lcliamlariga mos ravishda 
siljitilsin (4.8,b-rasm):

-  chiziq 1 da shiqillatiladi;
-  ORTHO (ORTO) rejimi va holat qatorida OTRACK 

(ОТСЛЕЖ) rejimi ulanadi;
-  o‘rtadagi ruchkada shiqillatiladi va u sichqon bilan 

tortilib, to‘g‘ri chiziq kerakli holatga siljitiladi, bunda 
nuqta 3 kuzatib turiladi.



To‘g‘ri chiziq 2 shunga o‘xshash siljitiladi.
4. Ruchkalarning kontekstli menyusining Copy (Копировать/ 

Nusxa olinsin) opsiyasidan foydalanib, oldindan ko‘rinish kichik 
teshiklar va ularga mos o‘q chiziqlari bilan to'ldirilsin (4.2-rasmga 
qarang):

-  to‘g‘ri chiziq 10 da shiqillatiladi (ORTHO (ORTO) va 
OTRACK (ОТСЛЕЖ rejimi);

-  o'rtadagi ruchkada shiqillatiladi, so‘ngra sichqonning o*ng 
knopkasi ekranda shiqillatiladi va ruchkalarning kontekstli 
menyusidan Copy (Копировать/Nusxa olinsin) opsiyasi 
tanlanadi;

-  faol ruchka sichqon bilan tortiladi, bunda to‘g‘ri chiziq 
kerakli holatga siljitiladi va quyidagi proyeksiyadagi 
teshiklar kuzatib turiladi.

5. Bog‘lanishlardan foydalanib 20x20 mm o4lcham!i prizmatik 
teshiklaming proyeksiyalari chizilsin (4.2-rasm).

6. Fayl saqlansin.



5. CHIZMALARNI SHAKLLANTIRISE

5.1. Shtrixovkalarni bajarish
Mashinasozlik chizmalarida shtrixovka detallar kesimlarini 

bajarishda materiallami belgilash uchun qo‘Ilanadi. Shtrixovkani 
bajarishda kesmalar, aylanalar yoylari va h.k.lardan tarkib topgan 
cheklangan berk konturlar jabhalari to‘ldiriIadi.

Shtrixovkani yaratish uchun В raw  (Черчение/Chizmachilik) 
instrumentlar panelida H atch (Shtrixovka) piktogrammasini 
shiqiilatish yoki shu nomda chiqayotgan menyudan komandani 
chaqirish kerak. Komanda ishga tushgandan keyin ekranda kontur 
bo‘yicha shtrixovkalash dialogi darchasi Hatch and Gradiyent 
(Штриховка и градиент/Shtrixlash va gradiyent) paydo bo‘ladi -
5.1-rasm, unda quyidagi amallami bajarish mumkin:

* zarur boMgan shtrixovkani tanlash -  Pattern (Struktura) 
ro‘yxati darchasi;

« shtrixovka qilinishi talab etiigan chizma qismini aniqlash -  
Pick Points (Выбрать точки/Nuqtalami tanlash) va Select 
objects (Выбрать объекты/Obyektlami tanlash) knopkalari;

* shtrixovka parametrlarini berish -  ro'yxatlar darchasi Angle 
(Угол/В urchak) va Scale (Masshtab);

* shtrixovka chiqishidan oldin shtrixovkani ko'rib chiqish — 
Preview (Предварительный просмотр/Oldindan ko'rib 
chiqish) knopkasi.

Gradiyentli to‘ldirish (заливка) Gradient (Gradiyent) 
qistirmasi orqali shunga o‘xshash amalga oshiriladi -  ranglar 
miqdori va zalivka turi tanlanadi.

Shtrixlash (yoki gradiyentni to4dirish) uchun jabhani ikki 
usulda aniqlash mumkin: yoki (sichqon bilan shiqiilatib) jabha 
ichidagi nuqta ko‘rsatiladi yoki jabhani cheklaydigan obyektlar 
tanlanadi. Birinchi holda Pick Points (Выбрать точки/ Nuqtalami 
tanlash) knopkasini, ikkinchi holda Select objects (Выбрать 
объекты/Obyektlami tanlash) knopkasini bosish kerak. 
Shtrixovkalar palitrasida ro‘yxat darchasi yonida shtrixlash stili 
0‘matilishi mumkin.
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5.1-rasm. H atch  and  G rad ien t (Shtrixlash va gradiyent) dialogli darcha

Shtrixovka istalgan boshqa primitiv kabi o*chiriladi.
Shtrixovkani tahrir qilish uchun oqib chiqqan menyudan Hatch 
Edit (Редактирование штриховки/Shtrixovkani tahrir qilish) 
opsiyasi tanlanadi. Tanlovdan so‘ng ekranda Hatch Edit dialog 
darchasi paydo bo‘ladi, talab qilinayotgan yangi parametrlar 
o‘matiIadi.



5.1-mashq. Shtrixovkani bajarish
1. «Чертеж 4» fayli ochilsin va u «Чертеж 5» nomi ostida 

saqlansin.
2. Oldidan ko‘rinishda kesim shakli shtrixovka qilinsin, u 

yerda 5.2-rasmga muvofiq simmetriya tekisligida kesimni qurish 
zarur:

-  Shtrixovka qatlamiga o'tiladi;
-  Hatch (Shtrixovka) piktogrammasida shiqillatib shtrixovka 

komandasi chaqiriladi;
-  Hatch and Gradient (Штриховка и градиент/ShtrixIash va 

gradiyent) dialog darchasida Pick Points (Выбрать 
точки/Nuqtalami tanlash) knopkasida shiqillatiladi;

-  I, 2, 3, 4, 5 jabhalari ichida sichqon bilan to‘rt marta 
shiqillatiladi va E nter kiavishasi bosiladi, bunda jabhalar 
chegaralari ajratib ko‘rsati!adi. Agar hamma chegaralar 
ajratilmagan boMsa, u holda ekrandagi tasvir masshtabi 
kattalashtirilib, ulaming berk ekanligini tekshirib chiqish 
zarur;

-  dialog darchasida 5.1-rasmga muvofiq parametrlar 
o‘matiladi;

-  agar shtrixovkada o‘zgartirishlar talab qilinmasa, Enter 
kiavishasi bosilib, yana shtrixovkalashning dialog darchasi 
chaqiriladi;

-  OK knopkasida sichqonni shiqillatib, dialog darchasidan 
chiqiladi.

3. Shtrixovka qadami va og'ishi o‘zgartirilsin:
-  kontekst menyu orqali Hatch Edit (Редактирование 

штриховки/Shtrixovkani tahrir qilish) chaqiriladi;
-  sichqon bilan shtrixovkada shiqillatiladi;
-  Hatch Edit dialog darchasida 90° burchak va 1.25 masshtab 

o‘matiladi;
-  OK knopkasida sichqon shiqillatilib dialog darchasidan 

chiqiladi. Oszgartishlar kiritilgandan keyin shtrixovka 5.2- 
rasmdagi chizmaga mos bo‘ladi.



5.2. OMchamlami berish (chizish)
OMchamlami berish -  chizmani yaratish jarayonidagi eng 

mashaqqatli bosqichlardan biridir. AutoCAD tizimi quyidagi 
operatsiyalami avtomatlashtirish imkonini beradi [4]:

-  o‘Ichamlami berish, ya’ni oMcham turiga qarab hamma 
elementlami (chiquvchi va oMcham chiziqlarini, strelkalami, 
oMchamli matnlarni, tokchalami) avtomatik ravishda qurish;

-  bogMangan oMchamlar ketma-ketligini: oMchamlar 
zanjirchalari va bazaviy chiziqdan oMchamlami qo‘yib 
chiqish.

Shtrixovka qaysi xossalarga ega boMsa, oMcham ham o‘sha 
xossalarga ega boMadi, ya’ni oMcham -  blok va assotsiativlidir, 
detal shakli o‘zgarganda u ham o‘zgaradi. Oichamlami qo'yib 
chiqish komandalari oqib chiquvchi Dimension 
(Размеры/OMchamlar) menyusi yoki Dimension instrumentlar 
panelidagi mos piktogrammalar yordamida chaqiriladi (5.3-rasm).

5.3-rasm. Dim ension (Размеры/OMchamlar) instrumentlar paneli

Alohida oMchamlarni qo‘yib chiqish 
Linear Dimension komandasi
M* 1 Linear Dimension (Линейный/Chiziqli) komandasi 

gorizontal, vertikal yoki buralgan oMchamlami yaratish imkonini 
beradi. OMchamni ikki usulda berish mumkin:



* chiquvchi chiziqlar boshlanadigan nuqtalar ketma-ket 
ko'rsatiladi, so‘ngra o‘lcham chizigM joylashadigan nuqta 
ko‘rsati!adi;

* obyekt tanlanadi (bu hoida chiquvchi chiziqlaming 
boshlangMch nuqtalari avtomatik tarzda aniqlanadi), so‘ngra 
oMcham chizigM joylashadigan nuqta ko'rsatiladi.

Komanda ishga tushgandan keyin S p e c i f y  f i r s t  
e x t e n s i o n  l i n e  o r i g i n  o r  < s e l e c t  o b j e c t >  
( О п р е д е л и т е  н а ч а л о  п е р в о й  в ы н о с н о й  л и н и и  
р а з м е р а  и л и  < В ы б е р и т е  о б ъ е к т > : / О Ч с Ь а т  
b i r i n c h i  c h i q u v c h i  c h i z i g M  b o s h l a n i s h i n i
a n i q l a n g  y o k i  < o b y e k t n i  t a n l a n g > : )  so‘roviga 
javoban birinchi chiquvchi chiziq boshlanishi ko‘rsati!adi, so‘ngra 
ikkinchi chiquvchi chiziq boshlanishi haqidagi so‘rov chiqadi: 
S p e c i f y  s e c o n d  e x t e n s i o n  l i n e  o r i g i n :
( О п р е д е л и т е  н а ч а л о  в т о р о й  в ы н о с н о й  л и н и и  
р а з м е р а /  O M c h a m  i k k i n c h i  c h i q u v c h i  c h i z i g M  
b o s h l a n i s h i n i  a n i q l a n g ) .

Ikkinchi chiquvchi chiziqning boshlang‘ich nuqtasi
kiritiigandan keyin quyidagi taklif paydo bo‘ladi: S p e c i f y
d i m e n s i o n  l i n e  l o c a t i o n  o r  [ M T e x t / T e x t / A n g l e /  
H o r i z o n t a l / У e r t i c a l / R o t a t e d ] : ( O п p e д e л и т e  
п о л о ж е н и е  л и н и и  р а з м е р а  и л и  [ М Т е к с т /  
Т е к с т / У г о л / Г  о р и з о н т а л ь н ы й / В е р т и к а л ь н ы й /  
П о в е р н у т ы й ]  : / 0 ‘ l c h a m  c h i z i g M  h o l a t i n i  
a n i q l a n g  y o k i  [ M T e k s t / M a t n / B u r c h a k /
G o r i z o n t a l / V e r t i k a l / B u r i l g a n ] : ) .

Bunga javoban ekranda oMcham chizig‘i o‘tadigan nuqta 
ko‘rsatiladi yoki o‘zgartishlami kiritish lozim bo‘lsa, quyida qayd 
etilgan opsiyalardan biri tanlanadi:

* oMcham matniga -  MText (MTekst), Text (Matn), Angle 
(Угол/Burchak) opsiyalari;

* 0 ‘lcham chizigM joylashishiga -  Horizontal 
(Горизонтальный/Gorizontal), Vertical (Вертикальный/ 
Vertikal), Rotated (Повернутый/ Buralgan) opsiyalari.

Simvollar oMchamlarini matnga kiritish uchun klaviaturadan



oMchamdan oldin va keyin quyidagi kodlami terish kerak:
♦ %%c -  diametr belgisini kiritish uchun;
♦ %%d — gradus belgisini kiritish uchun;
♦ %%p -  qo‘yim (допуск) ishorasini (plyus/minus) kiritish 

uchun (simvollar lotincha va probellarsiz).
OMchamni ikkinchi usulda, ya’ni obyektni tanlash bo'yicha, 

qo'yib chiqish uchun, komandaning birinchi S p e c i f y  f i r s t  
e x t e n s i o n  l i n e  o r i g i n  or  < s e l e c t  o b j e c t >  
( О п р е д е л и т е  н а ч а л о  п е р в о й  в ы н о с н о й  л и н и и  
р а з м е р а  и л и  < В ы б е р и т е  о б ъ е к т > /  0 ‘ l c h a m n i n g  
b i r i n c h i  c h i q u v c h i  c h i z i g ‘ i n i n g  b o s h l a n i s h i n i  
a n i q l a n g  y o k i  < O b y e k t n i  t a n l a n g > )  so‘roviga 
javoban Enter klavishasi bosiladi, so‘ngra obyekt ko‘rsatiladi. 
Bundan keyin oMcham chizig'ining joylashishi va komanda 
opsiyalarini tanlash haqida so'rov chiqadi.

Aligned Dimension komandasi

^  Aligned Dimension (Выровненный pa3Mep/Tekislangan 
oMcham) komandasi oMcham chizigM obyektga parallel boMgan 
chiziqli oMchamlami chizish imkonini beradi. Tekislangan oMcham 
gorizontal va vertikallarga o'xshash yaratiladi.

A rc Length komandasi

L Arc Length (Длина дуги/Уоу uzunligi) komandasi 
aylanalar yoylari uzunligi va yoyli segmentlar polichiziqlarini 
berishga imkon yaratadi. OMchamli songa yoy simvoli avtoinatik 
tarzda yoMdosh boMadi.

Ordinate komandasi

•ft- Ordinate (Ординатиый/Ordinatali) komandasi detal 
oMchamlarini abssissa va ordinata koordinat o‘qIari bo‘yicha bir xil 
qalinlikda berish imkonini yaratadi.

Radius Dimension komandasi

Radius Dimension (Радиальный размер/Radial oMcham)



komandasi aylana yoki yoy radiusi oMchamini qurish imkonini 
beradi. Komandaning S e l e c t  a r c  or  c i r c l e :  ( В ы б е р и т е  
д у г у  и л и  о к р у ж н о с т ь : / У о у  y o k i  a y l a n a n i  
t a n l a n g )  so‘roviga javoban aylana yoki yoyni ko'rsatish zarur. 
OMchamli songa radius simvoli avtomatik tarzda yoMdosh boMadi.

Jogged komandasi

^  Jogged (Радиус с изломом/SiniqIi radius) komandasi 
markazini haqiqiy joyida ko‘rsatib boMmaydigan, katta radiusli 
aylana yoki yoy radiusining oMchamini qurish imkonini beradi.

Diameter komandasi
f a Diameter (Диаметральный pa3Mep/Diametral oMcham) 

komandasi ay Jana yoki yoy diametri oMchamini qurish imkonini 
beradi. Radial oMchamga o'xshash yaratiladi. Diametr simvoli 
oMchamli songa avtomatik tarzda yoMdosh boMadi.

Angular Dimension komandasi
A
—* Angular Dimension (Угловой размер/Burchak oMchami) 

komandasi ikki parallel boMmagan chiziq orasidagi burchakni 
ko‘rsatuvchi oMchamm chizish imkonini beradi.

Quick Leader, Center M ark komandalari
*** ©  Quick Leader (Быстрая выноска/Tez chiqarish) 

chiqadigan chiziqni chizish, Center M ark  (Маркер 
центра/Магкаг markeri) komandasi aylana yoki yoy markazi 
belgisini yaratish imkonini beradi.

Tolerance komandasi
СЩ1

Tolerance C3onycK/Qo‘yim) komandasi chizmaiarga 
qo'yimlar, shakllaming ogMshi va sirtlaming joylashishi belgilarini 
chizish imkonini beradi.



OMchamlar guruhlarm i chizish 
Baseline Dimension komandasi
I, ,i
1 * Baseline Dimension (Размер с основной линией/Asosiy 

chiziqli oMcham) komandasi bazaviy chiziq (oldingi oMchamning 
birinchi chiquvchi chizigM)dan boshiab oMchamlaming ketma-kel 
guruhini chizish imkonini beradi.

Continue Dimension komandasi

Continue Dimension (Продолженный размер/Davom 
ettirilgan oMcham) komandasi oldingi oMchamning ikkinchi 
chiquvchi chizigMdan boshiab oMchamlami davom ettirish 
imkonini beradi. Bazaviy chiziqdan boshlangan oMchamlarga 
o'xshash tarzda yaratiiadi.

Quick Dimension komandasi

Quick Dimension (Быстрый размер/Tezkor oMcham) 
komandasi oMchamlar guruhini chizib chiqishni avtomatlashtirish 
imkonini beradi. Ushbu holda oMchamlar mos sirtlar 
ko‘rsatilganidan keyin zanjirsimon -  bir-biridan keyin qo‘yib 
chiqiladi.

OMchamlami tah rir qilish
Dimension Edit komandasi

%
^ * Dimension Edit (Правка размера/ОМсЬатш to'g'rilash 

(tuzatish)) komandasi matnni o4zgartirish (tahrir qilish) va 
chiquvchi chiqishlar ogMsh burchagini o‘zgartirish imkonini 
beradi.

Dimension Text Edit komandasi

Dimension Text Edit (Правка текста размера/ОМсЬаш 
matnini to‘g‘rilash (tuzatish)) komandasi matnning oMcham 
chizigMda joylashishini va matn oriyentatsiyasini o‘zgartirish 
imkonini beradi.



Dimension Update (Обновление размера/OMchamni 
yangilash) komandasi o‘lcham parametrlarini oMcham stilining 
joriy ko‘rsatma!ariga muvofiq qaytadan aniqlash imkonini beradi.

Dimension Style komandasi

Dimension Style (Размерные стили/ОМсЬат stillari) 
komandasi oMchamlami qo‘yib chiqish stiiini berish imkonini 
yaratadi. Bosilgandan keyin Dimension Style M anager 
(Менеджер стилей размеров/OMchamlar stillari menejeri) dialog 
darchasi paydo boMadi.

OMchamni, istalgan boshqa obyekt kabi, uni tanlashda paydo 
boMadigan ruchkalar yordamida tahrir qilish mumkin.

Chetki ruchkalardan chiquvchi chiziqlami surish (siljitish) 
uchun o'rtadagi ruchkadan oMcham chizigMni siljitish va matnni u 
bo'ylab siljitish uchun foydalaniladi.

5 3 . OMcham stiiini o‘zgartirish
Tizim yuklanganda ISO-25 stili o‘mati!adi, u oMcham 

parametrlari majmuasi (oMcham chiziqlari orasidagi masofa, matn 
joylashishi, matn va strelkalar oMchami, matn shrifti va h.k.) bilan 
aniqlanadi. Dimension Style (Стиль размера/ОМсЬат stili) 
instrument Dimension Style M anager (Менеджер стилей 
размеров/ОМсЬат stillari menejeri) dialog darchasini chaqirish 
(5.4-rasm) hamda standartga muvofiq oMchamlami qo'yib chiqish 
uchun mavjud stilga o‘zgartishlar kiritish imkonini beradi.

OMcham stiliga o‘zgartishlar kiritish uchun sichqon bilan 
Modify... (Изменить.../0 ‘zgartirilsin...) knopkasi shiqillatiladi, 
natijada Modify Dimension Style: ISO-25 (Заменить текущий 
стиль: ISO-25/Joriy stil almashtirilsin: ISO-25) dialog darchasi 
paydo boMadi.

Symbol and Arrows (Символы и стрелки/SimvoUar va 
strelkalar) sahifasida (5.5-rasm) chiquvchi va oMcham 
chiziqlarining parametrlari hamda strelkalar parametrlari 
o‘matiladi.



5.4-rasm. 0 ‘lchamlar stillari menejeri
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5.5-rasm. Sym bol a n d  A rrow s (Символы и стрелки/Simvollar va 
strelkalar) sahifasi



5.6-rasm. T ext (Текст/M atn) sahifasi

Text (Текст/Matn) sahifasida 5.6-rasm -  oMchamli matn (matn 
stili, matn balandligi, matnning o‘lcham chizig‘i ustida/ostida, 
ichida/tashqarisida joylashishi) parametrlari o‘matiladi.

Fit (Расгюложение/Joylashish) qistirmasining opsiyalari matn 
chiquvchi chiziqlar orasiga sig‘masdan qolganda matnni 
joylashtirish usulini hamda o‘lcham chiziqlarini joylashtirish 
usulini (chiquvchi chiziqlar orasida yoki ulardan tashqarida) 
boshqaradi.

Primary units (Основные единицы/Asosiy birliklar) -  5.7- 
rasm -  birliklar formatini o‘matish, hisoblab topilgan o'lchamni 
yiriklashtirish va oMchamlar masshtabini boshqaradi.
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5.7-rasm. P rim ary  U nits (Основные единицы/Asosiy birliklar) sahifasi

5.2-ntashq. 0 ‘lciiantlami qo‘yib chiqisb
5.8-rasmga muvofiq o'lchamlar qo‘yib chiqilsin.
1. «Чертеж 5» fayli ochilsin va «Чертеж 6» nomi ostida 

saqlansin.
2. Chizmadan detal tasviridan boshqa hamma tasvirlar 

yo'qotilsin (o‘chirilsin).
3. 0 ‘lchamlar parametrlari standartga muvofiq o‘matiisin:
— Dimension Style (Стиль pa3Mepa/0‘lcham stili) 

instrument yordamida Dimension Style Manager 
(Менеджер стилей размеров/Oichamlar stili menejeri) 
dialog darchasi chaqiriladi va Modify... 
(Изменить.../0 ‘zgartirilsin...) knopkasi bosiladi -  5.4-rasm;

-  qistirmalar yordamida sahifalar navbatma-navbat ochiladi 
va ularda opsiyalar 5.5...5.7-rasmIarga muvofiq (strelkalar 
balandligi, stil, matn balandligi va uning tekislanishi,



ISOCPEUR, Italic shrifti) o‘matiladi, so‘ngra OK 
knopkasida shiqillatiladi;

-  Dimension Style Manager (Менеджер стилей 
раз.меров/0‘1сЬаш1аг stili menejeri) dialog darchasi 
yopiladi.

4. Размеры (0 ‘lchamlar) qatlamiga o‘tilsin.

5.8-rasm. 0 ‘lchamlari chizilgan chizma

5. Olddan ko‘rinishda vertikal gabarit o*lcham chizilsin (5.8- 
rasm):

-  Linear Dimension (Линейный/Chiziqli) komandasi 
chaqiriladi;

-  komandaning S p e c i f y  f i r s t  e x t e n s i o n  l i ne  
o r i g i n  o r  < s e l e c t  o b j e c t >  ( О п р е д е л и т е  
н а ч а л о  п е р в о й  в ы н о с н о й  л и н и и  р а з м е р а  
и л и  < В ы б е р и т е  о б ъ е к т > /  0 ‘ l c h a m n i n g  
b i r i n c h i  c h i q u v c h i  c h i z i g ‘ i b o s h l a n i s h i n i



a n i q l a n g  y o k i  < o b y e k t n i  t a n l a n g > )  so‘roviga 
javoban nuqta 1 ko‘rsati!adi;

-  komandaning S p e c i f y  s e c o n d  e x t e n s i o n  l i ne  
o r i g i n :  ( О п р е д е л и т е  н а ч а л о  в т о р о й  
в ы н о с н о й  л и н и и  p a 3 M e p a : / 0 ‘ l c h a m n i n g  
i k k i n c h i  c h i q u v c h i  c h i z i g ‘ i b o s h l a n i s h i n i  
a n i q l a n g : )  so‘roviga javoban nuqta 2 kocrsatiladi;

-  S p e c i f y  d i m e n s i o n  l i ne  l o c a t i o n  or  
[ M T e x t / T e x t / A n g l e / H o r i z o n t a l / V e r t i c a l /  
R o t a t e d ] :  ( О п р е д е л и т е  п о л о ж е н и е  л и н и и  
р а з м е р а  и л и  [ М Т е к с т / Т е к с т / У г о л /  Г о р и ­
з о н т а л ь н ы й / В е р т и к а л ь н ы й / П о в е р н у т ы й ] :  
/ O M c h a m  c h i z i g ‘ i h o l a t i n i  a n i q l a n g  y o k i  
[ M T e k s t / M a t n / B u r c h a k / G o r i z o n t a l /  
V e r t i k a l / B u r a l g a n ] : )  so'roviga ekranda o'lcham 
chizig‘i 3 o‘tadigan istalgan nuqta ko‘rsatiladi.

6. Qolgan o'lcham chiziqlari shunga o‘xshash chiziladi.
7. To‘rtta teshik markaziari joylashgan o‘q chizig‘i 

diametrining oMchami chizilsin:
-  Linear Dimension (Линейный/Chiziqli) komanda 

chaqiriladi;
-  komandaning S p e c i f y  f i r s t  e x t e n s i o n  l i ne  

o r i g i n  o r  < s e l e c t  o b j e c t >  ( О п р е д е л и т е  
н а ч а л о  п е р в о й  в ы н о с н о й  л и н и и  р а з м е р а  
ил и  < В ы б е р и т е  о б ъ е к т > /  0 ‘ l c h a m n i n g  
b i r i n c h i  c h i q u v c h i  c h i z i g ‘ i n i n g
b o s h l a n i s h i n i  a n i q l a n g  y o k i  < O b y e k t n i  
t a n l a n g > )  soVoviga javoban nuqta4 ko‘rsatiladi;

-  komandaning S p e c i f y  s e c o n d  e x t e n s i o n  l i ne  
o r i g i n :  ( О п р е д е л и т е  Н а ч а л о  в т о р о й
в ы н о с н о й  л и н и и  р а з м е р а : / 0 ‘ l c h a m n i n g  
i k k i n c h i  c h i q u v c h i  c h i z i g ' i n i n g
b o s h l a n i s h i n i  a n i q l a n g : )  so‘roviga nuqta 5 
ko'rsatiladi;

-  komandaning S p e c i f y  d i m e n s i o n  l i ne  l o c a t i o n  
or  [M T e x t / T e x t / A n g l e / H o r i z o n t a l / V e r t i c a l /



R o t a t e d ] :  ( О п р е д е л и т е  п о л о ж е н и е  л и н и и  
р а з м е р а  или  [ М Т е к с т / Т е к с т / У г о л /  
Г ори  з о н т а л ь  н ы й / В е р т и к а л ь н ы й /  
П о в е р н у т ы й ] : / 0 ‘ 1сИаш c h i z i g ' i  h o l a t i n i  
a n i q l a n g  y o k i  [ MTe  k s t / M a t  п / B u r c h a k /
G o r i z o n t a l / V e r t i k a l / B u r a l g a n ] :) so‘roviga 
javoban kontekstli menyu (sichqon o‘ng knopkasi ekranda 
shiqillatiladi)dan MText (МТекст/MMatn) opsiya 
tanlanadi;

-  klaviaturadan probelsiz %%c40 kiritiladi (yoki redaktor 
darchasidan Symbol knopkasi ostida tanlanadi) va Enter 
klavishasi bosiladi;

-  ekranda oMcham chizigM o‘tadigan nuqta ko‘rsatiladi.
%%c belgilarini kiritishdan oldin lotincha klaviaturaga o‘tish

yodingizdan chiqmasin.
8. Tashqi yoy radiusi oMchami chizilsin:
-  Radius Dimension (Радиальный размер/Radial oMcham) 

komandasi chaqiriladi;
-  komandaning S e l e c t  a r c  o r  c i r c l e ;  ( В ы б е р и т е  

д у г у  и л и  о к р у ж н о с т ь / У о у  y o k i  a y l a n a n i  
t a n l a n g )  so‘roviga javoban nuqta 6 ko‘rsatiladi;

-  komandaning S p e c i f y  d i m e n s i o n  l i n e  l o c a t i o n  
o r  [ M T e x t / T e x t / A n g l e ] :  ( О п р е д е л и т е  
п о л о ж е н и е  л и н и и  р а з м е р а  и л и  [ М Т е к с т /  
Т е к с т / У г о л ] : / 0 ‘ 1 с Ь а т  c h i z i g ‘ i h o l a t i n i  
a n i q l a n g  y o k i  [ M T e k s t / M a t n / B u r c h a k ] :) 
so‘roviga javoban nuqta 7 ko‘rsatiladi.

9. Ichki yoy radiusining oMchami shunga o‘xshash chizilsin.
10. Diametri 6 mm li to‘it teshik uchun diametr oMchami 

chizilsin:
-  Diameter (Диаметральный размер/Diametral oMcham) 

komandasi chaqiriladi;
-  komandaning S e l e c t  a r c  o r  c i r c l e :  ( В ы б е р и т е  

д у г у  и л и  о к р у ж н о с т ь : / Y o y  y o k i  a y l a n a n i  
t a n l a n g : )  so‘roviga nuqta 8 ko'rsatiladi;



-  komandaning S p e c i f y  d i m e n s i o n  l i n e  l o c a t i o n  
o r  [ M T e x t / T e x t / A n g i e J :  ( О п р е д е л и т е  
п о л о ж е н и е  л и н и и  р а з м е р а  и л и  [ М Т е к с т /  
Т е к с т / У г о л ] : / 0 ‘ 1с11аш c h i z i g ' i  h o l a t i n i  
a n i q l a n g  y o k i  [ M T e k s t / M a t n / B u r c h a k ] : )  
so‘roviga javoban kontekstli menyudan (sichqon o‘ng 
knopkasi ekranda shiqillatiladi) MText (MTekst) opsiya 
tanlanadi;

-  ochilgan redaktor darchasida (ruscha kirill imlosida) 4 
«отв» teriladi va E nter klavishasi bosiladi;

-  marker nuqta 9 gacha tortib boriladi va sichqon 
shiqillatiladi.

11. Rotate (Повернуть/Buralsin) komandasi yordamida 
tasviming hammasi 90° ga buralsin (5.9-rasm).

12.Tasvir konturlariga qo‘yilgan o'lchamlar tahrir qilinsin.
13. Move (Перемещение/Siljitish) komandasi yordamida 

tasvir chizma maydonining markazida joylashtirilsin.
14. Tasviming yuqori qismini «siqib» yoki «cho'zib», 

detaining gabarit o‘lchami 130-150 mm oralig‘ida (doirasida) 
o‘zgartiriisin:

-  Modify (H3M eHeHHe/0‘zg a rish )  intrumentlar panelining 
mos instrumentidan foydalanib, Stretch 
(PacTflHyrb/Cho'zilsin) komandasi chaqiriladi;

-  komandaning S e l e c t  o b j e c t :  ( В ы б е р и т е  
о б ъ е к т : /  O b y e k t n i  t a n l a n g : )  so‘roviga 
klaviaturadan (lotin imlosida) «С» harfi kiritiladi, so‘ngra 
ramka yordamida tasviming cho‘ziladigan qismi (5.9- 
rasmdagi tasviming yuqori qismi) ajratib ko‘rsatiladi va 
Enter klavishasi bosiladi;

-  S p e c i f y  b a s e  p o i n t  o f  d i s p l a c e m e n t :  
( О п р е д е л и т е  б а з о в у ю  т о ч к у
п е р е м е щ е н и я : ^ !  l j i t i s h n i n g  b a z a v i y
n u q t a s i n i  a n i q l a n g : )  so‘rovga javoban istalgan 
nuqta, masalan, nuqta 1 ko‘rsatiladi (5.8-rasm);

-  S p e c i f y  s e c o n d  p o i n t  o f  d i s p l a c e m e n t :  
( О п р е д е л и т е  в т о р у ю  т о ч к у



п е р е м е щ е н и я  : / S i l j i t i s h n i n g  i k k i n c h i
n u q t a s i n i  a n i q l a n g : )  so‘rovga javoban tasvir 
sichqon bilan yuqoriga tortiladi va qachon gabarit o‘Icham 
130-150 mm ga teng bo4sa, o‘shanda sichqon shiqillatiladi.

5.9-rasm. Buralgan chizma

Obyekt shakli o‘zgarganda o‘lchamlar avtomatik ravishda mos 
qiymatlami qabul qiladi.

15. Chizma saqlansin.

5.4. Matnli kiritm a (kiritib o‘rnatish)iar
Matnni yaratish
AutoCADda chizmaga bir qatorli matnli informatsiyani kiritish 

uchun Text (Текст/Matn) komandasidan foydalaniladi. Bu 
komandani chaqirish quyidagi opsiyalar bo‘yicha sodir bo'Iadi: 
Draw => Test ==> Single Line Text (Черчение => Текст =>



Текстовая строка/Chizmachilik => Matn => Matnli qator).
Ko‘p qatorli matnni kiritish uchun MText (MTekst) 

komandasidan foydalanish Iozim, uni chaqirish uchun Draw => 
Text => Multiline Text (Черчение => Текст ->  
Многострочный/Chizmachilik => Matn => Ko‘p qatorli)ni tanlash 
yoki Draw (Черчение/Chizmachilik) instrumentlar panelidagi 
Multiline Text (Многострочный/Ко‘р qatorli) instrumentdan 
foydalanish kerak.

Multiline Text (Многострочный/Ко‘р qatorli) komanda 
chaqirilgandan keyin komanda qatorida quyidagi so‘rovlar paydo 
bo'ladi:

S p e c i f y  f i r s t  c o r n e r :  ( О п р е д е л и т е  пе рв ый
у г о л : /  B i r i n c h i  b u r c h a k n i  a n i q l a n g : ) ;

S p e c i f y  t h e  o t h e r  c o r n e r  or  [ H e i g h t / J u s t i f y /  
L i n e s p a c i n g / R o t a t i o n / S t y l e / W i d t h ] : ( О п р е д е л и т е  
п р о т и в о п о л о ж н ы й  у г о л  или  [ Вы с о та /  
В ы р а в н и в а н и е / М е ж с т р о ч н ы й  и н т е р в а л / П о в о р о т  
/ С т и л ь / Ш и р и н а ] /  Q a r a m a - q a r s h i  b u r c h a k n i  
a n i q l a n g  y o k i  [ B a l a n d l i k / T e k i s l a s h / K o ‘p qa t o r l i  
i n t e r v a l /  B u r a s h / S t i l / K e n g l i k ] ) .

Agar birinchi so‘rovga javoban ekranda matn to‘g‘ri burchakli 
ramkasining bitta nuqtasi ko‘rsatilsa, ikkinchi so‘rovga javoban esa 
diagonal bo‘yicha qarama-qarshi nuqta kiritilsa, ekranda Text 
Formatting (Форматирование текста/Matnni formatlash) dialog 
darchasi paydo boMadi -  5.10-rasm, unda matn kiritilishi va uning 
parametrlarining o‘matilishi bajariladi.

jS te x to d  v T f f t r i ______________________  F .  H 1 S  * • {Ш F  |Щ !  OK ©

ijillll m  @ 2  s  1= != S  ?a. At о  . o furaf;; j

5.10-rasm. Text F orm atting  (Форматирование текста/Matnni formatlash)
dialog darchasi

Text Formatting (Форматирование текста/Matnni 
formatlash) dialog darchasi beradigan imkoniyatlar:

© shrift, simvollar balandligi va formatini berish hamda



matnga maxsus simvollar kiritish;
® matn stili, paragraf kengligini tanlash yoki berish, 

matnni burish va uni tekislash; 
о matn qatorlari orasidagi masofani berish;
0 matnni almashtirishni amalga oshirish.

Matn xossasini o4zgartirish faqatgina matnning tahrir 
qilinadigan qismi ajratiigandan keyingina amalga oshiriladi. Matn 
kiritiigandan va dialog darchasidan chiqilgandan keyin ruchkalar 
yordamida matnni kiritish darchasini cho‘zib yoki siqib paragraf 
kengligini tahrirlash mumkin.

Yangi matnli stilni yaratish
Tizim yuklanganda indamaslik bo‘yicha matnning muayyan 

Standard stili o‘matiladi, unda Txt shrifti o‘matilgan boMadi. 
Chizmada yozuvlami bajarish uchun ISOCPEUR shriftidan 
foydalanilgani ma’qul, u ГОСТ 2.304-68 ga ancha mos keladi. 
Agar chizmada yozuvlar ko‘p bo‘lsa, har gal matn redaktorining 
dialog darchasida shrifini almashtirlsh ncqulay bo‘!adi. Undan 
ko‘ra talab qilinayotgan shriftli yangi matnli stilni yaratish va 
undan foydalanish yaxshiroq bo'ladi.

Yangi stil Text Style (Стиль текста/Matn stili) dialog 
darchasida yaratiladi va Form at => Text Style... (Формат => 
Стиль текста.../Format => Matn stili...) komandasi bilan 
chaqiriladi. Stilning yangi nomi, masalan stile 1, New... 
(Создать.../Yaratilsin...) knopkasi bosilganda paydo bo‘ladigan 
New Text Style (Новый стиль текста/Matnning yangi stili) dialog 
darchasida beriladi. Text Style (Стиль текста/Matn stili) dialog 
darchasida Style Name (Имя стиля/Stil nomi) ro*yxat maydonida 
style 1 stili o‘mati!adi, Font Name (Shrift) ro‘yxat maydonida esa 
ISOCPEUR shrifti teriladi.

5.3-mashq. Matnli kiritm alar
1. «Чертеж 6» fayli ochilsin va u «Чертеж 7» nomi ostida 

saqlansin.
2. Gabarit o‘lcham 150 yoniga «*» simvoli qo‘yilsin (5.11- 

rasm):



-  matn qatlamiga o'tiladi;
-  Draw => Text => Single Line Text (Черчение => Текст 

=> Текстовая строка/Chizmachilik => Matn => Matnli 
qator) terilib Text (Текст/Matn) komandasi chaqiriladi;

-  komandaning S p e c i f y  s t a r t  p o i n t  o f  t e x t  or  
[ J u s t i f y \ S t y l e ] :  ( О п р е д е л и т е  н а ч а л ь н ы й
у г о л  т е к с т а  или
[ В ы р а в н и в а н и е \ С т и л ь ] / М а 1п п 1п§ 
b o s h l a n g ‘ i c h  b u r c h a g i n i  a n i q l a n g  y o k i  
[ T e k i s l a s h \ S t i I ] )  so‘roviga o‘icham raqami ustida 
nuqta ko‘rsatiladi;

-  komandaning S p e c i f y  h e i g h t  <5> :
( О п р е д е л и т е  в ы с о т у  < 5 > : / B a l a n d l i k n i  
a n i q l a n g  < 5 > : )  so‘roviga balandlik 5 mm teriladi va 
Enter klavishasi bosiladi;

-  komandaning S p e c i f y  r o t a t i o n  a n g l e  o f  t e x t  
< 0 > :  ( О п р е д е л и т е  у г о л  в р а щ е н и я  т е к с т  
< 0 > : / M a t n  b u r a l i s h i  b u r c h a g i n i  a n i q l a n g  
< 0 > : )  soeroviga Enter klavishasi bosiladi;

-  «*» simvoli klaviaturadan kiritiladi va Enter ikki marta 
bosiladi.

3. Chizmaga «* Ma’lumot uchun o'lcham» matni, asosiy yozuv 
ostida joylashtirib, kiritilsin (5.11-rasm):

-  Draw (Черчение/Chizmachilik) instrumentlar panelida 
Multiline Text (Многострочный текст/Ко‘р qatorli matn) 
piktogrammasida shiqillatib MText (МТекст/ММаШ) 
komandasi chaqiriladi;

-  komandaning S p e c i f y  f i r s t  c o r n e r :
( О п р е д е л и т е  п е р в ы й  у г о л : / В т п с 1 п  
b u r c h a k n i  a n i q l a n g : )  so‘roviga javoban ekranda 
asosiy yozuv ustida sichqonni shiqillatib matn ramkasining 
pastki chap nuqtasi kiritiladi;



5.11-rasm. A4 formatda «Plita» detalining chizmasi

-  komandaning S p e c i f y  t h e  o t h e r  c o r n e r  or  
[ H e i g h t / J u s t i f y / L i n e  s p a c i n g / R o t a t i o i n  
S t y l e / W i d t h ] :  ( О п р е д е л и т е  п р о т и в о п о ­
л о ж н ы й  у г о л  и л и  [ В ы с о т а /
В ы р а в н и в а н и е / М е ж с т р о ч н ы й  и н т е р в а л /  
П о в о р о т / С т и л ь / Ш и р и н а ] : / р а г а т а - д а г 5 1 и  
b u r c h a k n i  a n i q l a n g  y o k i  [ B a i a n d l i k /  
T e k i s l a s h l a r / Q a t o r i a r a r o  i n t e r v a l / B u r a s h /  
S t i l / K e n g l i k ] : )  so'roviga matn ramkasining diagonal 
bo‘yicha qarama-qarshi nuqtasi kiritiladi;

-  Text Formatting (Форматирование текста/Matnni 
formatlash) dialog darchasida -  5.10-rasm -  ISOCPEUR 
shrifti kursiv bilan teriiadi, matn balandligi 5 ga teng 
o‘matiladi va mos matn teriiadi.

4. Asosiy yozuvning yetishmayotgan chiziqlari ГОСТ 2.104-68



bo‘yicha chizilsin (hammasi Ramka qatlamida chiziladi) va uning 
maydonlari 5.11-rasmga mos to'ldirilsin (maydoniar Matn 
qatlamida toMdiriladi).

5. Chizma saqlansin.

5.5. Grafik informatsiyani bosmaga chiqarish
Grafik informatsiyani bosmaga chiqarish File => Plot... (Fayl 

=> Pechat...) komandasi yordamida yoki instrumentlar tizimiy 
panelidagi Plot (Pechat) piktogrammasida sichqon shiqillatiiib 
amalga oshiriladi. File => Plot... (Fayl => Pechat...) komandasi 
Plot (Pechat) dialog darchasini ochadi -  5.12-rasm, unda 
bosmalovchi qurilma tanlanadi va chizma parametrlari (masshtab, 
joylashish, oriyentatsiya) o‘matiladi.
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-Jit;

Нлбср п'ста

i< N S T >

npaviisp/rjaiTcp
1Ъ&: ©Нет 'V I

П л о т т е р :

Пвао-лтг

Ю  M icrosoft № S  D s e w r a s r t  W i i «  
b y  м г д а о н  O ine ts D e e u m s m  i m s s e  w i s e t  Пмлжмтм. kShpiessjjenmOSensjOifvef 
f ^ t o L e s e i J e i l C n O  

j  D e la iA  W n f c w  S y s te m  P t r t o . p c 3  jDWFed=W.pc3 
jD W G  Т о Р О Р .р с З  
?  P l ib S A T  o W e b  J P G  p c 3  

j P u f e h T o W e b  P K G .p c 3 _________________ФЭРЯ4Т Ч кло >K5«!-n<KpC9

! 150 АЧ (ZIO.Q) z  297.00 m )

r . i4 iT K M 3 9  o f  n v r r a  

[Экрги , v /

MetareSnewn 
[ЗЁцйать 
Мэситай i •

С г г д г * * г  о т  м а ч а п а  ( п г ч в г в  ь  п г ч а г г е г а "  с О л е с т ч )  

X; 1 1 1 5 5  I ri4 О и еч т£ « р св * ть

£ р|3.65 ~| ик ...........

^ c w j t p ,  .  ■ П ; ; . -  5 K i - c < r , 4 T i  | OK 11 О т п з к д  j  | О т а у с а '  1 ©

5.12-rasm. Plot (Pechat) dialog darchasi



6. CHIZMANI YARATISH METODHtASI

Shuni qayd qilish kerakki, yuqoridagi mashqlarda ko‘rib 
chiqilgan bar xil grafik tasvirlami chizish metodikasi mumkin 
bo'lganyagona metodika emas. U yoki bu chizmani qurish grafik 
tashkil etuvchilarining konfiguratsiyasiga, chizma murakkabligi 
darajasiga hamda konstruktoming avtomatlashtirilgan muhiida 
ishlashga tayyorgarlik darajasiga bog‘Iiq. Biz AutoCAD muhitida 
chizmalarni yaratish bo‘yicha faqat umumiy tavsiyalami beramiz 
xolos.

6.1. Chizmalarni yaratish bo‘yicha iavsiyalar
1. Shablonni yaratish va undan, misol uchun, keyinchalik A3, 

A4 formatii chizmalarni olish uchun foydalanish. Shablonni 
tayyoriashda zarur boMgan amallami bajarish:

-  chizma chegaralari va o'lchov birliklarini berish;
-  ularda chizmaning har xil komponentlarini chizish uchun 

qatlamlami yaratish va har bir qatiam uchun chiziqlaming 
talab qilingan turi, qalinligi va rangini o‘rnatish;

-  o‘lchamlami qo‘yib chiqish uchun opsiyalami rostlashni 
amalga oshirish;

-  chizmada yozuvlami amalga oshirish uchun matn stilini 
yaratish;

-  ramkani chizish va asosiy yozuvni bajarish;
-  koordinat setkasini ekranga chiqarish rejimini o'rnatish.
2. Chizmani qo‘l usulida yaratish usufiga yaqin bo'lgan 

metodikadan foydalanib chizmani bevosita bajarish (bunda har bir 
konstruktoming о ‘z  «dastxati» bo ‘lishi mumkin).

6.2. Chizmani bajarish
\  uqorida keltiriigan tavsiyalami amalga oshirish uchun turli 

usullardan foydalanish mumkin. 6.1-rasmda tasvirlangan [8] 
«Korpus» detalini chizish misolida usullardan birini ko‘rib 
chiqamiz.

6.5-6.14 rasmlardagi individual (shaxsiy) grafik topshiriq 
variantini tanlash talaba reyting daftarchasining oxirgi ik/d raqami



yig'indisi bo'yicha amalga oshiriladi.
Individual grafik topshiriq quyidagi bandlardan tarkib topadi:

0 detaining ikki tasviri bo6yicha uning uchinchi tasviri 
ratsional kesimlar bilan A3 formatda qurilsin; 

e kesishish chiziqlari va yuza (sirt)lar o‘tishlari yordamchi 
kesuvchi yuzalar (o'tish chiziqlari shartli ko‘rsatilgan, 
ularda savol belgisi qo‘yilgan) qurilsin;

® o‘lchamlar qo‘yib chiqilsin va asosiy yozuvlar 
to‘ldirilsin.
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6.1-rasm. Topshiriqning boshlang‘ich varianti



Ishni boshlashdan oldin detalni tashkil etuvchi asosiy geometrik 
jismlami aniqlash lozim. Bundan tashqari o‘zaro kesishuvchi sirtlar 
juftliklarini aniqlash zarur. 0 ‘tish chiziqlarining xarakterli 
nuqtalarini qurish kerak. Oraliq nuqtalami yordamchi kesishuvchi 
tekisliklar usuli bilan aniqlash lozim. 0 ‘tish chiziqlari qurilgandan 
keyin uchala tasvirda oMchamlami qo‘yib chiqish zarur, bunda 
o‘IchamIar ko‘rmishlarda ratsional taqsimlanishi kerak.

6.3. Korpus detali chizmasini bosqichma-bosqich bajarisli
6.1-mashq. Korpus detali chizmasini qurish
1. Boshlang‘ich variant (бЛ-rasm) asosida uchinchi ko‘rinishni 

qurish:
-  «Чертеж 7» fayli ochiladi va uning formatining 

o‘lchamlari o‘zgartirilib (A4 o'miga A3 formatini ramka va 
asosiy yozuv bilan yaratamiz), «Чертеж 8» nomi ostida 
saqlanadi;

-  chizma maydonini teng to‘rt bo'lakka burib, proyeksiyalar 
o‘qlari o‘tkaziladi; bissektrisani nisbiy koordinatalarda 
( 0 ‘q qatlamida) qutb usulida berish yordamiaa o‘ikaziladi;

-  chizma maydonining choragi proporsional ikkiga bo‘linib, 
uchta ko'rinish uchun simmetriya o‘qi o‘tkazi!adi;

-  Endpoint (Конец/Oxirgi nuqta), M idpoint (Середина/ 
0 ‘rta nuqta), Center (Центр/Markaz) va Intersection 
(Пересечение/Kesishish) bog‘lanishlari yordamida 
yuqoridan ko‘rinishda silindrlar asosi aylanasi quriladi, 
so‘ngra Offset (Отступ/Chekinish) (Kontur qatlami) 
instrumentidan foydalanib, olddan va yondan 
ko‘rinishlarda qolgan proyeksiyalar quriladi;

-  Offset (Отступ/Chekinish) va Tangent (Касательная/ 
Urinma) (yuqoridan ko'rinish uchun) bogManishidan 
foydalanib, detaining yuqori qismida konusning o‘q 
chizig‘i o‘tkaziladi va uning proyeksiyasi uchta kocrinishda 
quriladi;

-  yuqoridan ko‘rinishda aylana chiziladi, unda silindrsimon 
teshiklar detal asosida joylashadi va qutb rejimida Array 
(Massiv) instrumentidan foydalanib, teshiklami yaratamiz.



2. Sirtlaming kesishish chiziqlarini (6.1-rasmda savol belgisili 
chiziqlar) qurish:

-  yordamchi kesishuvchi tekisliklar (frontal 
proyeksiyalovchi) metodi yordamida kesik konusning 
silindr bilan kesishish nuqtalari aniqlanadi, bu nuqtalar 
olddan ko‘rinishning chap yarmida va chapdan ko'rinishda 
quriladi (6.2-rasm);

-  nuqtalaming keraklicha soni qurilgandan keyin ular Spline 
(Splayn) instrument! yordamida silliq egri chiziq bilan 
birlashtiriladi va yordamchi chiziqlar yo'qotiladi.

6.2-rasm. Uchta ko‘rinishni va kesishish chiziqlarini qurish

3. Olddan va yuqoridan ko‘rinishlarda kesimni qurish (6.3- 
rasm):

-  topshiriq variantiga muvofiq olddan ko'rinishning o ‘ng 
yarmida kesim quriladi;

-  detal ichida ikki tomoni teshikli silindrsimon teshigi bor 
olddan ko‘rinishda kesik konusning ichidagi silindrsimon 
teshik kesishishining tayanch nuqtasi aniqlanadi;

-  olddan ko'rinishdagi kesimda detal asosidagi silindrsimon



teshikning kesik konus ko‘rinishdagi ichki teshik bilan 
kesishishining tayanch nuqtasi aniqlanadi;

-  silindrsimon teshik proyeksiyasining (o‘q chizigM bo‘ylab) 
asosning ichki qismida chegaraviy nuqtalar 
(soddalashtirilganda ellips ko'rinishida) aniqlanadi;

-  qurilgan kesishish nuqtalari Spline (Splayn) instrument! 
yordamida (savol belgisi qo‘yilgan joylarda) silliq egri 
chiziq bilan birlashtiriladi, yordamchi chiziqlaryo‘qotiladi.

4. Yuqoridan ko‘rinishda berilgan gorizontal kesishni va 
hamma tasvirlarda ikki tomoni teshik prizmatik teshikni qurish:

-  yuqoridan ko‘rinishda kesuvchi tekislik A-A bo‘ylab 
gorizontal kesim quriladi;

-- olddan va chapdan ko'rinishlarda ikki tomoni teshik 
prizmatik teshikning proyeksiyalari berilgan o‘lchamlarga 
muvofiq quriladi;

-  yordamchi qurilmalar yo‘qotiladi;
-  hamma kontur chiziqlari kontur qatlamiga, o‘q chiziqlari -  

o‘q qatlamiga o‘tkaziladi (ko‘chiriladi).



5. ICesim shakllarini shtrixlash:
-  Slitrixovka qatlami tanlanadi;
-  Hatch (Slitrixovka) instrumenti yordamida, 5.1-rasmdagi 

parametrlar yo‘rig‘iga muvofiq, tasvirlardagi Kesim 
shakllari, ulaming berk ekanligini tekshirilib, shtrixlanadi;

-  A-A kesuvchi tekisligining holati ko'rsatiladi va kesim 
belgisi chiziladi (Matn qatlami).

6. 0 ‘lchamlami qo‘yib chiqish:
-  Размеры ( 0 ‘lchamlar) qatlami tanlanadi;
-  Dimension Style (Стиль размера/0‘ Icham stili) 

instrumenti yordamida parametrlar 5.5-5.7-rasm larga 
muvofiq o‘matiladi;

-  Dimension (Размер/ОЧсЬат) instrumenti yordamida 6.4- 
rasmga muvofiq o‘lchamlar qo‘yi!adi.

6.4-rasm. Shtrixovkalash va o‘lchamlami qo*yib chiqish
7. Asosiy yozuv to‘ldiriladi. Bu operatsiya Tekst (Matn) 

qatlamida bajariladi.
8. Chizma saqlanadi va u bosmaga chiqariladi.



©

6.5-rasm. Individual grafik topshiriqning (0-1) variantlari





6.7-rasm. Individual grafik topshiriqning (4-5) variantlari 
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6.8-rasm. Individual grafik topshiriqning (6-7) variantlari
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7. UCH 0 ‘LCHAMLI MODELLASH

CAD-tizimlarida uch oMchamli obyektlami yaratish uchun 
modellashning asosan uch: karkasli, sirtli va qattiq jismli 
modeltash usullaridan foydalaniladi; ulaming har biri real 
obyektlami reallikning har xil darajasida yaratish imkonini beradi:

• Karkasli modellash. Ushbu modelda obyektning faqat 
qovurg‘aIari taqdim etiladi, uning qirralari aniqlanmaydi, 
shuning uchun model shaffof bo‘ladi. Karkasli modelda hajm 
tushunchasi bo'lmaydi. 

e Sirtli modellash. Bu modelda obyektning qovurg'a va 
qirralari aniqlanadi, u karkasli modelga nisbatan aniqroq 
bayonni ta’minlaydi. Model shaffof emas, oldindagi qirralar 
ortdagi qiiTalarni berkitib turadi. Sirtli model hajmga ega, 
lekin massani hisobga olmaydi, chunki model devorlari 
qalinligi hisobga olinmaydi. 

e Qattiq jism li modellash. Bu model obyektni haqiqatga yaqin 
bayon qilish imkonini beradi. U obyektning tashqi qirralari 
va qovurg‘alari haqida batafsil informatsiyani beradi hamda 
uning ichki strukturasini bayon qiiadi. Qattiq jismli model 
hajm va massaga ega va material xarakteristikasini hisobga 
oladi.

Uch o‘ichamli modellash quyidagi imkoniyatlami ta’minlaydi:
® modelni fazoning istalgan nuqtasidan ko‘rib chiqish; 
о model kesimini bajarish;
a modelning ikki o‘lchamli cnizmalarini avtomatik tarzda 

bajarish; 
e modelning real aksini olish;
о material xarakteristikalari va tashqi yoritishni qo-shish. 
AutoCADda uch o‘lchamlt fazoda ishiash uchun komandalar 

mavjud, ular yordamida uch o‘Ichamli obyektlami modellash, 
materialni bayon qilish va yoritishni o'matish mumkin. AutoCAD 
2007 da uch o‘lchamli modellash uchun qulay maxsus interfeys 
mavjud [4].



7.1. Uch o‘lcham!i fazo
Dastur dastlab ishga tushirilgandan keyin (7.1-rasmga qarang) 

dialog darchasida 3D Modeling (3D моделирование/ЗО 
modellash) interfeysini tanlash mumkin. Lekin keyingi ishga 
tushirishlarda bu rejimga o‘tish uchun Tools => Workspase => 3D 
Modeling (Сервис => Рабочее пространство => ZM 
моделирование/Servis => Ishchi maydon => 3D modellash) 
komandasidan foydalanish yoki Workspase (Рабочее 
пространство/fshchi maydon) panelida oqib tushadigan 
menyuning tizimiy qatori ostida mos rejimni tanlagandan keyin 
o‘tish mumkin (7.1-rasm).
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7.1-rasra. 3D M odeling (3DmodeIlash) ishchi maydonining darchasi

3D Modeling (3D моделирование/3D modellash) rejimida 
dastuming ishchi darchasi o‘zgaradi. AutoCAD 2007 da 
Dashboard (Инструментальная панель/instrumental pane!) 
paneli paydo bo'ldi, u quyidagi boshqaruv panellaridan tarkib 
topgan (7.1-rasm, darchaning o‘ng qismi):



« 2D Make (2D nocTpoeHWi/2D qurishlar), indamasdan 
kelishganlik bo‘yicha u berkitilgan;

® 3D Make (3D построения/ЗО qurishlar);
e 3D Navigate (3D навигация);
© Visual Styles (Стили визуализации/Vizuallash stillari);
• Light (Освещение/Yoritish);
© Materials (Материалы/MateriaIIar);
e Render (Тонирование/Tonirovka qilish).
Bu panellarning liar biri qisman aks ettiriladi, ulami pastga 

yoyish uchun davom ettirish znachogi -  ikkilangan galochkani 
bosish zarur. Uch o‘Ichamli sahnani ko‘rib chiqish paytida ishchi 
maydonni vaqtinchalik kattalashtirish uchun View => Clean 
Screen (Вид => Очистить 3KpaH/Ko‘rinish => Ekran tozalansin) 
komandasidan foydalanish mumkin. Ko‘rib chiqish uchun 
mo‘ljallangan uch o‘lchamli obyektlami aks ettirish rejimlarini 
ko‘rib chiqamiz.

7.2. Aks ettirish va ko‘rih chiqish rejimlari
Sirtli va qattiq jismli modellar tashqi ko‘rinishini o‘zgartirish 

uchun View => Visual Styles (Вид => Визуальные 
cmjiH/I<.o‘rinish => Vizual stillar) komandasidan yoki Visual 
Styles (Визуальные стили/Vizual stillar) panelidan -  7.2-rasm 
hamda yuqorida bayon qilingan Dashboard (Инструментальная 
панель/instrumental panel) panelidagi shu nomdagi paneldan 
foydalaniladi. Aks ettirish va ko‘rib chiqish rejimlarini tekshirish 
uchun c:\Program Files\AutoCAD 2007\Help\buildyourworld 
tizimiy papkadagi istalgan obyekt ochiladi.

Visual Styles (Визуальные стили/Vizual stillar) opsiyalari uch 
o'lchamli obyektlami ko‘rib chiqishning quyidagi rejimlarini 
tanlash imkonini beradi:

0 2D W ireframe (2D karkas) -  faqat sirtlar chegaralarini 
aniqlovchi kesmalar va egri chiziqlar aks ettiriladi, 
qovurg‘alar ko'rsatiladi;

® 3D W ireframe (3D karkas) -  uch o‘lchamli modellar 
karkasli ko‘rinishda aks ettiriladi;

® 3D Hidden (3D CKpbrme/3D yashirin) -  modelning



ko‘rinmaydigan qovurg‘alari yashiriladi;
® Realistic (Реалистичный/Real) -  sirt obyekt rangi yoki 

material turi bo‘yicha bo‘yaladi (7.1-rasm);
® Conceptual (Концептуапьный/Konseptual) -  sirt 

obyektning yarimshaffof rangi bilan bo‘yaladi.
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7.2-rasm. V isual Styles (Визуальные стили/Vizual stillar) instrumentlar 
paneli va boshqaruv paneii

Aksning foydalanuvchi stilini yaratish uchun Visual Styles 
M anager (Диспетчер стилей визуапизации/VizualIash stillari 
dispetcheri) komandasidan foydalaniladi.

Uch o‘lchamli obyektlami ko‘rib chiqish uchun View



(Bnji/Ko‘nnish) yoki Dashboard (Инструментальная панель/ 
Instrumental panel) menyusidagi komandalardan foydalaniladi -  
7.3-rasm:

* 3D Views (3D виды/ЗО ko‘rinishlar);
* 3D Orbit (3D orbita);
♦ 3D W alk (3D прогулка/ЗО sayr);
* 3D Fly (3D полет/ЗО uchish);
* 3D Distance (3D дистандия/ЗО масофа);
* 3D Swivel (3D shamir);
* Parallel Projection (Параллелная проекция/Parallel 

proyeksiya);
• Perspective Projection (Перспективная проекция/ 

Perspektiv proyeksiya).
View (BiutfKo'rinish) instrumentlar panelida quyidagi ikki 

oMcliamli va uch o‘lchamli ko‘rinishlar mavjud:
• T or (Вид сверху/Уuqoridan ko‘rinish);
• Bottom (Вид снизу/Pastdan ko‘rinish);
♦ Left (Вид слева/Chapdan ko‘rinish);
• Right (Вид c n p a B a /0 ‘n g d a n k o ‘rin ish );
• Front (Вид спереди/Olddan ko‘rinish);
♦ Back (Вид сзади/Ortdan ko‘rinish);
* SW Isometric (Ю-3 изометрический/J-G1 izometrik);
* SE Isometric (IO-B изометрический/J-Sh izometrik);
<• NE Isometric (C-B изометрический/Shim-Sh izometrik);
• NW Isometric (C-3 изометрический/Shim-G* izometrik).
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7.3-rasm. Ko‘rib chiqish uchun instrumentlar panellari

Aks ettirish va ko‘rib chiqish isntrumentlari yordamida 
AutoCADda uch oMchamli obyekt ishlanayotgan modelining eng 
ma’qul ko'rinishini va ko‘rib chiqish rejimini tanlash mumkin.

I l l



7.3. Karkasli va sirtli modellash
AutoCADda sirtlami qurish uchun komandalar Draw 

Modeling => Meshes (Черчение => Моделирование
сетки/Chizmachilik => To‘mi modellash) menyusida joylashgan, 
ular 7.4-rasmda taqdim etilgan. Bu menyu yordamida sirtlaming 
quyidagi turlarini qurish mumkin:

♦ 2D Solid (Плоская поверхность/Tekis sirt) -  burchak 
cho‘qqi!ari berilgan tekis sirt;

• 3D Face (Трехмерная грань/Uch o‘lchovli qirra) -  uchta 
yoki to'rtta to‘g‘ri chiziqli qovurg‘a!ari bilan berilgan sirt;
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7.4-rasm. Sirtlami qurish uchun komandalar 

♦ Edge (Кромки/Qirralar) — 3D Face (Трехмерная



грань/Uch o‘lchov!i qirra) turidagi obyektlar qovurg‘alarining 
ko‘rinuvchanligini boshqaradi;

* 3D Mesh (3D ceTKa/3D to‘r) -  cho‘qqilari bilan berilgan 
ko‘pburchakli to‘r;

* Revolved Mesh (Сетка вращения/Aylanish to‘ri) — 
ixtiyoriy ikki o‘!cham!i kontuming o‘z o‘qi atroida aylanishi 
natijasida olingan to‘r;

* Tabulated Mesh (Сетка сдвига/Siljish to‘ri) -  ixtiyoriy 
ikki o‘lchamli kontuming berilgan vektor yo'nalishida sitib 
chiqarish natijasida olingan to‘r;

* Ruled Mesh (Сетка соединения/Birlashtirish to‘ri) -  ikki 
to‘g‘ri chiziq yoki egri chiziqli qovurg‘alar orasida interpolyatsiya 
yo‘li bilan qurilgan to‘r;

* Edge Mesh (Сетка no кромкам/Qirralar bo'yicha to‘r) -  
to‘rt qovurg‘a orasida interpolyatsiya yo‘Ii bilan qurilgan to‘r 
(Kuns sirti).

Sirtlami yaratish bo‘yicha komandalami qo'Ilashni mashqlarda 
ko‘rib chiqamiz.

7.1-mashq. 3D Face (Трехмерная грапь/Uch o4lchovli 
qirra) komandasi

Besh qirrali piramida
1. Tools => W orkspase => 3D modeling (Сервис => 

Рабочее пространство => 3D моделирование/Servis => Ishchi 
maydon => 3D modellash) komandasi bilan metrik o‘lchov birligili 
uch oichamli modellash rejimiga o‘ting. Faylni «Piramida» nomi 
ostida saqlang.

2. To‘g‘ri chiziq kesmasini piramida balandligi ko‘rinishida va 
asosni -  beshburchak ko'rinishida chizamiz:

-  Line (Линия/Chiziq) komandasi chaqiriladi;
-  birinchi nuqta 100,100, 0 koordinatalari bilan beriladi;
-  kesma oxiri 100, 100, 100 koordinatalar bilan beriladi va 

Enter klavishasi bosiladi;
-  Polygon (Многоугольник/Ко‘рЬигс11ак) komandasi 

chaqiriladi;
-  5 la burchak va bayon qilingan aylananing radiusi SO mm



beriladi, markaz sifatida piramida balandligining asosi 
ko‘rsatiladi.

&

7.5-rasm. Piramidaning karkasli va sirtli modellari

3. Qurishlar natijasi piramidaning karkasli modeli ko‘rinishida
7.5-rasmning chap tarafida Realistic (Реалистичный/Real) aks 
ettirish rejimida taqdim etilgan. Uch o'lchamii model -  bu 
piramida qovurg'alarining majmuidir. Piramida qirralarini qurish 
uchun 3D Face (Трехмерная грань/Uch o'lchamii qirra) 
komandasidan foydalanamiz:

-  Draw => Modeling => Meshes => 3D Face (Черчение 
=> Моделирование => Сетки => Трехмерная грань/ 
Chizmachilik => Modellash => To‘rlar => Uch o'lchamli 
qirra) komandasi tanlanadi;

-  komandaning so'roviga javoban piramida asosi -  
beshburchakning cho‘qqiIarini navbatma-navbat 
ko'rsatiladi, natijada asos ikkita bir-birini qoplaydigan 
to'rtburchakli qirralardan tarkib topadi;

-  so‘ngra piramidaning uchburchakli yon qirralari shunga 
o‘xshash quriladi va qurilgan chizma saqlanadi.

4. Qurilmalar natijasi piramidaning sirtli modeli ko‘rinishida
7.5-rasmning o‘ng tarafida Realistic (Реалистичный/Real) aks 
ettirish rejimida taqdim etilgan.



7.2-mashq. Revolved Mesh (Сетка вращения/Aylanish 
setkasi) komandasi

Aylanish ruxi (ладья)
1. Oidingi qurilmalami o'chiring va faylni «Rux» nomi ostida 

saqiang. Bu mashqda biz rux ko'rinishidagi shaxmat figurasini 
yaratamiz (shu tarzda piyoda yoki filni yaratishingiz mumkin).

2. Buning uchun biz aylantirish usulidan foydalanamiz, 
shuning uchun shaxmat figurasining o‘qi va profilini qurish lozim:

-  yuqoridan ko‘rinishga o‘tish uchun View => 3D Views => 
Tor (Вид => ЗМ виды => Вид CBepxy/Ko‘rinish => ЗМ 
ko‘rinishIar => Yuqoridan ko'rinish) komandasini 
bajariladi;

-  Line (Линия/Chiziq) instrumenti yordamida to‘g‘ri chiziq 
kesmasini aylanish o‘qi ko‘rinishida quring;

-  Spline (Splayn) instrumenti yordamida aylantirish uchun 
profil quring (7.6-rasm, chapda);

-  aylantirishni amalga oshirishdan oldin shuni qayd etish 
lozimki, tizimiv o'matishlar bo‘yicha aylantirishda 
segmentlar soni indamasdan kelishganlik bo‘yicha 6 ga 
teng boiadi, bu hoida natija ko‘pda real bo‘lmaydi, 
shuning uchun segmentlar sonini ko'paytiramiz, buning 
uchun komanda qatori orqali navbatma-navbat 
quyidagilami kiritamiz: S U R F T A B 1 ,  E n t e r ,  50;  
П О Т О М  S U R F T A B 2 ,  E n t e r ,  50 .

3. Draw => Modeling => Meshes => Revolved Mesh 
(Черчение => Моделирование => Сетки => Сетка вращения/ 
Chizmachilik => Modellash => To‘rlar => Aylanish to‘ri):

-  so‘rovga javoban dastiab aylantirish uchun mo‘ljallangan 
profilni, so'ngra -  aylanish o‘qi ko'rsatiladi;

-  aylanishning boshlang'ich va oxirgi burchaklari haqidagi 
so‘rovga Enter klavishasi bosiladi (chunki aylanish 
burchagini 0° dan 360° gacha qoldiramiz) va qurilmalar 
saqlanadi.

4. Qurishlar natijasi ruxning sirtli modeli ko‘rinishida 7.6- 
rasmning o‘ng tarafida Realistic (Реалистичный/Real) aks ettirish 
rejimida taqdim etilgan.



7.6-rasm. Rux profili va uning sirtli modeli

7.3-mashq. Tabulated Mesh (Сетка сдвига/Sitib chiqarish 
to ‘ri) komandasi

Sitib chiqariigan relslar
1. Oldingi qurilmalami o‘chiring va faylni «Relslan> nomi 

ostida saqlang. Bu mashqda biz relslami tavr profilidan sitib 
chiqarish metodi bilan yaratamiz.

2. Sitib chiqarish metodini qoMlash uchun berk va ochiq egri 
chiziqlami hamda sitib chiqarish vektorini yaratish lozim:

-  olddan ko‘rinishga o‘tish uchun View => 3D Views => 
Front (Вид => ЗМ виды => Вид спереди/К.о4гшз11 => 
ЗМ ko'rinishlar => Olddan ko'rinish) komandasi bajariladi;

-  Poliline (Полилиния/Polichiziqlar) instrumenti yordamida 
7.7-rasm, yuqorida ko‘rsatilganidek tavr profili quriladi 
(profilni istalgan geometrik primitivlardan yagona obyekt 
ko‘rinishida qurish mumkin);

-  sitib chiqarish vektorini qurish uchun View => 3D Views 
=> Tor (Вид => ЗМ виды => Вид cBepxy/Ko‘rinish => 
ЗМ ko'rinishlar => Yuqoridan ko'rinish) komandasi 
yordamida yuqoridan ko'rinishga o‘tiladi va to‘g‘ri chiziq 
kesmasi quriladi, so‘ngra qulay bo‘lgan uch o‘lchamli 
ko‘rinishga o‘tiladi.

3. Draw => Modeling => Meshes => Tabulated Mesh 
(Черчение => Моделирование => Сетки => Сетка сдвига/ 
Chizmachilik => Modellash => To‘rlar => Sitib chiqarish to‘ri)



-  kontur haqidagi so'rovga javoban qurilgan profil, so‘ngra 
sitib chiqarish vektori -  tocg‘ri chiziq ko‘rsatiladi.

4. Faylni saqlang. Qurishlar natijasi relsning sirtli modeli 
ko'rinishida 7.7-rasm, pastda, Conceptual (Концептуальный/ 
Konseptual) aks ettirish rejimida taqdim etilgan.

7.7-rasm. Sitib chiqarish uchun boshlang‘ich obyektlar va relsning sirtli
modeli

7.4-mas!tq. Ruled Mesh (Сетка соедипения/Biriktirish 
to‘ri) komandasi

Transtovushii qanot
1. Oldingi qurilmalami o‘chiring va faylni «Qanot» nomi 

ostida saqlang. Bu mashqda biz qanot chiziqli sirti (qiya pona) 
modelini biriktirish metodi bilan yaratamiz.

2. Biriktirish metodini qoMlash uchun ikkita berk kontumi 
yaratish lozim, ular sifatida biz qanotning transtovushii profilidan 
foydalanamiz:

-  olddan ko‘rinishga o‘tiladi va qiya ponaning ikkita 
yo‘naItiruvchi chiziqli sirti ko‘rinishidagi (tovushgacha, 
tovushdan yuqori yoki transtovushii) profil quriladi (7.8- 
rasm, yuqorida, tovushgacha profil uchun yo‘naltiruvchiiar



taqdim etilgan);
-  yuqoridan ko‘rinishga o‘ti!adi va ikkinchi yo‘naltiruvchi 

zarur bo‘lgan masofaga suriladi (7.8-rasm) va qulay 
bo‘lgan uch o‘lchamli ko'rinish tanlanadi;

-  qiya qiyiqning buralish burchagini ham hisobga olish 
mumkin.

3. Draw => Modeling => Meshes => Ruled Mesb (Черчение 
=> Моделирование => Сетки => Сетка соединения/ 
Chizmachilik => Modellash => To‘rlar => Biriktirish to‘ri) 
komandasini tanlang:

-  so'rovga javoban qurilgan yo‘naltiruvchi profillar ketma- 
ketko‘rsatiladi.

4. Faylni saqlang. Qurishlar natijasi qanotning sirtli modeli 
ko‘rinishida 7.8-rasm, pastda, Realistic (Реалистичный/Real) aks 
ettirish rejimida taqdim etilgan.



7.5-mashq. Edge Mesh (Сепса no кромкам/Q irralar 
bo‘ylab to‘r)

Gilam-samolyot ( 0 ‘zi uchar gilam)
1. Oldingi qurilmalami o‘chiring va faylni «Gilam» nomi 

ostida saqlang. Bu mashqda biz egri chiziqli sirt modelini gilamcha 
ko‘rinishida qirralar bo‘ylab to‘mi yaratish metodi (Kuns sirti) 
bilan yaratamiz.

2. Ushbu metodni qo‘llash uchun ixtiyoriy shakldagi to‘rtta 
uch o'lchamli qovurg‘a (qirra)lami berk kontur ko'rinishida 
yaratish lozim. Dastlab gilamcha sirti uchun gabaritii 
parallelepipedni quramiz:

-  uch o'lchamli ko‘rinishda Rectangle (Прямоугольник/ 
To‘gsri burchakli to‘rtburchak) instrumenti yordamida 
to‘g‘ri burchakli to‘rtburchak quriladi;

-  Copy (Копирование/Nusxa olish) instrumenti yordamida 
to‘g‘ri burchakli to‘rtburchakdan qandaydir balandlikka 
nusxa olinadi va parallelepipedning vertikal qovurg'aiarini 
quriladi (7.9-rasm, yuqorida);

-  Spline (Splayn) instrumenti tanlanadi va parallelepipedning 
har bir yon qirrasida berk kontur bo‘ylab istalgan shaklda 
splayn quriladi (7.9-rasm, yuqorida).

3. Draw => Modeling => Meshes => Edge Mesh (Черчение 
=> Моделирование => Сетки => Сетка по кромкам/ 
Chizmachilik => Modellash => To‘rlar => Qirralar bo‘y!ab to‘r) 
komandasini tanlang:

-  «uchar gilam»ni qurish uchun komandaning so‘roviga 
javoban qurilgan splaynlar ketma-ket ko‘rsatiladi.

4. Faylni saqlang, Qurishlar natijasi gilamchaning sirtli modeli 
ko‘rinishida 7.9-rasm, pastda, Realistic (Реалистичный/Яеа!) aks 
ettirish rejimida taqdim etilgan.



Endi AutoCADning birinchi versiyalarida paydo boMgan uch 
o‘lchamIi obyektlami yaratishga mo‘ijaIlangan ikkita komandani 
ko‘rib chiqamiz.

7.6-mashq. Elevation (Уровень/Sath) va Thickness 
(Толщвиа/Qaiinlik) komandalar!

Ezoterik uchburchak
1. Oldingi qurilmalami o‘chiring va faylni «Uchburchak» 

nomi ostida saqlang. Bu mashqda biz uch oMchamli obyektlami 
primitivlar komandalari bilan yaratamiz.

2. Elevation (Уровень/Sath) komandasi komanda qatori 
yordamida chaqiriladi va ba’zi tekis primitivlar obyektlarining 
xossalarida mavjud boMadi, u shaklni gorizontal sirt ustida 
ko‘tarish imkonini beradi.

3. Thickness (Толщина/Qalinlik) komandasi Format => 
Thickness (Формат => Толщинa/Format => Qalinlik) menyusi



orqali chaqiriladi, bu komanda tekis geometrik primitivlar obyekti 
xossalarida mavjud bo‘ladi. Agar Thickness parametriga 
qandaydir qiymat berilsa, hamma tekis primitivlar uch o‘lchamli 
sitib chiqariigan obyektlar ko‘rinishida quriladi.

4. Yuqoridan ko‘rinishda uchburchakni, aylananing iklcita 
berk yoyini va ko‘z hamda ko‘z qorachig‘i ko'rinishida iklcita 
aylanani 7.10-rasmning chap tarafida tasvir etilganidek quring:

-  uch o‘lchamli ko‘rinishga o‘tiladi, uchburchak chiziladi, 
kontekstli menyu (o‘ng knopka ostida) yordamida 
Properties (Свойства/Xossalar) dialog darchasi 
chaqiriladi;

-  Thickness (Толщина/Qaiinlik) qatorida qiymat 5 beriladi, 
Elevation (Уровень/Sath) qatorida esa 10 qiymati 
o'matiladi;

-  yoylar navbatma-navbat ajratib ko‘rsatiladi, Properties 
dialog darchasining Thickness qatorida 10 qiymati 
o ‘matiladi;

-  ko‘zning rangli pardasi va qorachig‘i aylanalari ajratib 
ko'rsatiladi; Properties dialog darchasining Thickness 
qatorida 15 va 20 qiymatlari o‘mati!adi (o‘zingizning 
parametrlaringizni berishingiz mumkin).

5. Faylni saqlang. Ezoterik uchburchakning sirtli modeli 7.10- 
rasm, o'ngda, Realistic (Реалистичный/Кеа!) aks ettirish rejimida 
taqdim etilgan.



AutoCADda uch o‘Ichamli sirtlaming primitivlarini yaratish 
mumkin. Ular -  ko‘pburchak!i to‘rlardir. AutoCADning 2007 
versiyasida uch oMchamli primitivlami yaratish bo‘yicha komanda 
indamasdan kelishganlik bo'yicha menyuda mavjud emas. Ulami 
yaratish uchun komanda qatoriga 3D komandasini kiritish kerak.

7.7-mashq. 3D Surfaces (ЗМ поверхыость/ЗМ sirtlar) 
komandasi

Sirtli primitivlar
1. Mavjud qurilmalami o'chiring va faylni «Primitivlar» nomi 

ostida saqlang. Bu mashqda uch o‘lcham!i primitivlaming sirtli 
modelini quramiz.

2. Uch o‘lchamli ko‘rinishni tanlang va komanda qatorida -  
3D (3M)ni tering:

-  B ox/C one/D ish/D om e/M esh/Pyram id/Sphere/ 
T orus/ W edge (П араллелепипед\ Конус\Чаш а\ 
Купол\Сетка\П ирамида\Сфера\Тор\Клин/Рага11 
e lep iped\Konus \Kosa\Gumbaz\To‘r\Piramida\  
S fera\Tor \  Pona) so‘roviga javoban taqdim etilgan 
opsiyalar nomi bo‘yicha ketma-ket tanlanadi va bu uch 
o‘lchamli primitivlar quriladi.

3. Faylni saqlang. Sirtli primitivlar 7.11-rasmda Realistic 
(РеалистичныйЛ1еа1) aks ettirish rejimida taqdim etilgan.
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7.11-rasm. Sirtli primitivlar



Bu mashq bilan biz AutoCAD 2007 grafik tizimida mavjud 
bo'igan komandalaming bajarilishini namoyish qildik. Bu 
komandalardan foydalanib Siz (sanoat yoki transport) dizayn 
sohasidagi o'zingizning ijodiy g‘oyalaringiz va fantaziyalaringizni 
ro‘yobga chiqarishingiz mumkin. Keyingi mashqlarda biz yuqorida 
bayon qilingan komandalar asosida uchuvchi apparatning 
konseptual dizayni bilan shug‘ullanamiz.

7.8-mashq. «Ko‘rshapalak» samolyoti
1. Oldingi qurilmalami yo‘qoting va faylni «Ko'rshapalak» 

nomi ostida saqiang. «Ko‘rshapaIak» samolyotining sirtli modelini 
yaratish bo‘yicha ijodiy g'oyani amalga oshirish uchun dastlab 
mavjud komandalar imkoniyatiarini hamda modellanayotgan 
obyektning tarkibiy qismlarini tahlil qilib chiqish lozim.

2. Samolyotni (korpus uzunligi bo‘yicha simmetriya o‘qini 
hisobga olgan holda) tarkibiy qismlar: korpusning yuqori va pastki 
sirti, ki! sirti va soplo sirtiga bo‘lib chiqamiz.

3. Samolyot korpusi suyri (havoga kam qarshilik ko‘rsatadigan) 
shaklda boMishi kerak, uni yaratish uchun Kuns sirti ko'rinishida 
Edge Mesh (Сетка no кромкам/Qirralar bo‘ylab to‘r) metodidan 
foydalanamiz. Dum qismini va sopiolami Ruled Mesh (Сетка 
соединения/Biriktirish to‘ri) komandasi yordamida yaratamiz.

4. Qurishni «Gilam-samolyot» mashqiga o‘xshash ravishda 
suyri korpusning gabarit parallelepipedini yaratishdan boshlaymiz:

-  uch o‘lchamli ko‘rinishda gabarit parallelepipedi quriladi 
(proporsiyalar Sizning ixtiyoringizga havola);

-  yon qirralarda splaynlar quriladi, korpus yuqori qismining 
uchburchakli siluetini yaratish uchun qirralardan biri 
parallelepiped ichiga siljitiladi;

-  qulaylik uchun mos proyeksiyalardagi splaynlar ko‘rinishi 
va holatini tahrir qilish mumkin;

-  korpus pastki qismini qurish uchun birlamchi 
parallelepipedning yon qirrasi (tomoni)da fyuzelyaj bo‘ylab 
yangi splayn quriladi;

-  M irror (Zerkalo/Aks) instrumenti yordamida qat’iy 
splaynlarining aks nusxalari quriladi, hamma splaynlar



yangi qatlamga ko‘chiriladi;
— dum va soplolar uchun birlamchi tekis shakllami 

polichiziqlar yoki splayn ko‘rinishida chiziladi, ular yangi 
qatlamga ko‘chiri!adi;

-  samolyot sirtini yaratish bo‘yicha tayyorgarlik ishlarining 
natijasi birlamchi tekis splaynlar va polichiziqlar 
ko‘rinishida 7.12-rasmda taqdim etiigan.

7.12-rasm. Samolyot sirtining birlamchi tekis shakliari

5. Edge Mesh (Сетка no кромкам/Qirralar bo‘ylab to‘r) 
komandasi yordamida navbatma-navbat koфusning chap va o‘ng 
qismlarini quring, korpusning pastki va yuqori sirtlarini alohida 
qatlamlarga ko'chiring.

6. Yangi qatlamda Ruled Mesh (Сетка соединения/ 
Biriktiruvchi to‘r) komandasi yordamida dum qism va soplolami 
yarating. Qurishlar natijasi uchta to‘g‘riburchakIi ikki o‘lchamli 
proyeksiyalarda va janubiy-g‘arbiy izometriyada 7.13-rasmda 
taqdim etiigan. ' Zarurat tug‘ilganda uchuvchi apparatning 
aerodinamik xossalarini rostlash (корректировка) uchun birlamchi 
shakllami tahrir qilish mumkin.



7.13-rasm. Samolyotning uch o‘Ichamli sirtli modeli proyeksiyalarda

7. 7.14-rasmda «Ko‘rshapalak» samolyoti tonirovka qilingan 
sirtli modelining kreyserlik uchish va qo‘nishga kirish paytidagi 
vizualizatsiyasi taqdim etiigan.

. i
I - *

' !i }
I " I

- - : - " X  ‘

7.14-rasm. «Ko‘rshapaIak» samolyotming tonirovka qilingan sirtli modeli

Shuni qayd etish lozimki, tonirovka va vizualizatsiya qilish 
masalalari ushbu o‘quv qo‘llanma doirasida ko‘rib chiqilmagan, bu 
mavzular mustaqil o‘zlashtirish uchun tavsiya etiigan [9].

7.4. Qatfiq jismli modellash
AutoCADda qattiq jismli modellami yaratish uchun

mo‘ljalIangan komandalar Draw => Modeling (Черчение =>



Моделирование/Chizmachilik => Modellash) menyusida, ulami 
tahrir qilish uchun komandalar esa — Modify => Solids Editing 
(Редактирование => Редактирование тел/Tahrir qilish => 
Jismlami tahrir qilish) menyusida joylashadi. Bunda Dashboard 
(Инструментальная панель/Instrumentlar paneli) panelining 3D 
M ake (ЗМ построения/ЗМ qurishlar) boshqaruv panelidan ham 
foydalanish mumkin, ular 7.15-rasmda taqdim etilgan.

Qattiq jismli modellami yaratish uchun mo'Ijallangan 
algoritmlar quyidagilarga asoslangan:

• primitivlar va ikki o‘lchamli shakllar asosida uch o‘Ichamli 
obyektlami yaratish, so‘ngra ulami uch o‘Icham!i 
modellarga aylantirish; 

e jismlami tahrir qilish komandalari yordamida uch o‘lchamli 
modellami o‘zgartirish.

Dastlab qattiq jismli primitivlami yaratish usullarini ko‘rib 
chiqamiz.
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7.15-rasm. Qattiq jism li modellar bilan ishlash uchun komandalar va panellar



7.9-mashq. Qattiq jismli primitivlar
1. Mavjud qurilmalami yo‘qoting va faylni «Qattiq jismlar» 

nomi ostida saqlang. Bu mashqda biz uch oMchamli primitivlaming 
qattiq jismli modellarini quramiz.

2. Qurish uchun Draw => Modeling (Черчение => 
Моделнрование/Chizmachilik => Modellash) menyusi yoki 
Dashboard (Инструментальная панель/instrumental panel) 
instrumentlar panelining 3D Make (ЗМ построения/ЗМ qurishlar) 
boshqarish panelidan foydalanish mumkin.

3. Uch oMchamli ko‘rinishni tanlang va quyidagi qattiq 
jismlami quring: Polysolid (Политела/Polijismlar), Box 
(Parallelepiped), Wedge (Кпин/Ропа), Cone (Konus), Sphere 
(Sfera), Cylinder (Silindr), Pyramid (Piramida), Torus (Top).

4. Faylni saqlang. Qattiq jismli primitivlar 7.16-rasmda taqdim 
etilgan.

7.16-rasm. Qattiq jism li primitivlar

Endi o‘zgartishlar komandasidan foydalanilgan holda ikki 
oMchamli shakllar asosida qattiq jismli modellami yaratish 
metodlarini ko‘rib chiqamiz.

7.10-masftq. Extrude (Выдавливание/Sitib chiqarish) 
komandasi

«Сердце/Yurak» upakovkasi
1. Oldingi qurilmalami yo‘qoting va faylni «Сердце/Yurak» 

nomi ostida saqlang. Bu mashqda biz konditer (yoki kosmetika)



upakovkasining qattiq jismli modelini quramiz.
2. Yuqoridan ko‘rinishda polichiziq yoki splayn yordamida 

yurak konturi ko‘rinishida berk shaklni quring. Shakldan nusxa 
oling, uni alohida qatlamga ko*chiring va qatlamni o‘chiring, 
zarurat tug‘ilganda bu qatlamga qaytish mumkin boMadi. Uch 
o‘lchamli qatlamga o'ting va Draw => Modeling => Extrude 
(Черчение => Моделирование => Выдавливание/СЫгтасЫНк 
=> Modellash => Sitib chiqarish):

-  so‘rovga javoban shakl tanlanadi, so‘ngra sitib chiqarish 
balandligi, masalan, 40 beriladi (natija 7.17-rasm, chapda 
taqdim etiigan).

3. Ushbu komanda yordamida uchli qirrani ham yaratish 
mumkin. Buning uchun shakl nusxasini tanlang yoki oldingi 
amallami bekor qiling:

-  Extrude (Выдавливание/Sitib chiqarish) komandasi 
tanlanadi, so'rovga javoban shakl ko‘rsatiladi;

-  so'ngra komanda qatori menyusidan Taper angle (Угол 
заострения/ Uchli qirra) metodi tanlanadi;

' -  o‘tkir qirra burchagi 30 va sitib chiqarish balandligi 40 
beriladi. Natija 7.17-rasm, o‘ngda taqdim etiigan.

7.17-rasm. E x trude (Выдавливание/Sitib chiqarish) metodi bilan yaratilgan 
qattiq jism li modeiiar

4. Mavjud ikki o‘lchamIi shakl asosida upakovkaning uch sathli 
sitib chiqariigan qattiq jismli modelini yaratamiz. Extrude 
(Выдавливание/Sitib chiqarish) komandasini tanlang:

-  so‘rovga javoban birlamchi shakl ko‘rsatiladi, so‘ngra 
komanda qatori menyusidan Taper angle (Угол



заострения/Uchli qirra) metodi tanlanadi;
-  o‘tkir qirra burchagi (-30) va sitib chiqarish balandligi 10 

beriladi;
-  keyingi qurishlar uchun jismlami tahrir qilish komandasi 

Modify => Solids Editing => Extrude Faces 
(Редактирование => Редактирование тел => 
Выдавливание грани/Tahrir qilish => Jismlami tahrir 
qilish => Qirrani sitib chiqarish)dan foydalanish mumkin;

-  so‘rovga javoban qurilgan modelning yuqori qirrasi 
koTsatiiadi, sitib chiqarish balandligi 20, o'tkir qirra 
burchagi 0 beriladi;

-  Extrude Faces (Выдавливание грани/Qirrani sitib 
chiqarish) komandasi takrorlanadi, sitib chiqarish 
balandligi 10 va o‘tkir qirra burchagi 30 beriladi.

5. Faylni saqlang. Qurishlar natijasi upakovkaning tonirovka 
qilingan qattiq jismli modeli ko'rinishida 7.18-rasmda taqdim 
etilgan.

7.18-rasm. Upakovkaning tonirovka qilingan qattiqjism li modeli

7.11-mashq. Revolve (Вращение/Aylanish) komandasi
M anjeta va vino quyilgan bokal
1. Oldingi qurilmalami yo*qoting (o‘chiring) va faylni 

«Manjeta» nomi ostida saqlang. Bu mashqda biz zichlovchi 
manjeta [10] va bokal qattiqjismli modeilarim aylantirish metodi 
bilan quramiz.

2. Olddan ko‘rinishda polichiziq (yoki splayn) yordamida 
manjetaning berk profilini va aylanish o‘qini 7.19-rasm, chapda 
taqdim etilganidek to‘g‘ri chiziq kesmasi ko‘rinishida quring.



Profildan nusxa oling va uni alohida qatlamga ko‘chiring.
3. Uch o‘lchamli ko'rinishga o‘ting va Draw => Modeling => 

Revolve (Черчение => Моделирование => Вращение/ 
Chizmachilik => Modellash => Aylantirish) komandasini tanlang;

- so'rovga javoban berk profilni tanlanadi, so‘ngra to£g‘ri 
chiziq kesmasining boshi va oxirini ko‘rsatib, aylanish o‘qini 
beriladi;

- aylantirish burchagi diapazoni 270° (doira bo‘yicha 360°) 
beriladi;

- natija 7.19-rasm, o‘ngda choragi holda, janubi-sharqiy 
izometriyada taqdim etiigan.

7.19-rasm. M anjeta aylanish profili va (kesmali) qattiq jismli modeli

4. Qurilmalami saqlang. Shuni qaydetish lozimki, aylanish o‘qi 
sifatida komanda qatori menyusidan mos koordinata o‘q!arini 
tanlash mumkin, u holda bir profil bilan ikkita har xil obyektni 
olish mumkin.

5. Bokal modelini yaratish uchun olddan ko‘rinishda 
polichiziq yoki splayndan berk aylanish protllini qurish lozim.

6. 7.20-rasmda aylantirish uchun profil va uning asosida 
yaratilgan qattiq jismli modellar taqdim etiigan. Ushbu holda 
aylanish o‘qi sifatida profilning vertikal va gorizontal segmenti 
qabul qilingan. Natijada bokal hamda kosa modeli hosil bo‘lgan.



7.20-rasm. Aylanish profili va uning asosidagi qattiqjism li modellar

7. 7.21-rasmda (sharbat quyilgan) bokal tonirovka qilingan 
modelining vizualizatsiyasi taqdim etilgan.

7.21-rasm. Sharbat quyilgan bokal tonirovka qilingan qattiqjism li 
modelining vizualizatsiyasi

7.12-mashq. Sweep (Нзгиб/Egilish) komandasi
Bukilgan sverlo
1. Oldingi qurilmalami yo‘qoting va faylni «Sverio» nomi 

ostida saqlang. Bu mashqda biz sverloning qattiq jismli modelini 
egish metodi bilan quramiz.

2. Olddan ko‘rinishda polichiziq (yoki splayn) yordamida 
sverloni sitib chiqarish uchun berk profilni va egilish yo6lini to‘g‘ri 
chiziq kesmasi ko‘rinishida 7.22-rasm, chapda ko‘rsatilganidek 
quring.



7.22-rasm. Egish uchun profil va sverloning qattiq jismli modellari

3. Uch o‘lcham!i ko‘rinishga o‘ting va Draw => Modeling => 
Sweep (Черчение => Моделирование => Изгиб/Chizmachiiik => 
Modellash => Egilish) komandasini tanlar.g:

- so‘rovga javoban berk profil tanlanadi, so‘ngra burashni 
amalga oshirish uchun komanda qatori menyusidan Twist 
(Закручивание/Burash) tanlandi;

- burash burchagi 270° beriladi, so‘ngra yo‘l sifatida to‘g£ri 
chiziq kesmasi ko'rsatiladi va qurrlma saqlanadi.

4. Qurishlar natijasi sverloning qattiq jismli modeli ko'rinishida 
7.22-rasm, markazda taqdim etiigan. Bu rasmning o‘ng qismida 
egilgan sverloning qattiq jismli modeli taqdim etiigan; model 
o'xshash tarzda egilish yo‘li ko'rinishida egri chiziqli splayn 
bo‘ylab olingan.

7.13-mashq. Loft (Lofting) komandasi
Haykalcha va raketa
1. Oldingi quriimalami yo'qoting va faylni «Haykalcha» nomi 

ostida saqlang. Bu mashqda biz haykalchaning qattiq jismli 
modelini lofting metodi bilan quramiz. Lofting metodini qo‘IIashda 
lofting uchun yo‘l va tekis shakllar ko‘rinishida kesimlami yaratish 
lozim.

2. Yuqoridan ko‘rinishda ikki o‘lchamli primitivlar (ikkita 
oltiburchak, beshta aylana, uchta ellips va dumaloqlashtirilgan 
to‘g‘ri burchakli to‘rtburchak) yordamida haykalcha kesimlarining



shakllarini (bir markazdan) quring, olddan ko‘rinishda balandlik 
o‘qini quring. So‘ngra ulami siljiting va 7.23-rasm, chapda tasvir 
etilgani kabi balandlik bo‘ylab joylashtiring.

3. Uch oMchamli ko‘rinishga o‘ting va Draw => Modeling => 
Loft (Черчение => Моделирование => Лофтинг/Chizmachilik 
=> Modeilash => Lofting) komandasini tanlang:

-  komanda so‘roviga javoban kesim shakllari balandligi 
bo‘yicha ketma-ket tanlanadi;

-  Loft Setting (Режимы лофтинга/Lofting rejimlari) 
dialog darchasidan silliqiashning mos rejimi tanlanadi 
va qurilganlar saqlanadi.

4. Qurilishlar natijasi haykalchaning qattiq jismli modeli 
ko‘rinishida 7.23-rasm, markazda taqdim etilgan.

7.23-rasm. Lofting uchun tekis shakllar va haykalchaning qattiq jism li modeli

5. 7.23-rasm, o‘ngda raketani lofting metodi bilan yaratish 
uchun tekis kesinilar taqdim etilgan. 7.24-rasmda lofting metodi 
bilan yaratilgan raketaning tonirovka qilingan modelining Yer 
fonidagi vizualizatsiyasi taqdim etilgan.



ICeyingi mashqda biz plitaning qattiq jismli modelini ilgari 
bajarilgan (5.11-rasmga qarang) chizma asosida yaratamiz. Uni 
konstruksiyalash uchun biz Modify => Solids Editing
(Редактирование => Редактирование тел/Tahrir qilish => 
Jismlami tahrir qilish) menyusida va 3D Make (3M 
построения/ЗМ qurishlar) boshqaruv panelidagi nazariy-ko‘plik 
operatsiyalarining komandalaridan foydalanamiz. Union
(Объединение/Birlashma), Subtract (Вычитание/Ayirish) va 
Intersect (Пересечение/Kesishish) komandalari ularga
taaiiuqlidir.

7.14-mashq. Union (Объедпненпе/Birlashma), Subtract 
(Вычитание/Ayirish) va Intersect (Пересечение/Kesisbish) 
komandalari

Plitani konstruksiyalash
1. Oldingi qurilmalami yo‘qoting va faylni «Plita» nomi 

ostida saqlang. Bu mashqda biz plitaning qattiq jismli modelini 
nazariy-ko‘plik operatsiyalarini qoMlab sitib chiqarish metodi bilan 
konstruksiyalaymiz. Buning uchun «Чертеж 7» faylini oching, 
«Plita» detalining chapdan ko‘rinishidan (7.25-rasm, yuqorida) 
nusxa oling va uch oMchamli joriy faylga ko‘chiring.



2. Yuqoridan ko‘rinishda detal proyeksiyasini uch bo'lakka 
ajrating, bunda har bitta qismni alohida qatlamga ko‘chiring (7.25- 
rasm. pastda). Yuqori maydoncha konturini berkitish (7.25-rasm, 
markazda) yodingizdan chiqmasin.
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7.25-rasm. Sitib chiqarish uchun plitaning tekis konturlari

3. Uch oMchamli ko‘rinishga o‘ting, yuqoridagi konturli va 
teshikli qatlamlami o‘chiring, Draw => Modeling => Extrude 
(Черчение => Моделирование => Выдавливание/Chizmachilik 
=> Modellash => Sitib chiqarish) komandasini taniang:

~ so'rovga javoban sitib chiqarish baiandligi 30 mm ni 
o'tkir qirralarsiz 5.11-rasmdagi detal chizmasiga 
muvofiq beriladi;

-  detaining yuqori konturili qatlam ulanadi va u 35 mm 
baladlikka sitib chiqariladi;

-  ikkita jismni bir-biriga biriktirish uchun Modify => 
Solids Editing => Union (Редактирование => 
Редактирование тел => Объединение/Tahrir qilish => 
Jismlami tahrir qilish => Biriktirish) komandasi 
tanlanadi. Natija 7.26-rasm, chapda taqdim etilgan;

-  teshikli qatlam ulanadi va ular ham 35 mm balandlikka 
sitib chiqariladi (7.26-rasm, o‘ngda).



4. Teshiklami teshish uchun yaratilgan silindrlar va prizmani 
plita asosidan ayirishimiz kerak. Modify => Solids Editing => 
Subtract (Редактирование => Редактирование тел => 
Вычитание/Tahrir qilish —> Jismlami tahrir qilish => Ayirish 
(Olib tashlash)) komandasi tanlanadi:

-  so'rovga javoban dastlab plita asosi ko‘rsatiladi, so'ngra 
ayirib tashlanadigan jismlar ko‘rsatiladi. Qurilmalar 
saqlanadi.
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7.26-rasm. Plita asosi va teshiklami sitib chiqarish

v......

7.27-rasm. «Plita» detail tonirovka qilingan qattiq jismli modelining 
vizualizatsiyasi



5. Qurilmalar natijasi plita tonirovka qilingan qattiq jismli 
modelining vizualizatsiyasi ko‘rinishida 7.27-rasmda taqdim 
etilgan.

Biz ushbu mashq bilan qattiqjismli modellash asosiy usullarini 
bayon qilishni tugatdik. Plita korpusi pastki qismidagi 
silliqlashliklarni qurishni AutoCAD dasturida amalga oshirish 
qiyin, Autodesk Mechanical Desktop kompaniyasining uch 
oMchamli tizimi bu maqsadlarga ancha mos keladi.

7.15-masfiq. V-200 sainolyot-amfibiyani modellash
1. Bu mashqda biz samolyot-amfibiyaning uch o‘lchamli 

modelini qattiqjismli modellash metodlari bilan yaratamiz. Buning 
uchun gabaritli chizmalar va modellanayotgan obyekt fotosuratlari 
ko'rinishidagi (7.28-rasm) birlamchi material talab qilinadi [11].

i

7.28-rasm. V-200 samolyot-amfibiyaning suvdan uchib ko'tarilishi

2. Konstruksiyalash uchun samolyotni tarkibiy qismlar: kema 
(fyuzelyaj), qanot, kil, dvigatellar, stabilizatorlar va qayiqsimon 
moslama (poplavok)ga boMamiz. Modellashda biz asosan lofting 
metodidan foydalanamiz. Bu texnologiya nuqtayi nazaridan eng 
qulay metod bo‘Hb, unda samolyotsozlikda va kemasozlikda keng 
foydalaniladi. Tekis kesimlar sifatida kema shpangoutidan 
foydalaniladi, model aniqligi ulaming soniga bog‘liq boMadi.



3. Tekis kesimlami splayn asosida quramiz va ulami kema 
bo‘yi bo‘ylab taqsimlab chiqamiz. Qanot va dum qanotni shunga 
o‘xshash quramiz. ish jarayonida birlamchi tekis shakllami alohida 
qatlamlarga nusxalash va keyinchalik tahrirlash uchun bosqichma- 
bosqich rezerv fayllami yaratib borish maqsadga muvofiq boMadi. 
Dvigatellar va qayiqsimon moslama (poplavok)lar polichiziqlardan 
aylantirish metodi bilan hosil qilingan.

Modellash uchun boshlang‘ich tekis shakllar majmuasi 7.29- 
rasmda fazoda taqsimlangan holda taqdim etiigan.

7.30-rasmda samolyot-amfibiyaning qattiq jismli modeli 
Realistic (РеалистичныйЛ1еа1) aks ettirish rejimida taqdim 
etiigan.

7.31-rasmda samolyot-amfibiyaning uchib ko'tarilishi 
sahnasining vizualizatsiyasi taqdim etiigan.
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7.29. Modellash uchun boshlang‘ich tekis shakllar



7.30-rasm. Samolyot-amfibiyaning qattiq jism li tonirovka qilingan modeli
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7.31-rasm. Samolyot-amfibiyaning suvdan uchib ko‘tari!ish sahnasining 
vizualizatsiyasi



XULOSA

Ushbu o‘quv qoMlanmada AutoCAD 2007 grafik tizimida 
chizmalami va uch oMchamli modellami yaratish metodikalari 
ko'rib chiqildi.

Birinchi bobda grafik tizim darchasi, mavjud menyu va 
instrumentlar panellari, koordinatalar tizimi, chizmalami yaratish 
va saqlash masalalari hamda tizim parametrlarini muayyan 
foydalanuvchiga rostlash bayon qilingan.

Ikkinchi va uchinchi boblarda grafik primitivlar va ulaming 
xossalari taqdim etilgan hamda qatlamlami yaratish masalalari 
ko‘rib chiqilgan. Format va chizma ramkalarini qurish, detal va olti 
qirrali gaykani qurish bo‘yicha mashqlar keltirilgan.

To'rtinchi bobda chizma grafik elementlarini tahrir qilish 
bo‘yicha komandalar bayon qilingan va ulardan foydalanish 
bo‘yicha mashqlar keltirilgan. Tasvirlarga faskalar, 
dumaloqlashtirishlar, teshik ko‘rinishida massiv kiritilgan. 
Perpendikulyar, parallel to‘g‘ri chiziqlar va to‘g‘ri chiziqlaming 
aksi qurilgan, uzaytirish, kesish va uzish operatsiyalari taqdim 
etilgan.

Beshinchi bobda kesim shakllarini shtrixovkalash, yangi 
o‘Icham stilini o‘matish va o'lchamlami berish, matnli kiritmalami 
yaratish va grafik informatsiyani chop qilishga chiqarish 
komandalari bayon qilingan.

Oltinchi bobda chizmalami yaratish metodikasi, korpus detali 
chizmasini bosqichma-bosqich bajarish ko‘rib chiqilgan, 
texnikaviy chizmachilik bo*yicha individual grafik topshiriqlar 
taqdim etilgan, ularda sirtlaming kesishish chiziqlarini qurish 
nazarda tutilgan.



Yettinchi bobda AutoCAD grafik tizimining uch o‘Ichamli 
modellash borasidagi imkoniyatlari ko‘rib chiqilgan. Uch o‘lchamli 
ishchi maydonni rostlash ko'rsatilgan; uch o'Ichamli obyektlami 
qattiq jismli modellar ko‘rinishida qurish metodlari bayon qilingan. 
Har bir metod bo'yicha muayyan misollarda vazifasi har xil 
boMgan uch o‘lchamli obyektlaryaratiladi.

Osquv qo‘llanmada nazorat savollari hamda tavsiya etiladigan 
o4quv va metodik adabiyotlar ro‘yxati keltirilgan.



NAZORAT SAVOLLARI

1. AutoCAD tizimining vazifasi va imkoniyatlarini bayon 
qiling.

2. Tizimiy menyu qatorida qanday oqib chiquvchi menyular 
mavjud?

3. fContekstli menyuning asosiy turlarini aytib bering.

4. AutoCADda qanday instrumental panellar mavjud?

5. Ishchi muhit parametrlarini rostlash deganda nimalar 
tushuniladi?

6. AutoCAD tizimida grafik primitivlami qanday 
koordinatalar tizimlarida qurish mumkin?

7. Grafik primitivlami qaysi instrumentlar paneli yordamida 
chizish mumkin va unda qaysi grafik primitivlar mavjud?

8. Obyektli bog*lash deganda nima tushuniladi?

9. Qatlam nima va Sizning «Korpus» chizmangizda qanday 
qatlamlar mavjud?

10. Modify (Редактирование/ТаЬпг qilish) instrumentlar 
panelida qanday komandalar mavjud? Ular qanday 
ishlaydi?

11. Siz oMchamlami korrektirovka qiladigan qaysi 
komandalami bilasiz?

12. Primitivlami ruchkalar yordamida tahrir qilish deganda 
nima tushuniladi?

13. Shtrixovkalash deganda nima tushuniladi?

14. Dimension (Размеры/O 'Ichamlar) panelida qanday 
instrumentlar mavjud?

15. Detal chizmasida oMchamlaming qanday to‘rtta turi 
qo‘yiladi?



16. OMchamlami qo'yish stilini qanday o'matish lozim?

17. Chizmada oMchamlami qo‘yib chiqishning qanday uchta 
asosiy usuli mavjud?

18. Matnni yaratish bo‘yicha qanday komandalar mavjud va 
matnli kiritmalarda foydalanish uchun qanday shrift tavsiya 
etiladi?

19. AutoCAD tizimida tavsiya etiladigan chizmani qurishning 
asosiy bosqichlarini sanab bering.

20. AutoCAD grafik tizimi uch oMchamli ishchi maydoni 
darchasining asosiy elementlarini sanab chiqing.

21. Uch oMchamli modellashning qanday metodlari mavjud, 
ulaming afzalliklari va kamchiliklari?

22. AutoCAD grafik tizimida ko‘rib chiqish va aks ettirishning 
qanday rejimlari mavjud?

23. Dashboard (Инструментальная панель/Instrumer.ta! 
panel) paneli nima uchun moMjallangan va unda qanday 
komandalar mavjud?

24. AutoCAD tizimida sirtli modellashning qanday 
komandalari va metodlari mavjud?

25. Uch oMchamli obyektlami yaratishda aylantirish va sitib 
chiqarish metodlarining qoMlanilishini illyustratsiya qilib 
bering.

26. Uch oMchamli obyektlami yaratishda biriktirish va Kuns 
sirtlari metodlarining qoMlanilishini illyustratsiya qilib 
bering.

27. Elevation (Уровень/Sath) va Thickness (Толщина/ 
Qalinlik) komandalari nimalaming imkonini beradi?

28. AutoCAD tizimida qanday sirtli primitivlai mavjud?

29. AutoCAD tizimida qattiq jismli modellashning qanday 
komandalari va metodlari mavjud?



30. AutoCAD tizimida qanday qattiq jismli primitivlar mavjud?

31. Uch o6Ichamli obyektlami yaratishda bosib chiqarish va 
aylantirish metcdlarinmg qo'Uamlishini illyustratsiya qilib 
bering.

32. Uch oMchamli obyektlami yaratishda egish va lofting 
metodlarining qoMIanilishini illyustratsiya qilib bering.

33. AutoCAD tizimida qattiq jismli modellami tahrir qilishning 
qanday komandalari mavjud?

34. AutoCAD tizimida qanday nazariy-ko‘prik operatsiyalari 
mavjud?

35. Korpus detali misolida qattiq jismli modelni yaratishning 
asosiy bosqichlarini bayon qiling.



ADABIYOTLAR

1. Аббасов И.Б. Чертежи в графической среде AutoCAD. 
Учебное пособие. -  Таганрог: Изд-во ТРТУ, 2002. - S2c.

2. Глушаков С.В., Лобпк А.В. AutoCAD 2008. 
Самоучитель /  изд. 2-е, доп. и перераб. -  М.: ACT: ACT 
МОСКВА: Хранитель, 2008. -  448 с.

3. Двигатели внутреннего сгорания. В 3 кн. Кн. 3. 
Компьютерный практикум: Учеб./ В. Н. Лукаиин, М.Г. 
Шатров, А. Ю. Труш и др.; Под ред. В.Н. Луканина. -  
М.: Высшая школа, 1995.

4. Корячко В.П., Курейчик В.М., Ыоренков И Л . 
Теоретические основы САПР. — Минск: Вышэйшая 
школа, 1987.

5. Красильникова Г., Самсонов В., Тарелкнн С. 
Автоматизация инженерно-графических работ. -  С-Пб.: 
Питер, 2000. — 256 с.

6. Купву Ли. Основы САПР (CAD/CAM/CAE). -С-Пб.: 
Питер, 2004. -560с.

7. Левицкий B.C. Машиностроительное черчение и 
автоматизация выполнения чертежей. -  М.: Высшая 
школа, 1998. -  433 с.

8. Максимен И.В. Имитационное моделирование на 
ЭВМ.-М.: 1988.

9. Петров А.В., Черненький В.М. Проблемы и 
принципы создания САПР. -  М.: Высшая школа, 1990.

10. Питаев А.В. Автокад. -  Ташкент; ТГАИ, 2008. -  74 с.
11. Ткачев Д.А. AutoCAD 2007. — С-Пб.: Питер, Киев, 

BHV, 2007.-464 с.



12. Тулаев Б.Р. Основы автоматизированного 
проектирования. Учебное пособие. — Ташкент, 
ТашГТУ, 2004.

13. Филькентатейн Э. AutoCAD 2000. Библия 
пользователя. -  М.: Издательский дом «Вильямс», 
2001.-1040 с.

14. Хрящев В., Ш ипова Г. Моделирование и создание 
чертежей в системе AutoCAD. -  C-Пб.: BHV, 2006. -  
224 с.

15. Bendsoe, М Л\, Diaz, A. anti Kikuchi, N. Topology and 
Generalized Layout Optimization of Elastic Structures, In 
Bendsoe and Scares (eds.), Topology Design of Structures, 
Kluwer Academic Publishers, Dordrecht, Holland, 1992.

16. Kohn, R.V. and Strang, G. Optimal Design and 
Relaxation of Variational Problems, Communic. Pure and 
Appl. Math., Vol. 39, (Part 1), pp. 113-137; (Part 2), pp. 
139-182; (Part 3), pp. 333-350, 1986.

17. Tickoo, S. AutoCAD: A Problem-Solving Approach, 
Releasel3 DOS, Delmar, Albany, NY, 1995.

18. Tulaev B.R. Zakirova N.S. Basic of computer and design. 
The textbook. -Т ., 2005. -  13Ip.

19. Zeid, I. CAD/CAM Theory and Practice, McGraw-Hill, 
New York, 1991.

20. www.aviaport.ru.www.beriev.com.www.intel.com.

http://www.aviaport.ru.www.beriev.com.www.intel.com


M U N D A R IJA

K IR I S H .............................................................................................................................. 3
1. A U T O C A D  2007 R E D A K T O R IN I IS H G A  T U S H IR IS H  V A  U N IN G  
D A R C H A S I .......................................................................................................................5

1.1. Fo y d a l a n u v c h in in g  1SHCHISTOL1........................................................................8
1.2. MENYU VA INSTRUMENTLAR PANELLAR1...............................................................13
1.3. In d iv id u a l  fo y d a l a n u v c h j u c h u n  A u t o C A D n i o ‘r n a t is h ......................... 16
1.4. K o o r d in a t a l a r  t iz im i ........................................................................................18
1.5. E k r a n n i b o s h q a r js h .......................................................................................... 22

2. G R A F IK  P R I M IT IV L A R ........................................................................................ 24
2.1. P r im it iv l a r  x o s s a l a r i....................................................................................... 24
2.2. C h iz m a c h il ik  uc h u n  g e o m e t r ik  e l e m e n t l a r ................................................ 26

3. C H IZ M A N IT A H R IR L A S I I ...............   32
3.1. PRIMITIVLARNI YO‘QOTISH....................................................................................32
3.2. OBYEKTGA BOG‘LANISHLARDAN FOYDALANIB GEOMETRJK QURISHLAR............. 35
3.3.Q a t l a m l a  r ..........................................................................................................41

4. C I I IZ M A  E L E M E N T L A R IN I  0 ‘Z G A R T IR IS H ................................................ 45
4.1. O b y e k t l a r n it a n l a s h .......................................................................................45
4.2. O b y e k t l a r  n u s x a s in i o l is h  v a  jo y l a s h is h in i 0 ‘ZGARTIRISH........................46
4.3. O b y e k t  o ‘l c h a m l a r in i k o r r e k t ir o v k a  q iu s h .............................................. 51
4.4. O b y e k t l a r n i k o n s t r u k s iy a l a s h ..................................................................... 53
4.5. T a h r ir  q il is h  r u c h k a s id a n  fo y d a l a n is h ........................................................66

5. C H IZ M A L A R N l  S H A K L L A N T IR IS H ................................................................. 69
5.1. S h ir ix o v k a l a r n i b a ja r is h ................................................................................69
5.2. 0 ‘l c h a m l a u n i b e r is h  (c h iz ish ) ........................................................................ 72
5.3. 0 ‘l c h a m  s t il in i o ‘z g a r t ir js h ............................................................................77
5.4. M a t n l i k ir it m a  (k ir it ib  o ‘r n a t ish )l a r ...........................................................85
5.5. G r a f ik  in f o r m a t s iy a n i b o s m a g a c h iq a r is h .................................................. 90

6. C H IZ M A N I Y A R A T IS H  M E T O D IK A S I ............................................................. 91
6.1. CHIZMALARNl y a r a t is h  b o ‘y ic h a t a v s iy a l a r ................................................ 91
6.2. CHIZMANI BAJARISH.............................................................................................. 91
6.3. K o r p u s  d e t a l i c h iz m a s in i bo sq ic h m a-b o s q ic h  b a ja r is h ............................. 93
6.4. I n d iv id u a l  g r a f ik  t o psh ir iq la r  v a r ia n t l a r i................................................ 97

7. U C I I  0 ‘L C H A M L I  M O D E L L A S H ......................................................................107
7.1. U c h o ‘ l t h a m l i f a z o ......................................................................................... 108
7.2. A k s  e t t ir is h  v a  k o ‘r ib  c h iq ish  r e j im l a r i......................................................109
7.3. K a r k a s l i v a  s ir t l i m o d e l l a s h ........................................................................112
7.4. Q a t t iq  j i s m l i  m o d e l l a s h .................................................................................125

X U L O S A ....................................................................................................................... 140
N A Z O R A T  S A V O L L A R I ..........................................................................................142
A D A B IY O T L A R .........................................................................................................145



To‘layev Bekmurot Ro‘zmetovich,
Yelin Yevgeniy Aleksandrovich,

Daminov Oybek OHmovich,
Xakimov Jarashid Oktyamovicb

Loyihalash jarayonlarini avtomatlashtirish asoslari
Kompyuterda AutoCADda chizmalarni ishlab chiqish 

0 ‘quv qo‘I5an,Ma

Botirbekova M.M. 

Dexkanova Sh.S.

Muharrir

Musahhih

B o s is h g a  r u h s a t  e t i ld i  20 .04 .2011  y. B ic h im i 60x 8 4  1 /1 0 . 
S liai'H i b o s m a  L ib o rj 'i  0 ,65 . N u s x a s i  50 d o n a .  B u y u r tm a  N° 31Я.

T D T U  b o s in a x o n a s id a  c h o p  e t i ld i .  T o s h k e n t  sh , 
T a l a b a l a r  k o ’c h a s i 5 4 . te l:  2 4 6 -6 3 -0 4 .


